
 

 



2 
 

 

 

GeoPublish Tutorial 

A Guide to getting the most out of this complex software. 

 

final update June 4, 2005  

This page provides links to the pages that make up our geoPublish Tutorial. 

For each article in the series there will be a link to the HTML version of the 

file so you can read it online as well as a link to the GeoWrite file in 

CONVERT format so you can download it and use it to create your own 

printable copy of the Tutorial.  

 

Order your own copy of the geoPublish Tutorial. 

To obtain the programs to deal with the Converted Files (.cvt) please see 

our Tools Page.  

 
  i. Introduction (July 1, 2003) 

     - download Converted GeoWrite file (updated February 23, 2005) 

1. Sophisticated Software (July 1, 2003)  

- download Converted GeoWrite file  

2. A Quick Tour (July 13, 2003)  

- download Converted GeoWrite file  

- download AutoClock V1.5 by Rick Koch  

3. Planning and Preparation (August 2, 2003)  

- download Converted GeoWrite file  

4. Master Pages Mode (August 29, 2003)  

- download Converted GeoWrite file (updated February 23, 2005) 

5. Page Layout Mode (September 18, 2003)  

- download Converted GeoWrite file  

6. Document Conversions (October 11, 2003)  

- download Converted GeoWrite file  

- download Word Count by Michael Myers  

- download WrongIsWrite V7 by Red Storm  

- download GeoDOS by Markus Kanet  

- download Toolkit by Rick Krantz  

- download Toolkit 128 by Rick Krantz  

7. Importing More Articles (November 9, 2003)  

- download Converted GeoWrite file (updated Nov. 2, 2004)  

If you have been following along please d-load all of the Converted geoWrite files from 1-6 again as I 

made some changes and corrected a few mistakes and omissions. Sorry for the inconvenience.  

8. Editor Mode (January 4, 2004)  

- download Converted GeoWrite file  

- download Converted GeoWrite formatting file containing instructions for importing the geoPub8 file 

into the geoPublish Tutorial. This file explains how to create the second geoPublish document that is 

needed for the Tutorial along with a minor correction to a Page Layout Library entry we saved last time. 

http://members.shaw.ca/cue64/hardcopy.html
http://members.shaw.ca/cue64/tool.html
geopintro.html
gpintro.cvt
geopub1.html
geopub1.cvt
geopub2.html
geopub2.cvt
autoclock.cvt
geopub3.html
geopub3.cvt
geopub4.html
geopub4.cvt
geopub5.html
geopub5.cvt
geopub6.html
geopub6.cvt
wrdcount.cvt
wiw7.cvt
geodos.html
toolkit.cvt
tkit128.cvt
geopub7.html
geopub7.cvt
geopub8.html
geopub8.cvt
format8.cvt
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9. Column Analysis (February 1, 2004)  

- download Converted GeoWrite file  

- download Converted GeoWrite formatting file which explains text regions needed in geoPublish for 

importing the geopub9 article.  

- download Converted Text Manager sample file 

10. Importing Graphics Part 1 (February 22, 2004)  

- download Converted GeoWrite file (updated Nov. 2, 2004)  

- download Converted GeoWrite formatting file which explains text regions needed in geoPublish for 

importing the geopub10 article.  

- download Converted Photo Album file (updated Feb. 23, 2005) 

11. Document Renaming (March 12, 2004)  

- download Converted GeoWrite file  

- download Converted GeoWrite formatting file which explains text regions needed in geoPublish for 

importing this article.  

- download GetItWrite V2.0 file. This program is used to rename the file. Use CONVERT V2.5 to 

convert back to GEOS format.  

- download Times Roman font. This file needs to be converted back to GEOS format. It contains an 11 

point size which the original BSW LW Roma font does not. You will need this font to properly format 

the Dummy3 article.  

 

BONUS! - In article #3 I suggested that you make a Style Sheet to keep track of which fonts you are 

using for what part of the document. In article #7 I used a graphic and a table of values to make it easier 

to describe headline and text regions. I have put all of this info into a single page geoWrite file to make 

it easier to have it handy while you are working on the Tutorial. This is also a good example to use when 

you need to make up your own reference sheet for future projects. Download the GeoPublish Tutorial 

Style Sheet now. Make sure to have the LW fonts on the disk with the file when you print it out to get 

the proper formatting.  

12. Proof Reading (April 3, 2004)  

- download Converted GeoWrite file  

- download Converted GeoWrite formatting file which explains text regions needed in geoPublish for 

importing the geopub12 article.  

13. Importing Graphics Part 2 (April 23, 2004)  

- download Converted GeoWrite file  

- download Converted GeoWrite formatting file which explains text regions needed in geoPublish for 

importing the geopub13 article.  

- download Converted Photo Album file (updated Feb. 23, 2005) 

14. Free Flow Graphic Placement (May 22, 2004)  

- download Converted GeoWrite file  

- download Converted GeoWrite formatting file which explains text regions needed in geoPublish for 

importing the geopub14 article.  

- download Converted Photo Album file (updated Feb. 23, 2005)  

- download ScrapCan by Nate Fielder  

- download ScrapCan Documentation  

- download Screen2Paint Screen Capture Desk Accessory for use in Wheels 64 or Wheels 128 (40 and 

80 columns) by Maurice Randall  

- download Screen2Paint documentation  

15. Adding Special Text (July 10, 2004)  

- download Converted GeoWrite file  

- download Converted GeoWrite formatting file which explains text regions needed in geoPublish for 

importing the geopub15 article.  

geopub9.html
geopub9.cvt
format9.cvt
stylescraps.cvt
geopub10.html
geopub10.cvt
format10.cvt
pubpix.cvt
geopub11.html
dummy3.cvt
format11.cvt
getitwv2.cvt
troman.cvt
pubstyle.cvt
pubstyle.cvt
geopub12.html
geopub12.cvt
format12.cvt
geopub13.html
geopub13.cvt
format13.cvt
pubpix.cvt
geopub14.html
geopub14.cvt
format14.cvt
pubpix.cvt
scrapcan.cvt
scdox.cvt
scrn2pnt.cvt
s2pdox.cvt
geopub15.html
geopub15.cvt
format15.cvt
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16. Drawing Tools Part 1 (October 17, 2004)  

- download Converted GeoWrite file  

- download Converted GeoWrite formatting file which explains text regions needed in geoPublish for 

importing the geopub16 article.  

17. Corrections & Continuations (November 2, 2004)  

- download Converted GeoWrite file  

- download Converted GeoWrite formatting file which explains text regions needed in geoPublish for 

importing the geopub17 article.  

18. Drawing Tools Part 2 (November 28, 2004)  

- download Converted GeoWrite file  

- download Converted GeoWrite formatting file which explains text regions needed in geoPublish for 

importing the geopub18 article.  

19. A Quick Poster (January 23, 2005)  

- download Converted GeoWrite file  

- download Converted GeoWrite formatting file which explains text regions needed in geoPublish for 

importing the geopub19 article.  

- download Converted Photo Album file (updated Feb. 23, 2005)  

- download Photo Mover 40 V3.0 by Rick Coleman  

20. First Impressions (February 23, 2005)  

- download Converted GeoWrite file  

- download Converted GeoWrite formatting file which explains text regions needed in geoPublish for 

importing the geopub20 article.  

- download Converted GeoWrite file - Tutorial Index (updated June 4, 2005) 

- download Converted Photo Album file  

- download IconGetDbl by Robert J. G. Norton  

21. Creating Appendices (April 6, 2005)  

- download Converted GeoWrite file (updated May 8, 2005)  

- download Converted GeoWrite formatting file which explains text regions needed in geoPublish for 

importing the geopub21 article, how to add Page Graphics and how to add this format file to the 

Appendix geoPublish file.  

- download Converted GeoWrite file - Appendix A Index  

- download Converted GeoWrite file - Appendix B Index (updated June 4, 2005) 

- download Converted GeoWrite file - Appendix C Index  

22. Printing Part 1 (April 24, 2005)  

- download Converted GeoWrite file  

- download Converted GeoWrite formatting file which explains text regions needed in geoPublish for 

importing the geopub22 article, how to add Page Graphics and how to add this format file to the 

Appendix geoPublish file.  

23. Printing Part 2 (May 8, 2005)  

- download Converted GeoWrite file  

- download Converted GeoWrite formatting file which explains text regions needed in geoPublish for 

importing the geopub23 article, how to add Page Graphics and how to add this format file to the 

Appendix geoPublish file.  

- download Converted GeoPublish file that contains the color options available in PostPrint starting with 

Beta3.6. This file, and the next one, are made available with permission of Maurice Randall since some 

users may not have access to the files that accompanied the Beta versions of PostPrint.  

- download Converted GeoWrite file needed to print the B3.6 PostPrint News geoPublish document.  

24. Old Dog, New Tricks (June 4, 2005)  

- download Converted GeoWrite file  

- download Converted GeoWrite formatting file which explains how to import the geopub24 article, 

geopub16.html
geopub16.cvt
format16.cvt
geopub17.html
geopub17.cvt
format17.cvt
geopub18.html
geopub18.cvt
format18.cvt
geopub19.html
geopub19.cvt
format19.cvt
pubpix.cvt
mover4v3.cvt
geopub20.html
geopub20.cvt
format20.cvt
index.cvt
pubpix.cvt
icongetd.cvt
geopub21.html
geopub21.cvt
format21.cvt
apindexa.cvt
apindexb.cvt
apindexc.cvt
geopub22.html
geopub22.cvt
format22.cvt
geopub23.html
geopub23.cvt
format23.cvt
postnews.cvt
wrpost36.cvt
geopub24.html
geopub24.cvt
format24.cvt
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how to add Page Graphics and how to add this format file to the Appendix geoPublish file.  

- download Converted GeoWrite file - Appendix B Index (updated) 

- download Converted GeoWrite file - Appendix D Index  

- download Converted GeoWrite file - TutorialIndex (updated) 

- download Converted GeoWrite file - AboutAuthor to go on last page of Tutorial  

- download a picture of the Author to accompany the AboutAuthor article  

- download Combiner by Nick Vrtis - useful for appending one geoWrite file to another.  

That brings our geoPublish Tutorial to an end. 

enGEOy! 

  

apindexb.cvt
apindexd.cvt
index.cvt
author.cvt
BRUCE.JPG
combiner.cvt
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GeoPublish Tutorial copies available for purchase 

updated February 17, 2006 

 

I am ready to make hard copy versions of the geoPublish Tutorial available to those who want to buy one. 

 

The masters for the printed version were printed on a high-end Color Laser Printer and will be photocopied and 

cerlox bound with a clear front cover (so you can see the cover page) and a blue back cover. 

 

The entire publication is 110 pages. 15 pages have color. 

 

Mounted inside the back cover will be your choice of either one FD-2000 disk or two 1581 disks. The disk(s) 

will contain all of the files created/used in the Tutorial along with the GEOS PD programs that were used. 

 

The disk labels and the jackets they are mounted in are also laser printed. The jackets were designed in 

geoPublish and printed with PS.Processor to fit more than one on a page. 

 

Price for a photocopied edition will be US$30 plus US$6 for shipping anywhere in North America. Please e-

mail me for shipping price outside of North America. I prefer PayPal but will take cheques or International 

Money Orders in US Funds but have to add an extra $3 to cover the service charge my bank charges me for 

these items. 

 

Here is a bit of a bonus if you want one of these now. 
 

I have 21 copies of the geoPublish Tutorial that are all original prints. I am keeping number 1. The remaining 20 

(all sequentially numbered 2/21, 3/21, 4/21....) are available while they last for the price of US$30 (this includes 

shipping in N. America). 

 

Not only are these first copies all original Laser Printed Editions but they have a total of 31 pages with color (16 

more than the regular editions will have). 

 

So far, 17 of these original Laser Printed Editions have been ordered leaving only 4 more to go. 

 

After these are gone the rest of the hard copy versions will be photocopies with only 15 pages with color and 

you'll have to pay extra for shipping. 

 

Send your PayPal payment to rbthomas59(at)shaw.ca or contact me via e-mail to request the address to mail 

your payment to. 

 

enGEOy! 

 

Bruce Thomas 
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Tools for working with GEOS files 

 

Tools  

Of course, GEOS files can't be uploaded or downloaded in their native format. In order to transfer these files 

they have to be CONVERTed. If you don't have Convert or GeoConvertE98f you will need a copy.  

This BASIC Program (13 KB), when run, will create a GEOS copy of Convert for you. Ignore the '.cvt' 

extension (it is just there to make your download smoother) and RUN this program from the BASIC prompt on 

your C= 64. You can then use the generated copy of convert from within GEOS to convert this GEOS Desk 

Accessory (6 KB) version of Convert.  

In order to make use of the geoPACKed files (.pck and .lnx) you will need to download geoPACK (below) to 

unPACK the archive.  

For D64 Image files you can use either GeoConvert98F (15 KB in geoPacked form) or GeoBEAP (which can 

be found on Bo Zimmerman's Web Site - check the Projects Page).  

The Zipped files on this site were created with Todd Elliott's GeoZIP V0.8. You can follow this next link to find 

the download copy of GeoZIP V0.8 .  

Once you have the D.A. version of Convert you can use it to convert geoPack (11 KB). 

  

http://members.shaw.ca/cue64/convertgen.cvt
http://members.shaw.ca/cue64/convertda.cvt
http://members.shaw.ca/cue64/convertda.cvt
http://members.shaw.ca/cue64/geoconv98f.pck
http://www.zimmers.net/geos/index.html
http://www.cs.tut.fi/~albert/Dev/gunzip-geos/
http://members.shaw.ca/cue64/geopack.cvt
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GeoPublish Tutorial - Introduction 

Do you want to exercise your freedom of the press? Are you one of the people who has tried geoPublish but 

have become frustrated by the complexity of the program? Have you been able to produce a simple flyer but 

want to learn how to make really impressive publications? Do you want to learn how to access PostScript 

printers to get the best output possible from your 20 year old computer? Would you be interested in a series of 

articles, a prolonged tutorial, to show you how to use all of the features of geoPublish? 

My aim with this series of articles is to provide a single source of information that you can have close at hand to 

refer to when working with GeoPublish (gP). The articles will provide the details of the project including step-

by-step instructions and will be used to create the finished product. You will be able to work through the 

examples as we go, put together the gP documents (there will be more than one) and print off your own copy 

that will be suitable for binding. 

While the main objective is a big one it will be made up of smaller projects. During the course of this series we 

will learn about page layout and design, we will plan ahead to have a consistent look to a big project, we will 

see how to use gP to create a quick party invitation poster, we will work with plenty of GEOS programs that 

make using gP easier, and we will use all of the tools that gP has. 

You may wonder if there is a need for this kind of project. I believe there is and that now is the best time to start 

this. To begin with, more and more people are getting turned on to the power of gP due to the COPS Mailing 

List and the availability of low-cost PostScript-equipped Printers. These people need help to get the most out of 

gP. I have been using gP for 15 years and have used it to create posters, newsletters and business cards as well 

as publishing a book. I doubt there is something that can be done with gP that I haven't done. I like to help 

others increase their productivity and enjoyment of their time at the computer so this project was born. 

I am going to make some assumptions during this series. First off I am going to assume that you know how to 

use GEOS, that you own a copy of gP and that you have read the manual. I am going to assume that you have at 

least 2 drives to work with - preferably one is a large RAM Disk (if you don't you can still work through this but 

you will have to do a lot more work to juggle files on multiple disks). 

I am going to assume that you have the two-disk version of gP that is dated 10/4/88. There were a number of 

versions of gP and this two-disk version has some important bug-fixes in it. If you don't have the same version 

of gP then you won't be able to load and print off my documents as there are some incompatibilities between the 

versions. The two-disk version also includes a manual addendum, the Graphics Grabber program and some Clip 

Art that we will make use of in the examples. To get the manual addendum or the 2-Disk version visit the Click 

Here Software web site and contact Maurice Randall. 

I am also going to assume that you have internet access. This series will be Internet-based. Announcements will 

go out on the COPS Mailing List when new articles are available (about every 3-4 weeks). The COPS list 

(Commodore Only PostScript) is a mailing list for people who want to know how to get the most out of 

GeoPublish using PostScript equipped printers and learn about geoPublish as well. 

The articles and support files will be available for download from the CUE Web Site so you can work through 

the process and create your own copy of the Tutorial as you learn. If you have any questions feel free to contact 

me via e-mail at cue64(at)shaw.ca. 

So, with these thoughts in mind, let's get started learning how to get the most out of geoPublish. Bruce Thomas 

July 2003  

http://cmdrkey.com/
http://cmdrkey.com/
http://cbm.videocam.net.au/mailman/listinfo/cops
http://members.shaw.ca/cue64
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GeoPublish Tutorial Part 1 – Sophisticated Software 

Think fast! What is the first word that comes to mind when someone mentions geoPublish? 

For a lot of people the word would be complex or difficult or frustrating. The box calls it 'sophisticated' which is 

marketing talk for 'lots to learn'. 

Since the program is so 'sophisticated' a lot of people have become discouraged and have never realized the true 

power that geoPublish (gP) puts at your fingertips. I have been using geoPublish for over 15 years now and 

have done just about everything with it. 

In any gP project there are six main phases. 

1. Pick your topics and write your articles 

2. Design your columns and main page format 

3. Create text regions and import your articles 

4. Edit your text and fix any errors 

5. Add graphics (including lines, boxes...) 

6. Print your project 

With this series of articles I will take you from start to finish through the creation of a fair-sized publication. In 

the process we will use all of the power that geoPublish has to offer. When we're done you should have all of 

the knowledge, and a good resource, to get you through almost any publishing task. 

How do you spell Relief? 

Great! Finally someone is going to show you how to use this behemoth of a program. You read the ads. You 

wanted to make great looking newsletters. You wanted your own freedom of the press. You wanted to impress 

your family and friends with what your Commodore could do. So you bought the program. 

What you got was a quick lesson in the definition of 'sophisticated'. You soon realized that your single drive 

system lacked the necessary storage space to create much of a newsletter. Your Dot Matrix printer, even with 

the best multi-strike or interpolating driver, left much to be desired when it came time to print your creation. 

And your family told you the layout did not really catch their eye or make them want to read it. 

So here comes a series to teach you how to publish like the pros. You're ready. You're itching to learn. You've 

fired up your GEOS or Wheels system and have started geoPublish. You've pressed the Create button and 

entered a name for your file. The blank Page Graphics Mode screen is staring back at you, silently waiting, as if 

daring you to take your best shot. 

Ooops! Wrong way to get started. 

Learning to Crawl 

The proper way to get started, if you want to make front page news with GeoPublish, is to sit down at the table 

with a pencil and pad of paper and start to design your newsletter. But you're new at this. How can I expect you 

to design a layout when you don't know how to use geoPublish? Easy. 
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A carpenter has to have a blueprint and know the length to cut the boards and the proper spacing for the studs 

before he picks up his hammer to put it all together if he wants the building to stand up. GeoPublish, like the 

carpenter's hammer, is just a tool that lets us create our publications on the computer. Before we use the 

hammer, though, we have to know something about page layout, we have to have something to write about, and 

we have to have a plan for our project. 

In order to learn a bit about page layout take a look at your favorite magazines. Most likely they are fairly 

popular and there is a reason for that. Why do you like them? Is it the articles? Is it the pictures? Is it the way 

the two are mixed? Is it the size of the type? The number of columns of text? 

Flip through the magazines and make note of pages that grab your attention. Make note of which magazines are 

easier to read than the others.  

There are entire books and magazines about page layout and design so you can imagine that this topic is beyond 

the scope of this series of articles. I will concentrate on using the capabilities of GeoPublish so feel free to look 

for outside sources to make your special project have the impact that you want. A good book that I have been 

using for a number of years called Looking Good in Print (Roger C. Parker, ISBN 1-56604-471-5) is an 

excellent, easy to read reference. While it comes with a CD containing programs for PCs and Macs the book 

deals with layout and design concepts and is not written with any specific program in mind. This book is 

available used on Amazon.com for as low as $2.50. 

All the news that's fit... 

By now you should have realized that the design and layout of a publication are almost as important as the 

material that is presented. Of course, if the articles on the pages do not interest you, contain spelling and 

grammatical errors, or contain inaccurate or incomplete data it won't make any difference how spectacular the 

layout is.  

The reverse is also true. If you have award-winning material but you insist on cramming it all together, printing 

it too small, not leaving enough white space or placing graphics in the wrong places, nobody will read it.  

It is very important to allow the reader's eyes to rest. Use columns so that it is easier for the reader to find the 

next line (shorter lines make it easier for the reader's eyes to scan back and down to the next line). Pick an 

appropriate font size (consider your readers - older readers may mean you use a larger point size). Place your 

graphics in a logical spot - don't break up a paragraph by putting a graphic where it shouldn't be. 

Between the lines 

I've covered a lot here. Did you pick up all of the points? A big one that is hidden in all of the above is that what 

you like or want isn't as important as what your intended audience likes or wants. That isn't to say you shouldn't 

do something to make yourself happy but, unless you are doing all this work to publish a newsletter for 

yourself, the reader is who you are doing this for. Know your target audience. 

Another big item is to figure out your schedule. Is this going to be a one-time 'lost dog' poster? A single-page 

weekly flyer? A monthly newsletter? Are you publishing a book? I've done all of these things with geoPublish 

and it handles them all equally well. You just have to prepare ahead of time before you pick up that hammer. 

I hope this has provided a bit of an introduction to publishing. Next time we'll delve a little deeper into what 

GeoPublish is all about. In the meantime you can get out your GeoPublish Manual and read through it. Keep it 

http://www.amazon.com/
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handy throughout this process so you can look things up if needed. When I reference the Manual I'll enclose the 

page number in square brackets like this - [gP Page 3-25]. 

Until next time, enGEOy your Commodore!  
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GeoPublish Tutorial Part 2 - A Quick Tour 

Hi. Nice to see that you're back. I'm glad I didn't scare you away with that first article. 

I'll tell you now that this project isn't going to be easy. It will take quite a while to cover the many features of 

geoPublish. 

You must also know that you will find this easier if you have more than one 1541 disk drive (165 KB space) for 

this. It is possible to use geoPublish when you only have one small drive but it is painfully slow and you are 

very limited in what you can do. For instance, you are very lucky if you can use more than 2 fonts in your 

document which really limits your creativity.  

If you have a basic system don't get scared away. Just realize that your work is going to take longer and you will 

have to split files up over multiple disks. One such practice is to have your Photo Album and Photo Manager on 

a separate disk and just copy over the individual Photo Scraps when you need to insert them into your 

document. Until I realized what an amazing program GeoPublish was I used it on a bare bones C-64 with one 

1541 drive. After meeting several monthly deadlines I got a 1351 Mouse and a 1764 REU. A short while later I 

got a second 1541. Life with geoPublish improved immensely thereafter. 

Basically, since geoPublish is 99 KB in size, you want as much storage space as you can get. This can all be 

done with two 1541 drives but an FD-2000 (1.6 MBs), CMD HD drive or RAMLink are your best bets. The 

more RAM you have to work with the better as access times are nearly instantaneous. You should also be 

running Wheels, the GEOS upgrade from Maurice Randall, as it lets you use partitions up to 16 MBs in size on 

the HD or RL which comes in real handy for large GeoPublish projects. If you have a Schnedler 4 MHz 

TurboMaster Accelerator or a CMD 20 MHz SuperCPU Accelerator you will also benefit from the greatly 

reduced time to redraw screens although there are ways to work around this without an accelerator. 

Input/Output 

Your Input Device is important also. While GEOS or Wheels will work with a Joystick the best input option is a 

mouse. The C= 1351 mouse is a good device but a CMD SmartMouse is even better. The SmartMouse has a 

third button which can be used for handy features plus it has a clock device to automatically set your System 

Time. If you don't have a SmartMouse or another CMD Device with a clock (FD, HD, RL) then you should 

seriously consider adding an auto-time utility (Rick Koch's AutoClock is my favorite) to your boot disk so you 

set your system time during every bootup. Don't underestimate the importance of setting the time. Checking the 

time and date a file was created can help you make sure you have the latest version of a file and prevent lost 

hours of work. 

We are also going to work towards PostScript (PS) output. This provides the best possible output due to the 

ability to use scalable PS fonts and high resolution output devices. Don't worry if you don't have your own PS 

equipped printer. I started using PS Lasers (worth $6000!) in 1988 and didn't get my own (worth about $400 

used) until 1997. We'll look at ways you can access PS Printers without owning one. Nevertheless, you can still 

print out our project on a Dot Matrix or InkJet printer and get decent results if you choose the right fonts and 

have the right printer driver. 

OK. So you are still here. Very good. At least everyone knows what we are trying to accomplish. On with the 

fun. 

  

http://members.shaw.ca/cue64/autoclock.cvt
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Four Modes 

GeoPublish has four distinct modes of operation. These are Master Pages Mode, Page Layout Mode, Editor 

Mode, and Page Graphics Mode. We'll take a brief look at each of these modes and the part they play in our 

creations. 

For some odd reason the designers of geoPublish made it so that you start in Page Graphics Mode when you 

create a new document. The reasoning behind this is unimaginable. The real starting place for a new file should 

be Master Pages Mode. 

In Master Pages Mode you can work on the full page or you can zoom in to a small portion of the page. This is 

very handy as you can create the guidelines for your columns, plus you can place graphics (company logo) or 

text (page numbers and footers) in a very precise manner. Guidelines created here are visible while you work on 

your project but are not printed out. Any text or graphics that you place in Master Pages mode will show up on 

every page in your project. 

Master Pages Mode is also where you setup your main document parameters. Do you want to have a left and 

right page layout (to allow room for a book binding for instance)? If this is Chapter 2 you'll want the page 

numbering to start with something other than 1. How many columns will your layout use? Create Guidelines 

here so that each page layout is the same. If you are working on a regular publication you will want to save your 

Master Page layout into a Library file to make creation of the next edition easier. 

Once you have created your Master Page guidelines you need to head off to Page Layout Mode. In this mode 

you use the Open Region tool to create Text Regions and then pour your GeoWrite files into these regions. It is 

also possible to place graphics in this mode but this is not the best method in my opinion. 

Working in tandem with Page Layout mode to make sure your publication is the best it can be is the Editor 

Mode. This mode is very similar to using GeoWrite V2.1 except you don't have to leave geoPublish to use it. It 

is only possible to go to Editor Mode if you are already in Page Layout Mode. 

In Editor Mode you can change the fonts and margins of your text files. You can cut, copy and paste text 

between different documents if you have to. Desk Accessories are available in case you want to paste in a 

picture (again, not the best way to do this in my opinion) or some text or need to do a quick calculation or to 

play 'Hazard!'. 

Finally we get to Page Graphics Mode. This is the mode that I recommend you use to paste in pictures and lay 

out your headlines. Page Graphics Mode is one of the few Commodore drawing programs (yes, you have a full 

suite of drawing tools at hand) that lets you work on the entire page at once. You can create boxes and circles in 

any fill pattern. You can layer items by putting one graphic over another. Lots of interesting effects can be 

created here. 

Your headline text can use all of the styles. Special MegaFonts and LaserWriter PostScript fonts let you create 

headlines over 2.5 inches tall that print out with fewer jaggies. 

Page Graphics Mode is where you add all of the little touches that will make your publication special. This is 

the place where you actually see what your creation will look like on paper. The other three modes let you 

create the structure and content of your project but Page Graphics Mode is where you make it shine. 

http://sean.adventureteam.com/pages/geos/hazard.htm
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If you are just creating a Garage Sale or Lost Dog poster you can do the entire thing in Page Graphics mode 

very quickly. At the EXPOs that our club held I was able to quickly create posters using GeoPublish and an HP 

Laser Printer for the various booths, demos and displays as the shows were being setup. 

Play around in each of these modes and see what you can discover. Next time we'll finish our pre-planning and 

preparations.  Until then, enGEOy your Commodore! 
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GeoPublish Tutorial Part 3 - Planning and Preparation 

So far we have looked at some of the layout and design concepts that you need to take into account for each 

project you work on. We have also had a quick tour of the four main operating modes of GeoPublish. This time 

around we are going to finish our planning and do some final preparation. 

Pre-Planning 

Our project is to create a GeoPublish Tutorial using these articles as the text. We will, for the most part, use a 2-

column layout with a large space for Article Titles at the top of each page. We will use Left and Right Master 

Pages so we can bind the finished product or punch holes and keep it in a binder without infringing on the text. 

Page Numbers will appear in the lower left corner of Left Pages and in the lower right corner of Right Pages. 

With this in mind it should be obvious that we are aiming for double-sided printing. We will place footers at the 

bottom of the pages to identify the publication. We will create a main title page with an index of articles.  

Part of our planning process involves determining what output device we are going to use. Since November of 

1988 my output device of choice has been a PostScript equipped printer. As mentioned last time, one of the 

biggest reasons for this is the crisp printouts using the scalable PS fonts. GeoPublish comes with 4 "LW" 

(LaserWriter) fonts and 7 other LW fonts were later released by Berkeley Softworks (LW_Zapf is an improved 

version of LW_Galey). 

These fonts allow you to layout your document and get a relatively close approximation on-screen, and with 

regular printouts, of how your text will format on the PS Printer. When you do print your document, with 

GeoPubLaser or PostPrint, the Printer's built-in PS Fonts are substituted for the LW fonts in your document. 

Due to this part of the process it is important to know what fonts your printer supports. Your printout is done at 

the resolution of the printer (I have used 300, 600, 1200 and 2400 DPI PS Printers) rather than the 80 DPI of the 

GEOS screen and printers.  

If these 11 LW fonts aren't enough for you then contact Dale Sidebottom (luckykds@iglou.com) and order his 

Laser Lover's Disk (LLD) and learn how to make use of hundreds of Public Domain PS fonts in your 

GeoPublish output. Dale also teaches plenty about using PostScript to get the most out of your printing 

experiences and the LLD is the only official source of the PostPrint program. 

An added bonus of using a PS Printer for your output is speed. It used to take over 20 minutes to print one page 

with a multi-strike printer driver on my Dot Matrix printer. Using a PS Laser I have printed over 20 pages in 

just under 20 minutes. 

It is also important to know the printout area supported by your printer. The first time I did a printout on an 

Apple LaserWriter using Legal sized paper in landscape mode I thought I had messed up in a big way as the 

edges did not print out. It turns out that the Apple LaserWriter would only print 6 3/4 inches across an 8 1/2 

inch sheet of paper in landscape mode. Not what I wanted or what I was expecting. 

Workspace 

As mentioned previously the ideal setup for our project would be Wheels with a 16 MB RAMLink and as large 

a partition as you can set aside. Dedicating a full 16 MB partition on a CMD HD drive would also be very good 

although access times are noticeably slower when working from the HD. For this project, create the biggest 

partition that you can on the fastest drive that you have and then continue on. 
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What we want in our working partition to start with is GeoPublish and the Printer Driver your system is setup to 

use. Depending on how your system is configured you might also need the Desktop or a Configure File if using 

GEOS.  

Ideally we want to have a separate 'style sheet' listing what each font will be used for and the point size for that 

particular use. In this way you can easily reference your style sheet rather than having to go back to previous 

pages to check what font and size you used. The consistency this provides will give your publications a more 

polished and professional look. Copy these fonts to your geoPublish Project Disk and then print out this list for 

handy reference. 

LW_Roma (aka Times Roman) 

Front Page Headline - 80 points (bold) 

Article Text - 12 points 

LW_Cal (aka Helvetica)  

Article Title 30 points (first page) 

24 points (subsequent) 

Sub-Headings - 14 points (bold) 

LW_Zapf (aka Zapf Chancery) 

Page Numbers - 14 points 

Continued - 10 points 

LW_Giannini (aka Avant Garde) 

Footers - 14 points 

Captions - 14 points 

Call Outs - 18 points 

LW_Shattuck (aka Zapf Dingbats) 

End of article - 12 points 

Note - (if you are using two disk drives the fonts, printer driver and any Desk Accessories need to be on the disk 

with GeoPublish and your documents need to be on the disk in the second drive). 

If you still have enough space add geoWrite, geoPaint and the Photo Manager. 

Not Charlie McCarthy 

The next thing we need to do is create a couple of Dummy Articles. These come in very handy during the 

creation of any geoPublish document in case you find that you have some extra space to fill or come across 

some new information that will make a great article. Rather than having to exit geoPub and start geoWrite to 

create the new piece (you can't create new geoWrite files with the Editor Mode) you just import one of your 

Dummy Articles and then rename it later. 

Start geoWrite and create a new file called Dummy1. Select the LW_Roma font in 12 point size and write 

anything you want. A simple sentence or just one word will do. Close that file and create a second one called 

Dummy2 and do the same with the font selection and short writing. Save both of these files to your document 

disk. 
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And speaking of our document disk, I like to have three disks that I save my files to. I rotate the disks for 

backup purposes so that I am not going to lose any more than one days (or a few hours) work. For this project I 

have a partition on my RAMLink plus two Native formatted (1.6 MB) FD floppy disks. One of the disks is 

labelled 'even days' and one is labelled 'odd days' and I swap them daily to store my latest file versions on. In 

this way, if something happens to my RL, I am covered. If a file gets corrupted on my RL and I copy it to one 

disk I still have the other copy on the other disk so I am only going to lose what I did that day. Make yourself 

some project disks. 

The other thing that will really help once we start using Page Layout mode is to have a good idea how big the 

articles are. To get this kind of feel for your layout make sure you format your GeoWrite articles in the font and 

size that you want (LW_Roma 12 point in this case) and print off your articles. Take the time now to proofread 

what you have written. 

With your printouts you should be able to gauge whether a certain article will require 1 1/2 pages or 2 full pages 

or more. If you know this, and add this to your sketches, you have a good idea where to break columns and if 

one article will fill a certain page location better than another article. 

That ends our initial preparations. Next time we will begin creating our first geoPublish document. 

Until then, enGEOy your Commodore!  
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GeoPublish Tutorial Part 4 - Master Pages Mode 

Our initial planning phase is complete so it is time to get started on our Project. We are going to create and save 

our Master Pages and there is a lot to cover. Unfortunately, I couldn't decide on an appropriate place to break 

this topic up so this is a long article. 

Start GeoPublish, choose the Create new document button and then enter "TutorialPart1" as the name of the file. 

If you are using two drives make sure you use the Drive button to create your file on the second drive. The file 

opens up in Page Graphics mode but we want to change to Master Pages Mode so choose the Mode Menu and 

then select Master Pages (make note of the Commodore Key shortcuts as they are much quicker to use to 

change modes). If you have, or can get, a copy of the July/August 1991 RUN Magazine there is a great chart 

listing all of the geoPublish keyboard shortcuts. 

Follow the Blueprint 

Much of what we determined previously in our Pre-Planning steps gets done in Master Pages mode. Remember, 

everything we do here will be visible on every page in our project. Text and graphics will print out but the 

guidelines won't (unless you specifically choose to print them).  

The first thing we need to do in Master Pages Mode is setup our file. Choose the File Menu and then Doc Setup. 

Each GeoPublish document is limited to 16 pages and then we have to start a new document. The Page Number 

option lets us keep numbering continuously across multiple geoPublish documents. For our first document we 

want the starting page as #1.We also want 2 Master Pages and the Right Page as the first page. Press the OK 

button to return to Master Pages mode. 

Now we are going to set our Column Guidelines [gP Pages 4-5 and 4-6]. Make sure the Pointer tool [gP Page 3-

5] is selected and then move your pointer into the Top Guideline Margin. Your pointer will change shape. Move 

it along the margin and click your mouse button at the 1 inch, 4.5 inch and 8 inch marks across the top of the 

page. This will create dotted lines down the page which can be used for one wide column or two narrow 

columns. 

Set guidelines at the 1/2 inch, 1 inch, 1 1/2 inch, and 10 1/4 inch marks in the Left Guideline Margin [gP Page 

4-5]. To set the 10 1/4 inch (10 18/72) guideline you must position your pointer as close as you can and then use 

the cursor keys to move up or down until the display under the Y indicator in the Document ID box [gP Page 3-

5] shows 10 1/4.  

These guidelines will help us layout the majority of our headlines and two-column text regions in Page Layout 

mode. For some of our pages we will want to use a 3 column layout. To accomodate this create two more 

vertical guidelines in the Top Guideline Margin at the 3 26/80 and 5 54/80 marks. You will have to use the 

cursor keys to position these guidelines. 

If you have read through your GeoPublish manual you may be wondering why we just don't use one of the 

Master Page Layouts provided in the sample libraries. I have a number of reasons but it mainly comes down to 

Column Spacing and Gutters. We'll get to Gutters shortly when we deal with Page Layout Mode. 
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Special Text 

What we want to do next is setup our page numbering. Go to the DISP menu and select Zoom. A box will come 

on the screen instead of your mouse Pointer. Move to the lower right corner and press your mouse button. You 

will now see a closeup of that corner of the page. Two of our guidelines should be visible in the closeup view.  

If you don't see the two guidelines check the Page Indicator at the top of the screen to the left of the Document 

Title Bar (this isn't identified in the gP manual but is in the geoWrite sections on Page 150 of the GEOS v2.0 

manual and Page 5-2 of the GEOS v1.2 manual). The 'writing window' is the dark box in the Page Indicator. 

Drag your pointer to the edges of the screen to move the writing window to the bottom right corner of the Page 

Indicator. 

Select the Text tool [gP Page 3-5] in the toolbox on the left side of the page and then position your mouse 

pointer under the horizontal line and about 1/2" to the left of the vertical line. When you click your button a box 

will open up allowing you to enter text. 

Enter the word "PAGE" in all-caps and without the quotation marks. The program will substitute the actual 

page number for this keyword when the project gets printed. Click on the Attr button to set the Attributes for 

our Page Number. We said that LW_Zapf was going to be used for page numbers so click on either scroll arrow 

beside the Font box to select LW_Zapf. If you don't see LW_Zapf in the list make sure you have copied it to the 

same disk that you have geoPublish on. Select 12 for the Pointsize. Set the Justification option to Right and 

leave everything else alone. Click OK to return to Zoom mode. 

You should now see the word PAGE crammed over to the right edge of the view. In order to make changes we 

need to select the Pointer tool in the toolbox. Once you select the Pointer Tool click on the word PAGE to bring 

up the bounding rectangle [gP Page 3-21]. Click on the Size Button and move this to the left until it is aligned 

with the vertical guideline and then click to set the new position. If the text is not all visible in the bounding 

rectangle click on the Move Button to move the entire box to the left and then use the Size Button again to re-

align the whole thing with the vertical guideline. Click on the Pointer Tool in the Toolbox to make the bounding 

box disappear. 

Actually, clicking anywhere on the screen will also work but that can cause problems. If you have drawn a 

border around the entire page you may not see it when you are in Zoom mode. When you click anywhere on the 

screen you would make the bounding rectangle on the word PAGE disappear but you could actually be 

selecting the page border. When an object is selected you are not able to scroll the screen. Since you can't see 

that an object is selected it can be confusing as to why you are unable to scroll the screen. To avoid this it is best 

to just click on the Pointer Tool to remove the bounding rectangle when working in Zoom mode. 

Now that we have placed Special Text in Master Pages Mode I'll let you in on a little secret. The same process 

is used to place Special Text in Page Graphics Mode. You will have to know how to do this.  

Another little secret is that you need to make sure there is enough room in your Bounding Rectangle to contain 

the text. Leave plenty of space around your text. This is necessary as the LW Fonts are only a good 

approximation of the PS fonts. If your bounding rectangle fits tight around the text it contains there is every 

likelihood that some of the text will get cutoff when it is printed on the PS Printer. With practice you will learn 

how to size these text boxes. 

We are now done with our Page Number so go back to the DISP menu and select Preview. You will be returned 

to the full page view. 
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On our Right pages we want to have a footer that says "files available at http://members.shaw.ca/cue64". We 

also want a line going across the page at the 10 1/4" mark. To make drawing the line easier go to the Options 

menu and select Snap (C= S). This turns the guidelines into a 'magnet' that attracts and holds your pointer and 

makes it easier to put objects exactly where you want them. 

Select the Line tool in the toolbox and then select the Attributes tool right below it (or use the C= A shortcut). 

We want the square shape, set line width to the narrowest it can go with the down arrow button, Transparent 

mode and solid black pattern. Click OK. 

Move your pointer onto the page and down to the bottom where the 1" and 10 1/4" guidelines intersect. As you 

get close you will see that your pointer SNAPs onto the guideline. Click your mouse button and then drag the 

line across the page to the 8" guideline and click again. 

To put our footer text onto the page go into Zoom Mode and move to the lower left corner of the page. Select 

the Text tool and then bring up the Attributes (C= A). SNAP does not work in Zoom mode so move your 

pointer to the first dot on the 1" Guideline directly below the horizontal line we just put on the page. Click your 

mouse button and the text entry box will appear. Enter ("files available at http://members.shaw.ca/cue64") for 

our our footer text and then press the Attr button. We want LW_Giannini in 14 point, solid black, Center and 

Across and then press OK. 

You should be able to see some of the text at the right edge of the zoom window. Scroll to the right side of the 

page and then select the Pointer Tool. Click on the word 'cue' in our footer text and the bounding rectangle will 

appear. You will see that this rectangle goes all the way to the right side of the page. We want our text centered 

between our guidelines so click on the SIZE button and drag the edge of the rectangle back to our 8" guideline. 

Make sure you drag the rectangle down a bit as well to expand it for the text. Once you have the rectangle in 

position click the Pointer tool to deselect the text. 

You may notice that our PAGE text is no longer visible. Choose the Update tool [gP Page 3-5] to refresh the 

page and make PAGE visible again. Return to Preview Mode (C= P). 

As you saw previously when we created our special text and chose CENTER the area for it stretched all the way 

across the page. There will be times when you want to CENTER your text in a narrower area. In those instances 

just enter one word and leave the justification at LEFT before closing the text box. Then you can size the 

bounding rectangle and edit the text before choosing CENTER without having to scroll to the right edge of the 

page and shrink the box (which can be a real pain if you are working on the left edge). We'll use this technique 

later on. 

Copy and Edit 

We could do the whole thing over from scratch again for our Left Master Page but we'll take a bit of a shortcut. 

Press the Left button on the left side of the screen. You will see that our Left Master Page is blank. Press the 

Right button to return to our Right Master Page and then press the COPY button. Now press the Left button 

again and you will see that everything we just created has been copied to the Left Master Page. A great time 

saver these computers are! 

But, since we are going to have different margins to make room for a binding and we want the page number in 

the opposite corner and a different footer, we have a bit of touchup to do. 
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Select the Guideline at the 1 inch mark (click on the symbol in the Margin) and drag it to the left to the 1/2" 

mark. Drag the other 4 vertical guidelines 1/2 an inch to the left so that we have guidelines at 1/2", 2 66/80", 4", 

5 14/80" and 7 1/2". Use the cursor keys to set the positions as required. Our horizontal guidelines don't have to 

be changed. 

If you have to remove a Guideline after setting it just select it by clicking on the marker and then drop that onto 

the ruler markings. For any of these Graphics or Special Text elements on our pages if you make a mistake or 

need to fix things you can highlight the item with the Pointer Tool and then use the Delete Tool [gP Page 3-6] to 

remove the item. 

In the lower right corner of the page you should see a bit of a blurry area where our page number is. Turn SNAP 

off and then click on the blurry area with your pointer and the Bounding Rectangle should appear with the 

Move and Size buttons. Click on the Move button and drag the Page Number across to the left corner by the left 

vertical guideline. Click to place the box and then select Zoom from the Disp menu. Place the Zoom box in the 

lower left corner and click to place it. 

When the zoom screen opens click on the word PAGE again to bring up the box. Use the Move Button to line 

the box up just below the horizontal guideline and even with the vertical guideline. With the bounding box still 

visible select the Attribute Setting Tool from the toolbox [gP Page 3-5]. When the Attributes come up change 

the Justification from Right to Left. Leave everything else alone and press OK to exit. The word PAGE should 

now be at the left edge of the box. Resize the bounding rectangle and then click anywhere on the zoom screen to 

get rid of the bounding box. 

Next we want to change our Footer text for the even numbered pages. Click on the word "files" in the visible 

portion of the footer text. Use the C= A shortcut to bring up the Attributes box and then press the Edit button. 

Delete all of the text and then enter "GeoPublish Tutorial - 2003/2004". Click OK. Click on the Move button 

and drag the footer text to the left to line up with our guideline. Click the Pointer Tool to remove the bounding 

rectangle. Scroll to the right edge of the page and make sure the footer bounding rectangle is lined up with the 

right guideline (click in the area where you know the rectangle should be and then use the size button to line up 

the box with the guideline). 

Libraries 

Since we will need to use these same Master Page Layouts in the subsequent files of our project we need to save 

them to a Master Page Library. From the File Menu select Library. Create a new library file called 

"TutorialMaster" and save the page layout as "LeftMaster" in the first Empty position. Once that has been saved 

click on the Right Button to view the Right Master Page. Again, select Library from the File menu and then 

choose the second Empty entry. Enter "RightMaster" as the name to save this layout as. 

That is it for this time around. Copy the TutorialMaster MP Layout file to your backup floppy disk along with 

the TutorialPart1 geoPublish file. Next time we will create some Page Layouts and begin to pour our articles 

onto the pages. 

Until then, enGEOy your Commodore!  
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GeoPublish Tutorial Part 5 - Page Layout Mode 

In this column we are going to start to 'pour' our geoWrite files into columns in our geoPublish document. To 

start with, however, we have to make a correction to the manual. 

On Pages 3-10 and 3-11 of the geoPublish Manual we are introduced to the Page Layout Toolbox as part of the 

Tutorial chapter. Two of the tools are mislabelled. 

On Page 3-10 the tool identified as the "Delete Region Tool" is actually the "Clear Region Tool". On Page 3-11 

the tool identified as the "Clear Region Tool" is actually the "Delete Region Tool". I think you can see how this 

would be an important difference to know. 

Start up geoPublish and OPEN the TutorialPart1 file that we created last time. Select the Mode Menu and then 

Page Layout mode (C= L). This mode is where we create Regions to pour our text into. We need to do a little 

preparation before making our regions though. 

Gutterball 

Remember how I said that I didn't like the Sample Master Pages that come with geoPublish because of the 

column sizing and use of Gutters? We're going to learn about gutters now. 

If you have ever gone bowling you know what a gutter is. It is the trough down the sides of the lane where the 

ball goes if you don't throw it straight. The gutters stop your ball from encroaching on the lane beside you. In 

geoPublish a Gutter does the same thing - it prevents text from one column from running into text in the column 

beside it. 

One nice thing about geoPublish is that we can set the gutters for each individual text region. We will take 

advantage of this later on. For now we want to check the Default Gutter values that will be used for each and 

every Region that we create. 

Select the 'options' menu in Page Layout Mode and then choose the 'set gutters' option. When the dialog box 

appears you will see that the default value is 5 for the left, right, top and bottom gutters. Remember that our 

screen resolution in GEOS is 80 Dots Per Inch (DPI) in the horizontal direction and 72 DPI in the vertical 

direction. We are going to have two columns beside each other. So, with a gutter value of 5 for the right gutter 

of the column on the left side of the page and a gutter value of 5 for the left gutter of the column on the right 

side of the page (draw a picture if you have to, I won't start with screenshots for a while yet) you can see that we 

will have 10 points between our left and right column text. At 80 DPI this means we have 1/8th of an inch 

between our columns of text, which isn't a lot. 

Generally, I like to set the default left and right gutter values at 10. This gives a total of 20 points (or 1/4 of an 

inch) between the text columns. The largest gutters we can create are 1 inch meaning a value of 80 for the left 

and right gutters and a value of 72 for the top and bottom gutters. We will do more gutter manipulation 

throughout this project. For now we will leave the default values alone so just press the OK button. 

Our Master Page was laid out so we have choices of single column pages, 2-column pages or three column 

pages. We will start by using a 2-column layout for the first article. Since this is the first page for a new article 

we will also need to define a large title region. 
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In the options menu turn on SNAP. Select the 'Open Region Tool' [gP Page 3-11] and move your pointer onto 

the Page Work Area [gP Page 3-5] where it will take the shape of a crosshair. Move to the top left hand corner 

of the page and your crosshair should SNAP to the guideline junction. We want to create a region across the 

page from the 1" guideline to the 8" guideline and down the page from the 1/2" guideline to the 1 1/2" 

guideline. Click your mouse button to set the start point and then move your mouse over to the lower right 

corner of this area. Your crosshair should SNAP into place so just click your button to set the region. If you 

place the region incorrectly select the Pointer tool, click anywhere within the new region and then use the Move 

and Size buttons to fix the placement of the region. 

We will now create two regions to hold our article. These will go from the 1 1/2" guideline down to the 10 1/4" 

guideline and will use the center guideline as the divider. Make sure the Open Region Tool is selected and 

position your crosshair at the 1" and 1 1/2" junction, click your button and then drag the region to the 4 1/2" and 

10 1/4" junction and click your button. Place your crosshair at the 4 1/2" and 1 1/2" junction and click to set the 

top corner for the right column region. Drag this region down to the 8" and 10 1/4" junction and click to create 

our second region. We are now ready to import our geoWrite file. 

There are two different methods to import the geoWrite file. Click the 'Text Placement Tool' [gP Page 3-11], 

locate the 'geoPub1' file in the file list box and then click the OPEN button. You will be returned to Page Layout 

Mode with a Pointer. Move the Pointer to the region where you want your text to be imported (the right column 

in this case) and click your mouse button. The text region will fill with a bunch of dashed lines. 

The dashed lines indicate that a geoWrite file has been imported to this region but is not available to be worked 

on yet. To ripple the text and complete the import phase press the 'SHOW' button in the Layout Toolbox [gP 

Page 3-10]. The region will now fill with solid lines. 

Once the text has been rippled you can enter Editor mode and work on the text file (we'll get to this later). You 

can also change pages in your geoPublish document after the text is rippled. If you try to change pages before 

the text is rippled geoPublish will automatically ripple the text. 

So we have imported our file into the right column on our page. Ooops! We actually want to start the file in the 

left column. Make sure that the Pointer tool is selected and click on the right column which should be full of 

solid lines. The Move and Size buttons will appear to indicate the region is active. Now click on the Clear 

Region Tool so we can fix our mistake. The ripple lines will disappear. Click on the shaded left side of the 

geoPublish screen to deselect the region, click the Show button and then click on the left column region. 

With the left column selected click on the Text Placement Tool and choose our geoPub1 file again. When you 

click the OPEN button this time the text is automatically placed into the selected left region. Click the Show 

button to Ripple the text. 

So now you have seen the two methods to import a geoWrite file. The first method is the one I prefer to use 

since, after selecting the text file, you can then select multiple regions to place the file into. To see how this 

works Clear the left region where our file is rippled (highlight the region, use the Clear Region Tool and then 

deselect the region by clicking your button on the grey shaded area on the left side of the geoPublish screen). 

Now select the Text Placement Tool and choose our geoPub1 file again. After you press OPEN you will be 

back at the Page Layout Mode so move your pointer into the left column region and press your mouse button. 

The region will fill with dashed lines. Now move your mouse into the right region and click your button again. 

This region will also fill with dashed lines. When you press the SHOW button both columns will be rippled. 
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When you import geoWrite files you may get a surprise sometimes. If your regions are not level (you didn't use 

Guidelines and one is closer to the top of the page) the geoWrite file will begin in the region closer to the top of 

the page no matter which region you pour the text into first. 

After rippling our text the solid lines not only show that the text is ready to be worked on but give an indication 

of the amount of space taken up in our regions. Both columns that we filled have dashed lines going all the way 

to the bottom of the regions. Since we previously printed off our geoWrite files we knew that this file was going 

to require more than one full page. To import the rest of the file we need to create another page in our 

geoPublish file. 

Go to the options menu and select next page. A dialog box will pop up saying the program can't go to the given 

page and asking if you want to create the next page. Click on the OK button. The screen will be redrawn and 

you will see by the info in the Document ID Box [gP Page 3-5] that we are now on Page 2 of our file. Since this 

is a new page it has no regions defined. You should also notice that this page is based on our Left Master Page. 

Since this is Page 2 for our file we don't need to create the large title region. We will create a space for our titles 

in another manner. I have also formatted the text file already so it will print in Full Justification mode so you 

can see the difference from the previous page. 

We will now create our text regions. Select the Open Region Tool, place your crosshair at the 1/2" and 1/2" 

junction in the top left corner and click your mouse button. We are still going to use 2 columns so drag the 

region box down to the 4" and 10 1/4" junction. Click your button to set the region and then create the second 

region from the 1/2" and 4" junction to the 7 1/2" and 10 1/4 " junction.  

We should now have two regions created. Select the Text Placement Tool and again choose our geoPub1 file in 

the list box. After pressing the Open button click your mouse button in first the left and then the right regions to 

create the dashed lines. Complete the text import by pressing the Show button. 

Once the text is rippled you should see that the left column is completely filled and the right column does not 

have a lot of space used up. This is OK and we will fill that space later. 

Now, we need to make room for our Article Title. With the Pointer Tool selected click on the left column, select 

the options menu and then choose 'set gutters'. The box is different than before. There is a Default button. This 

can be used to return a regions' gutters to the default values in effect when that region was created. Since we 

haven't made any changes yet what you see are the default values for this region. 

In our third article in this series we defined our font usage. We said we would use a 30 Point size for the main 

article title and then a 24 point size for titles on subsequent pages. We will need to leave enough room for our 

24 point text plus some extra space between it and the article so we can underline the title or put a box around it. 

Press the Return button twice to get the cursor into the Top Gutter Value field. Press the Delete key and then 

enter a value of 36 for our top gutter. Press Return and then press the OK button. 

Our text has gone back to un-rippled as we have made some changes to the region. We could ripple the text 

again but the best thing is to wait and ripple both columns at the same time. Click the right column, go to the 

options menu and choose set gutters. Again, press the return key twice, delete the value of 5 and enter a value of 

36, press Return and then click OK. 

Click anywhere on the grey shaded area on the left of the geoPublish page to deselect the right column and then 

press the Show button to ripple the text. 
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When the text is rippled you will see that the solid lines still go all the way to the top of the regions but that the 

right column looks a little fuller than it previously did. We are going to leave the rest of this page empty as a 

playground for Page Graphics Mode but we want to even out the text columns to give our page a more balanced 

look. 

With the Pointer tool selected click on the left text region. Grab the Size button in the lower right corner of the 

region and move the bottom of the region up to the 6 1/2" mark on the page. Click your button to set the region 

and then ripple the text with the Show button. I used the Zoom view in Page Graphics Mode to make sure the 

columns were lined up after adjusting the region. 

At this point we are done with our first article as far as setting the regions and importing the text. We will come 

back to these 2 pages later on as we work with Page Graphics Mode. 

Next time we will look at Document Conversion methods in case you aren't a fan of GeoWrite. 

Until then, enGEOy your Commodore! 
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GeoPublish Tutorial Part 6 – Document Conversions 

"GeoWrite sucks." 

I've heard the preceding comment before from quite a few people. Once upon a time I felt that way as well and 

settled on Busy Bee Software's The Write Stuff (aka BB Writer or TWS) as my Word Processor of choice. All 

of the things that geoWrite sucks at TWS makes easy. 

GeoWrite is a Graphical-based program so text entry is painfully slow (especially on a stock C-64 and you 

really notice it if you try to insert some text at the start of a long article). TWS is a text-based program so text 

entry is fast. You have to load GeoSpell to check your typing and get a word count. TWS has integrated word 

counting ability and a lightning fast Spell Checker. GeoWrite does not have macro ability. TWS has user 

customizable macros and comes with existing macros to make typing easier. 

Of course, the shortcomings of geoWrite are overcome with some smart use of the program and some hardware 

and software products. By setting your margins in to one screen width you could avoid the side to side screen 

scrolling and type fairly quickly. If you use the default BSW font you are not hampered by a lot of graphical 

activity redrawing fonts. There are numerous Word Count utilities including some Desk Accessory versions that 

let you check your word count as you type (my favorite is the DA WordCount 2.0 by Michael Myers). Once I 

got a 4 MHz Schnedler TurboMaster Accelerator I had a hard time typing faster than what geoWrite could keep 

up with. With the 20 MHz SCPU I rarely bother moving my margins in and always use the font I want rather 

than having to change it later. 

Unbeatable Format 

But, the one thing that geoWrite has going for it that no other Word Processor can touch is a format ready-made 

for importing into geoPublish. To ensure that geoPublish could satisfy the needs of as many users as possible 

Berkeley Softworks planned ahead and created the Text Grabber to make it easy to import text from numerous 

Word Processor programs. Not only did this mean that people could use their favorite program but it meant that 

publishers could accept contributions from non-GEOS users and easily include these articles in their geoPublish 

projects. 

The reason this subject has come up this time is that I have been using geoWrite to write some of the articles in 

this series. Since I want to use geoPublish on my 128D with the 20 MHz SCPU to make it easier to document 

procedures I have been relegated to using geoWrite on my 64-C at 1 MHz. Uggghh! 

Due to the very slow performance at 1 MHz (I have been spoiled for the last 11 years with different 

accelerators) I have again resorted to using other Word Processors to write some of these articles. It occurred to 

me that many of you will do the same when it comes time to create your own gP Masterpieces. 

Sprechen Sie Deutsche? 

No. I don't speak German either but at one time I had a need to translate some German (geoDOS Dox) into 

English. I needed a way to handle the translation. Since all files imported into geoPublish have to be in 

geoWrite format how do we go about translating one format to the other? 

As mentioned, the BSW Text Grabber program allows easy import of files created by EasyScript, PaperClip, 

SpeedScript and WordWriter plus it has 3 Generic Import Forms. To import files created by BB Writer you 

http://members.shaw.ca/cue64/wrdcount.cvt
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would use the "Generic 1 Form". To make this easier to remember I renamed a copy of Generic 1 to "TWS 

Form". 

In addition to the Text Grabber a number of people created other programs to import files into geoWrite format. 

Red Storm (aka Joe Buckley) created numerous versions of WrongIsWrite7 (WIW) which will import ASCII 

files as well as converting between versions of geoWrite.  

Markus Kanet wrote geoDOS and it excels at file conversions. You can convert C= and PC text (ASCII) files 

into geoWrite format and set the font, margins and tabs at the same time. Maurice Randall warns that geoDOS 

affects certain areas that geoWrite uses and suggests rebooting Wheels after using geoDOS. 

One other program that is very handy to have when you are working with multiple geoWrite files and 

converting between different formats is Toolkit (or Toolkit.80 for GEOS 128 users) by Rick Krantz. This little 

gem lets you change fonts and margin settings on entire documents very easily. I keep Text Scraps of regular 

margin settings I use in an Album to make it even easier to get just what I want. 

If you don't have geoWrite 2.1 (you should pick up a copy of GEOS V2.0 right away) you also need to be 

careful to use copies of your geoWrite files when working on a geoPublish project. GeoPublish converts all 

geoWrite files into geoWrite V2.1 format so you won't be able to read them with previous versions of geoWrite. 

This will mean using a program like WrongIsWrite to convert the geoWrite file back if you want to edit it 

outside of geoPublish. 

There are plenty of other top-notch geoWrite utilities but we have seen enough so far to help us in creating the 

best geoPublish projects we can. Next time we will import more of our articles and look at other ways to fit our 

files into geoPublish. 

Until then, enGEOy your Commodore!  

 

 

 

 

 

 

 

 

 

 

 

 

http://members.shaw.ca/cue64/wiw7.cvt
http://members.shaw.ca/cue64/geodos.html
http://members.shaw.ca/cue64/toolkit.cvt
http://members.shaw.ca/cue64/tkit128.cvt
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GeoPublish Tutorial Part 7 – Importing More Articles 

In geoPub5 (it will be on Page 10 of this tutorial) we imported our first geoWrite file into geoPublish. We 

learned about gutters, how to set the regions, how to 'pour' our text into the regions and how to ripple our text. 

We looked at two methods to create space for a headline as well as how to re-size our regions to make the most 

efficient use of space.  

This time around we are going to import the rest of our articles up to this point. We are going to use different 

page layout formats, gutter sizes and a variety of justification settings. All of this will provide you with a wide 

range of visual styles as well as good practice at importing text files. For future articles I will include a separate 

file on the web site outlining the regions that you should create for proper importing of the article. 

When we finished importing our article in geoPub5 we were done with the layout of Page 2 of our Tutorial. In 

order to continue, choose 'next page' in the Options menu. Click the OK button when asked if you would like to 

create the next page. 

Our first article showed what pages look like if you use a 2-column layout. We also left the Gutters at the 

default value of 5 all around. For the majority of the rest of our articles we want to use a value of 10 for the left 

and right gutters. Select 'set gutters' in the Options menu and set 10 point left and right gutters. 

For geoPub2 we will use a 3 column layout. Since Page 3 is the first page for a new article we need to layout 

the page with a region for the headline (large) and 3 for our columns. 

In order to make it easier to describe the layout of our text regions pay close attention to the following page 

diagram and chart. The Guidelines shown are the ones we created in geoPub4. 

When we are working on a Left Page (even numbered) I will refer to the Vertical Guidelines as A, B, C, D and 

E. When we are working on a Right Page (odd numbered) I will refer to the Vertical Guidelines as V, W, X, Y 

and Z. In both cases the Horizontal Guidelines will be referred to as 1, 2, 3 and 4.  

 

 

 

 

 

 

Labels for the Horizontal Guidelines: 

Label    Position    Label   Position 

 1         1/2"        2        1" 

 3        1 1/2"       4     10 1/4" 

 

Labels for the Vertical Guidelines: 

  Left Page         Right Page 

Label  Position    Label  Position 

 A       1/2"        V      1" 

 B     2 66/80"      W    3 26/80" 

 C       4"          X     4 1/2" 

 D     5 14/80"      Y    5 54/80" 

 E      7 1/2"       Z      8" 

When I talk about setting a region I will say to select the Region Tool and set a region from 1A to 3E. This 

would create a Large Headline Region. If we have a Left Page with a small headline region using the 3 column 

format the middle region would go from 2B to 4D. A Right Page with a large headline using the 2 column 
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layout would have a right region going from 3X to 4Z. In instances where we have to create custom columns 

they will be referenced by the appropriate labels paired up with measurements - 3A to 6"C would indicate the 

left region on a left page using a 2-column layout where the region ended at the 6" vertical mark. This region 

would likely be paired with a second region from 6"A to 4C. I hope this naming convention is clear and easy to 

understand. 

While in Page Layout Mode ensure Snap is on (Options menu or C= S) and select the 'Open Region' [gP 3-11] 

tool. Create our first region across the top of the page (1V to 3Z). This is our Large Headline region and will be 

used to start all of our articles. 

We next want to create our three text regions using the narrow guidelines. Set text region 1 (3V to 4W) then text 

region 2 (3W to 4Y) and finally text region 3 (3Y to 4Z). 

With our regions set the way we want we can now select the 'Text Placement' tool [gP 3-11] and choose our 

geoPub2 article in the list. After pressing the Open button click your mouse in the three regions across the page 

from left to right and then ripple the text with the 'SHOW' button. Page 3 is complete as far as Page Layout 

mode is concerned so create the Next Page in the Options Menu. 

For Page 4 (RightMaster) we still want to use 3 columns but we only need the Small Headline region this time. 

To create the Small Headline region choose the 'Open Region' tool to set this region (1A to 2E). Next create text 

region 1 (2A to 4B), text region 2 (2B to 4D) and text region 3 (2D to 4E). 

After creating the regions use the 'Text Placement' tool and import geoPub2 into the 3 regions from left to right 

across the page. Ripple the text with the 'SHOW' button and you will notice that column 3 is not completely 

full. This is OK. We may fill it up later. 

In order to import geoPub3 we need to create another new page (RightMaster). In Page Layout mode for this 

article we want to create 3 regions. Create the Large Headline region (1V to 3Z) and then text region 1 (3V to 

4X) and text region 2 (3X to 4Z). 

Import and ripple the geoPub3 article and then create Page 6 (LeftMaster). Again we will use the 2-column 

format so create the Small Headline region (1A to 2E) plus 2 text regions (2A to 4C; 2C to 4E). Import and 

ripple the remainder of geoPub3 onto Page 6 and then create Page 7. 

We will begin geoPub4 on Page 7 (RightMaster). Create the layout with the Large Headline region (1V to 3Z) 

and 2 columns (3V to 4X; 3X to 4Z). Page 8 (LeftMaster) will utilize the Small Headline region (1A to 2E) plus 

2 text regions (2A to 4C; 2C to 4E). In order for our text to fit we have to set the bottom gutter in the second 

text region (2C to 4E) to a value of zero either before or after importing the text. The Small Headline region (1V 

to 2Z) on Page 9 (RightMaster) will top the page over our 2 text regions (2V to 4X; 2X to 4Z). 

We now get to a point where our text does not end neatly at the bottom of a page. In order to finish importing 

geoPub4 we need to use some space on Page 10. Start Page 10 (LeftMaster) in the normal fashion with a Large 

Headline (1A to 3E). Create two text regions to begin geoPub5 using the following areas (3A to 5 3/4"C; 3C to 

5 3/4"E). 

Next we need to create 2 more regions to hold the remainder of geoPub4 (5 3/4"A to 4C; 5 3/4"C to 4E). Once 

you have created these 2 lower regions we need to create some space for a Small Headline and 'continued from' 

text. Highlight each of these 2 regions in turn and set the Top Gutter to a value of 36.  
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In a case like this where we are using an odd measurement (you have to use the cursor keys to set 5 3/4") an 

option is to go into Master Pages Mode and set another Guideline. You could designate this Guideline as a 

'floater' and adjust it to wherever you need it on any given page and it would save having to use the cursor keys 

to set 4 regions. 

Now we can import the rest of geoPub4 into the two lower regions. Once you have done that import geoPub5 

into the top two regions and then Ripple the text. Create Page 11 (RightMaster) and make a Small Headline 

region (1V to 2Z) and 2 text regions (2V to 4X; 2X to 4Z) then import and Ripple more of geoPub5. The 

remainder of geoPub5 will go onto Page 12 (LeftMaster) with a Small Headline region (1A to 2E) and 2 text 

regions (2A to 4C; 2C to 4E). 

For Page 13 (RightMaster) we need a Large Headline region (1V to 3Z) and two full length article regions (3V 

to 4X; 3X to 4Z). Import and Ripple geoPub6 onto this page and then create Page 14. 

Page 14 (LeftMaster) will be similar to Page 10 in that we need to have some overflow room for the remainder 

of geoPub6. Make a Large Headline region (1A to 3E) and 2 text regions (3A to 6"C; 3C to 6"E) to start 

geoPub7. Create 2 more text regions (6"A to 4C; 6"C to 4E) and set the top gutter value in each to 36 to have 

room for a headline. 

Import geoPub6 into the lower 2 regions, import geoPub7 into the upper 2 regions and Ripple the page. 

Next we need to create Page 15 (RightMaster) to import more of geoPub7. We need a Small Headline region 

(1V to 2Z) and 2 full-length text regions (2V to 4X; 2X to 4Z) for the article. Create these and then import and 

ripple geoPub7. 

Create Page 16 (LeftMaster) to import the rest of geoPub7. We need a Small Headline region (1A to 2E) and 2 

full-length text regions (2A to 4C; 2C to 4E). Create these and then import and ripple geoPub7. 

Now that we have created all of our text regions in our first geoPublish document I'll show you an easier way to 

do this. In the Options menu choose 'goto page', type 1 and press Return. From the File menu choose 'library', 

press the 'Create' button, type 'TutorialPage' and press the Return key. This is very similar to the Library 

function we used in Master Pages Mode. 

Type 'Rt2ColLrg' and press the Save button. Your first Page Layout has been saved to the library. From the 

'options' menu select 'goto page', enter 3 and press Return. From the File menu choose 'library' and then 

highlight the first 'empty ' word. Type 'Rt3ColLrg' and press the Save button. Choose 'next page' from the 

'options' menu to go to page 4. Select 'library' from the 'file' menu, highlight the first 'empty ', type 'Lf3ColSml' 

and press Save. Goto page 6 from the 'options' menu, open the 'library' from the 'file' menu, highlight the first 

'empty ', type 'Lf2ColSml' and press Save. Goto page 9 from the 'options' menu, open the 'library' from the 'file' 

menu, press the down arrow and highlight the first 'empty ', type 'Rt2ColSml' and press Save. 

We now have 5 of our Page Layouts saved to a Library file. As we go along we will now use these Page layouts 

where we can instead of creating the regions from scratch every time. We will also add any new Page Layouts 

to the library.  

Next time we will take a look at Editor Mode and some of the tricks that can be used to squeeze more text onto 

a page. 

Until then, enGEOy your Commodore!  
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GeoPublish Tutorial Part 8 – Editor Mode 

For this tutorial I am providing the geoWrite files pre-formatted and ready to pour into the text regions. If you 

follow the step-by-step instructions in article #7 (and provided in a separate file with each successive article) 

you should be able to create the GeoPublish Tutorial fairly easily. This time we will look at some formatting 

tricks you need to know when creating your own gP masterpiece. 

As you work on a publishing project you begin by writing your articles. When I write articles I have a certain 

amount of information I want to convey. The topic is what determines the length of the article. Of course, how 

much I have to say on a particular topic oftentimes has very little to do with the space I have to fit the article 

into once I start working in gP. This tends to result in a number of options to get my text to fit. 

How can I cut thee... 

The first step in paring an article down to size is to read it through. After importing and rippling your geoWrite 

file highlight one of the text regions then select Editor from the Mode Menu (there is no keyboard shortcut and 

Editor Mode is only available from Page Layout Mode). 

You will find that Editor mode is almost the same as geoWrite V2.1. Scroll through your imported document 

and carefully read it over. Continue through each page (using 'next page' from the Page menu) until you get to 

the end.  

How much text is left over from your regions? By this I mean that if you created 4 text regions and you have 

now got to page 5 in Editor Mode is there a lot of text or only a couple of lines. The answer will determine what 

you do next. 

If there are only a couple of lines of overflow text then the first thing to do is to go over your article again and 

cut out any excess words. It is amazing what this can do. Especially look for paragraphs that end with only one 

or two words on the last line (like paragraph 2 above). By cutting or changing a word you may be able to bring 

that last word back onto the previous line thereby shortening your article. You will also want to look for any 

chances to hyphenate words to fill any space on the preceding line. Hyphenation can be a laborious process but 

it can pay big dividends. GeoPublish does not auto-hyphenate which is one of my big beefs with full 

justification formatting. 

While reviewing your article check for single lines from one paragraph that flow onto the next page. Sometimes 

it is possible to suck those lines back to the previous page by changing the bottom gutter value in the region to 

'0'. Don't forget to also remove the space between paragraphs that will now be at the top of the next page. 

Another gutter trick is to change the left and right gutter values for the text regions. In a 2-column layout, for 

example, lower the value for the inner gutters by 2 or 3 points. Lower the value for the outer gutters all the way 

to '0' if you want. This looks better if you are not using borders around your text regions. If you are using 

borders make sure you leave a gutter value of at least 5 points. After changing the gutter values and re-rippling 

your text go into Editor Mode again and check out the difference. You'll be surprised at what this simple change 

can do for your article. 

Another change that works well if you only have a few lines of overflow (depending on the length of your 

article) is to change the paragraph spacing by making use of geoWrite's individual paragraph formatting. You 

may have noticed that I like to leave a blank line between paragraphs. This provides some much needed 'white 



32 
 

space' on the page and allows the readers' eyes to rest a bit while reading. Of course, these blank lines add up 

over the course of an article and may be all you need to get your article to fit. 

In cases like this I still like to leave some blank space - just less. A trick I have been using for a long time 

(including this article) is to put my cursor at the end of the first line of a new paragraph and press RETURN. 

This creates a 'new paragraph' complete with the indent. Since this is not really a 'new paragraph' we have to get 

rid of the paragraph indent. Click on the 'P' marker under the ruler and drag it over to the left edge of the screen 

and click to set it there. Your 'new paragraph' will look just like it did before. 

The next step is to place your cursor at the start of the first line of your original paragraph (move one line up) 

and press the DEL key to remove the blank line between paragraphs. Now, select 1 1/2 line spacing for this 

single line paragraph. You have just saved yourself a half of a line in the length of your article. If you do this 4 

times you will shorten the article by 2 full lines which will have the effect of pulling the excess text back from 

the next page. This change works best when Full Justification is not being used. If you are using Full 

Justification then you will have to manually insert spaces to try to get the first line to spread out. 

You can use Toolkit (see article #6) to change the font size. A single point reduction (from 12 to 11 as I did 

with article #5) may be all you need to squeeze your article down to size. 

While an earlier option was to make some minor wording changes to save a bit of space we are now at the point 

where serious editing may be in order. Go back over the article and be vicious with your knife. Cut excess or 

redundant wording and, if necessary, remove entire sections for use at a later time. 

If none of these options will work for you, and you can spare the overflow space on another page, just do like 

we did with article #4 and create a new region on the next page to hold the overflow. 

Another method to ensure you don't run out of space is to import one of our Dummy articles and just type the 

article in Editor Mode. This allows you to pace your writing to only use the available space. 

And there you have it. As you have seen there are quite a few editing tricks that you will want to have in your 

publishing toolbox to improve your geoPublish endeavors. 

Next time we'll analyze the different page layouts we have used so far. 

Until then, enGEOy your Commodore! 
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A new file plus a correction 
 
As we know, each geoPublish document can only be 16 pages in length. Before we continue importing articles 

we need to Create a new geoPublish document called TutorialPart2. Change to Master Pages mode. 

 

Since we finished the first document on Page 16 (a Left Master page layout) we need to setup our second gP 

document accordingly. Go into `Doc Setup' in the File menu and set our options to start with Page #17, 2 

Master Pages with the first Page to be a Right Master Page. Use the Library function on the File menu to import 

our Master Page layouts for the Left and Right Master pages. Now change to Page Layout Mode. From the 

Options menu choose `set gutters' and set the Left and Right Gutters to a value of 10.  

 

We now have to correct an error in a Page Layout library that we saved last time. We saved the layout for Page 

1 when the default gutters for the text regions were set to 5 instead of 10. From the File menu choose Library 

and select Rt2ColLrg from the list. Click OPEN and the page layout should open with the Large Headline area 

and 2 text regions. Delete the 2 text regions. 

 

Select the Open Region Tool and create 2 new text regions from 3V to 4X and 3X to 4Z. Select one of the text 

regions and then choose `set gutters' from the options menu. Verify that the left and right gutters are set to 10. 

 

From the File menu again choose Library. Select Rt2ColLrg and press the Save button. This will overwrite the 

previous version of the layout and save the 10 point gutters that we want for our default. 

 

Importing geoPub8 - Editor Mode 
 

To import our geoPub8 article we will first choose the `text placement tool', select geoPub8 from the list and 

then click on the left and then the right text regions. After the import press the SHOW button to ripple the text. 

 

From the Options menu choose Next Page and agree to create it. This page will not be filled by geoPub8 so we 

want to split it with space to begin importing geoPub9 at the top and text regions for geoPub8 at the bottom. 

 

Create a Large Headline region (1A to 3E) and 2 text regions (3A to 5"C; 3C to 5"E). Create 2 more text 

regions (5"A to 4C; 5"C to 4E) and then set the top gutter values for these 2 lower regions to 36. Import the 

remainder of geoPub8 into the two lower text regions. 
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GeoPublish Tutorial Part 9 – Column Analysis 

So far we have used a variety of column layouts. Have you noticed the differences? Have you seen one that is 

better than the others? Have you seen one that is worse than the others? Let's do a little comparison and analysis 

and see if we can identify an ideal layout. 

We laid out Page 1 in a 2 column format using left justification and 5 point gutters. If your printout is like mine 

there are a couple of spots where the left column text almost runs into the right column text. This often crops up 

when printing with these settings and is one reason why I prefer using 10 point gutters. 

For Page 2 we changed the layout to use full justification. This format can provide a cleaner look to the page 

and almost always assures us that the text will not `run over' to the next column as on Page 1. There are, 

however, 2 problems here. GeoPublish does not do auto-hyphenation so this can create a lot more work for you, 

the user. The second, and maybe more important, issue is that full justification works by inserting, or removing, 

extra spaces between the words to stretch, or compact, them to fill the entire line width. This method makes it 

harder for the human eye to read the text as we have to work to read past the uneven spacing. I'm not saying that 

you are wrong if you use full justification but there are drawbacks. 

On Page 3 we changed to 3 columns, fully justified with 10 point gutters. The shorter lines are easy to read 

without a lot of eye movement but the full justification makes the need for hyphenation even greater. My 

feeling is that full justification should only be used on 2 column layouts, if at all. 

Page 4 kept the 3 column layout and gutters from Page 3 but changed to left justified. The geoWrite article has 

7 blank lines in the middle column on Page 4. We are going to use this space for a `callout' later on when we 

add finishing touches in Page Graphics Mode. A callout helps to make the page `less busy' and easier to read in 

the same way that the sub-headings on Page 3 do. 

Pages 5 & 6 use 2 columns of fully justified text separated by 10 point gutters. A good example of why I don't 

like full justification is in the first full paragraph in Column 2 on Page 6. The line "Start geoWrite and create a 

new file called" has a lot of space between the words compared with the rest of that paragraph. 

For Page 7 we changed to a 2 Column layout that is left justified and uses 10 Point Gutters. With the Sub-

Headings and spaces between paragraphs this page has good white space and is a fairly easy read. 

Now flip ahead to Page 11. Just looking at this page makes my eyes feel tired. There is a lot of text here and not 

much white space. I did not use any sub-headings or spacing between paragraphs on purpose to show the effects 

of trying to cram a lot onto the page. When you combine this with the smaller font size (11 point instead of the 

usual 12 point) you get a very busy page. The only thing I could have done to make this worse would be to have 

used Full Justification which would have removed the little white space there is at the ends of lines. Page 12 

uses the same small font but has spaces between the paragraphs which open the page up for a more `eye 

friendly' look. 

There you have it. So far we have used 7 different layouts. There are many more layouts that could be used 

depending on the material you are using. For the remainder of this Tutorial I will use a 2 Column, Left Justified 

layout with 10 Point Gutters. When necessary I'll cut down the paragraph spacing but I'll keep the pages with as 

much white space as I can. 

I will introduce one more page layout when we get to work on the cover and inside front page. The Introduction 

article will be laid out on `Page i' in one full page wide column. This will give you a good look at the reason for 
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using columns. With lines of text going all the way across the page it is hard to keep track of which line you are 

reading when your eyes move back across the page. 

Take Note 

If you are going to use full justification make sure you don't use spaces to line up your text. Since Full 

Justification adjusts spacing you can't be sure your text will remain where you want it. Take advantage of the 

margin settings and tab stops that you can set in geoWrite and Editor mode as these won't change position when 

justified. 

Don't forget about the Decimal Tab Stops in case you are doing a table of numbers. To create a Decimal Tab set 

a normal Tab Stop and then click on it with your pointer. The Tab Stop will get attached to your pointer. Press 

the Space Bar and the Tab will fill in and become a solid shape. Click once more to set the Tab Stop back down. 

When you create your table of numbers they will all line up on the decimal point. 

When you are entering your text in geoWrite make sure that you leave your margins wider than the width of 

your columns in geoPublish. The margins will be adjusted smaller when you import your text if they are wider. 

If your margins are narrower they will not be expanded and you will lose some of the space in your regions.  

To work around this use the ToolKit program to set your margins out wider if you have set them to one screen 

width for quicker typing. ToolKit makes use of margin and font settings in Text Scraps. What I have done is 

used Text manager to create a Text Album that contains settings I regularly use. It is then easy to make changes 

to documents as I work.  

Next time we will begin looking at some of the many ways that geoPublish lets us import graphics into our 

projects. 

Until then, enGEOy your Commodore!  
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Importing geoPub9 - Column Analysis 
 

Start geoPublish and open the TutorialPart2 geoPublish document. Change to Page 18 if it doesn't open there.  

 

To import our geoPub9 article we will first choose the `text placement tool', select geoPub9 from the list and 

then click on the left and then the right text regions in the upper half of the page (3A to 5"C; 3C to 5"E). The 

lower half text regions should contain the end of geoPub8. After the import press the SHOW button to ripple the 

text. 

 

From the Options menu choose Next Page and agree to create it.  

 

Create a Small Headline region (1V to 2Z) and 2 text regions (2V to 4X; 2X to 4Z). Import the remainder of 

geoPub9 into these two text regions. 
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GeoPublish Tutorial Part 10 - Importing Graphics Part 1 

We are finally going to spruce up our work with some imported graphics. GeoPublish offers 5 methods for 

importing graphics. You can place graphics in Master Pages mode (seen on every page of your document), in 

Page Layout mode (in a region), in Editor mode, and in Page Graphics mode (in a region or free-flow). We will 

look at two of these this time. 

The first method is one you are most likely familiar with (see our Column Graphic on Page 15). Either in 

geoWrite, or from within the Editor Mode, just choose the Edit Menu, select Paste and then choose Picture (C= 

W ). The Photo Scrap on the disk will be inserted on the line where your cursor is or on the next line down if 

you are not on a new line.  

This is the least desirable method as you have no real control over the image. The Scrap is permanently centered 

and you can't enter any text beside it. You can't re-size the scrap and can only position it by changing the 

margins.  

Looking Trashy  

Let's try this method. Just to show what a poor choice this method is we'll use the Waste Basket graphic (from 

Art Gallery 1) from the Work & Play Album on the 2 disk geoPublish. Extract the scrap from the album with 

Photo Manager and then copy the Scrap to your work disk. Enter Editor Mode and scroll down the first column 

until you reach this paragraph. Place your cursor on the second following line (there are two blank lines after 

this paragraph) and use the C= W shortcut to place the scrap. 

Now doesn't that look bad? And you really can't work with it at all. On to the next method. 

The second method for importing graphics is to create a region for the graphic in Page Layout Mode. We will 

again use this article as our example. Go to Page Layout Mode on Page 20 and create a new region (4 1/4"C - 5 

1/4"E) in the right column area (the new region will go over top of the existing one and the text will be aligned 

around the new region). You will have to Ripple the text again. 

Now select the new region and press the Bitmap Placement Tool [gP Page 3-10]. A box will prompt you to 

choose to Center the image in the area, Scale the image to fit or Stretch and Scale the image. For now choose 

Center and do not check the Smooth box. Press OK and your image will be inserted into the region. 

Again, you can't really do much with this image. If you wish to Scale the image to fit you have to delete it and 

then import the graphic again as Page Layout Mode does not offer an Attributes option. 

This method also creates an interesting issue when you wish to use Editor Mode. Try clicking on the right text 

region on Page 20 and choosing Editor Mode. You will be prompted to choose a text area to edit even though 

the entire column has been selected. You will have to click on the shaded text area above or below the graphic 

region in order to use Editor Mode. 

We are done with Page 20 so will go to the next page and pour the remainder of this article into one column and 

import the graphic again but with a slightly different approach. 

This time we will draw our new region for the graphic only half as wide as the text region. In order to make this 

easier we will use the Ratchet Option. You can turn on Ratchet or Snap. Ratchet does not jump to Guidelines 

but moves at preset intervals. Select the Options Menu and then choose `set ratchet'. When the dialog box 
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comes up you will see that you can set the ratchet at 2 pixel or 1/2 inch (the default) values. We want 1/2 inch 

ratcheting so press OK. Select the Options menu again and click on `ratchet' (C= R). Select the Region Tool and 

create a new region from 3" and 3" to 4" and 4X (doesn't ratcheting make this easy?). Ripple the text and you 

should notice that the column of text now appears as different areas - the dashed lines are broken at the edges of 

the graphic region. If you go into Page Graphics mode and use the Zoom feature you will be able to see the 

breaks around the region. 

This, of course, wastes more of our valuable space. It is possible to place a graphics region without having these 

obvious region breaks but it takes careful placement and checking in the Zoom view. 

Again, however, when we do import the Scrap we have the same three choices for effect and that is it.  

Smooth Operator  

A short discussion on Smoothing is required. If you choose Scaled to Fit or Stretched and Scaled to fit the 

graphic may lose some of its sharpness. The edges become blocky and the picture doesn't look very good. If you 

choose the Smooth option geoPublish will try to overcome some of this blockiness by adding extra pixels in 

certain places. This can have disturbing results - worse than leaving the picture alone. 

When you print your geoPublish file using geoPubLaser you have the option to set the quality of the smoothing. 

The available options are 75, 150, 300 or none. This sets the dots per inch (DPI) that any objects (text or 

graphics) designated for smoothing will be printed at. A lot of experimentation (test printing) is necessary to 

determine what level of smoothing works best for the graphic you are using. For the most part I don't worry 

about smoothing as it can take a long time to print pages when smoothing needs to be processed. 

Next time we will look at importing one of our Dummy articles and then changing the filename outside of 

geoPublish. 

Until then, enGEOy your Commodore!  
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Importing geoPub10 - Importing Graphics Part 1 

 
This article is different than others we have imported. Because we are going to import graphics into this article 

the spacing will change from what it is now. Please don't change the formatting before you import it to 

geoPublish and follow the directions or it may not be formatted properly once you import the graphics. 

 

The graphic we are going to work with is included in the Phot Album that is available on the web site as well. 

 

Start geoPublish and open the TutorialPart2 geoPublish document. Change to Page 19 if it doesn't open there.  

 

To import our geoPub10 article we will first need to create a new page to import it onto since Page 19 is already 

full. Choose New Page under the Options menu and agree to create it. Our new page will be a Left page layout 

and it will need a Large Headline Region (1A-3E) and 2 column regions for our text (3A-4C; 3C-4E).  

 

Once you have created the regions choose the Library option under the `file' menu. Use the down arrow button 

to move down the list until you see the first `empty' entry. Highlight this entry, type Lf2ColLrg and then Press 

the Save button to add this layout to our Page Layout Library collection. 

 

 Now, choose the `text placement tool', select geoPub10 from the list and then click on the left and then the right 

text regions (3A-4C; 3C-4E). After the import press the SHOW button to ripple the text. 

 

From the Options menu choose Next Page and agree to create it.  

 

Page 21 is going to contain the remainder of geoPub10 plus geoPub11. We are going to have both columns run 

the length of the page. Our headlines are going to be different sizes (not the best journalistic practice but we are 

going to do it). For now we are just going to create the regions for the remainder of geoPub10. Create a Small 

Headline region (1V to 2X) and a text region (2V to 4X). Import the remainder of geoPub10 into this region. 

 

Now follow along with the text in the article to complete the layout in geoPublish. 
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GeoPublish Tutorial Part 11 – Document Renaming 

Back in the third installment of this series (Planning and Preparation) I suggested that a great time saver while 

working with geoPublish (gP) is to have a couple of Dummy articles prepared that you can import if you need 

to fill some space. This practice saves time as you can remain working in gP as opposed to having to exit and 

create a new article in geoWrite (gW). 

This time we are going to import one of our Dummy articles into gP and then rename it to more accurately 

reflect the content. Of course, there is no Rename option in any menu in gP so this means we will use a different 

GEOS program to handle this part of the process. 

The instructions on the web site told you to download this installment, create the regions, import the file and 

then open it in Editor Mode. The file that you downloaded and imported was called Dummy3 so as not to cause 

problems with the Dummy1 and Dummy2 articles you created in accordance with the previous instructions.  

You should have downloaded the file GETITWV2.CVT as well and converted it back to GEOS format with 

Convert V2.5. This is a great tool to use if you get a gP file from someone else or if you are loading in a file that 

you haven't used for a while. If a gP document is opened and a required gW file is not on the disk gP can crash. 

The process to rename a gW file that has been imported into a gP document is quite simple. Run GetItWrite 

V2.0 (do not use the earlier version) and a dialog box will appear listing the gP documents on the current disk. 

There are Disk and Drive Icons if you need to check files on other disks. The program supports 3 Drives under 

GEOS and 4 Drives under Wheels if run from Drive A or Drive B. 

Choose the gP file you want to work with (in this case TutorialPart2) and press the Open button. A listing 

appears showing the gW files referenced in the gP document. If the gW file is on the disk it reports `OK'. If you 

see `Not on Disk' you need to locate that gW file before opening gP.  

To rename Dummy3 click the rename menu, click geoWrite file, click Dummy3 in the list and then OK. Delete 

the name Dummy3 and press Return after typing geoPub11. The gW file will be renamed and the gP file will be 

updated. 

Next time we will look at proofreading. 

Until then, enGEOy your Commodore!  
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Importing Dummy3 - Document Renaming 
 

Start geoPublish and open the TutorialPart2 geoPublish document. Change to Page 21 if it doesn't open there.  

 

Page 21 has the remainder of geoPub10 in the left column so we need to create our regions on the right side of 

the page for Dumy3.This page is a Right Page Layout and it will need a Large Headline Region (1X-3Z) and 1 

column region for our text (3X-4Z).  

 

 Now, choose the `text placement tool', select Dummy3 from the list and then click on the right text region (3X-

4Z). After the import press the SHOW button to ripple the text. 

 

Now follow along with the text in the article to learn how to rename an article in a geoPublish file. 
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GeoPublish Tutorial Style Sheet Font Usage 
 

LW_Roma  (aka Times Roman) 

 Front Page Headline - 80 points (bold) 

  Article Text - 12 points 

 

LW_Cal  (aka Helvetica)  

 Article Title 30 points (first page) 

 24 points (subsequent) 

 Sub-Headings - 14 points (bold) 

 

LW_Zapf  (aka Zapf Chancery) 

 Page Numbers - 14 points 

 Continued - 10 points 

 

LW_Giannini  (aka Avant Garde) 

 Footers - 14 points 

 Captions - 14 points 

 Call Outs - 18 points 

 

LW_Shattuck  (aka Zapf Dingbats) 

 End of article - 12 points 

 

 

Guidelines  

Labels for the Horizontal Guidelines:  

Label Position Label Position 

1 1/2" 2 1" 

3 1 1/2" 4 10 1/4" 

Labels for the Vertical Guidelines: 

Left Page Right Page 

Label Position Label Position 

A 1/2" V 1" 

B 2 66/80" W 3 26/80" 

C 4" X 4 1/2" 

D 5 14/80" Y 5 54/80" 

E 7 1/2" Z 8" 
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GeoPublish Tutorial Part 12 – Proof Reading 

I half mentioned this a few times already butt wee are really going two focus onthe topic this thyme. To ensure 

that you're publication will bee anticipated, red and enjoyed ewe need to be extremely care fool withyore 

spelling, typing and gramma. 

So how was that? Maybe try reading that first paragraph again. Do you feel like continuing to read this column? 

What if every article was written with such an obvious lack of caring and attention? Would you pay to subscribe 

to such a publication? There are a few simple steps to follow to make sure you don't send out your publication 

in such poor condition. 

For starters, print off your geoWrite documents and then grab a red pen or a highlighter. By printing off your 

documents you will get a general idea of the length and how much space you need to allow in your geoPublish 

document. Take the red pen and your printout to a comfortable location and read each article through. Circle 

any typos or spelling mistakes that you find. Then go back into geoWrite and, as you fix the mistakes, draw a 

line through each circle on your printouts. 

Once you have done that print off the files again and do the same thing. If you have a spouse, friend or child 

nearby give them the red pen and ask them to read the articles and highlight any errors they find. The reason for 

getting someone else to read the articles is that we are too familiar with the material and often don't really read 

what we have written. After reading a piece a number of times we will skim as we read and can skip right over 

obvious errors. 

The next thing that you should do is leave the articles on the shelf for a few days and then come back to them 

again with your red pen. This helps to lessen the familiarity and you will be surprised at how many times you 

will see an error you hadn't noticed before. 

After all of your reading and re-reading and getting someone else to check the articles make sure that you run 

each and every piece through geoSpell. Keep a real dictionary close by so you can look up any flagged words 

that you aren't sure of.  

While geoSpell is not the best spell checker around it is the only one for geoWrite articles. There are two main 

reasons for using geoSpell. I consider myself a very good speller and typer but the familiarity issue rears its 

head at times and I miss things in spite of all of my proof-reading. The other point is that importing articles 

from other word processors is not a perfect process. As is evident in the first paragraph (and far too many 

publications) the spacing between words can often get lost which results in some odd combinations. 

When you are satisfied that you have corrected all of the mistakes continue with the creation of your geoPublish 

document. When the entire project is complete print it off again and read everything all over again. This time 

pay particular attention to the headlines, picture captions and any other special text you have added. 

Once you have gone over everything and made all of these corrections you are ready to print off your 

publication and prepare it for distribution. 

You may think that proofreading and spell checking is something that you can do quite quickly but to do it right 

takes time. Don't underestimate the returns it will pay. People need to know that the person they rely on for 

information cares enough to invest the time to present the news in a clear, concise and error free manner. If that 

is not the case any paying subscribers will not continue to invest their money in your efforts. 
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This point also fits in with article #8. If you edit an article that you received from someone else you should send 

it back to them for approval to ensure you haven't cut in the wrong places. You could also request that the 

author cut the article down to size for you and then you will be assured not to affect the tone of the piece. 

Next time we will look at another method for importing graphics into our geoPublish documents. 

Until then, enGEOy your Commodore!  
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Importing geoPub12 - Proof Reading 
 

Start geoPublish and open the TutorialPart2 geoPublish document. Change to Page 21 if it doesn't open there.  

 

To import our geoPub12 article we will first need to create a new page to import it onto since Page 21 is already 

full. Choose New Page under the Options menu and agree to create it. Our new page (#22) will be a Left Page 

Layout and it will need a Large Headline Region (1A-3E) and 2 column regions for our text (3A-4C; 3C-4E).  

 

BUT, since we have been saving our Page Layouts in a Library file we don't have to create the regions this time. 

Choose the Library option under the `file' menu. Use the down arrow button to move down the list until you see 

the Lf2ColLrg entry that we created when importing geoPub10 and then press the Open button. 

 

 Now, choose the `text placement tool', select geoPub12 from the list and then click on the left (3A-4C) and 

then the right  (3C-4E) text regions. After the import press the SHOW button to ripple the text. 

 

All done. 
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GeoPublish Tutorial Part 13 - Importing Graphics Part 2 

This time out we are going to have a look at another technique for importing graphics into geoPublish (gP) 

documents. The method we will use this time is similar to the Page Layout (P.L.) method we used on Page 20 in 

installment 10. We will create P.L. regions but we will do the imports in Page Graphics Mode (P.G.). 

The big difference between these methods is that P.G. gives us access to Attributes, including some important 

options, that let us manipulate the images after we have placed them on the page. You'll see how this can be 

desirable when using graphics. 

Since we are going to be changing the size of our image I am going to choose the "Open Scroll" graphic from 

the Fantasy Photo Album on the 2-Disk gP version. Scrolls roll and unroll and change size in the process so it 

seems appropriate. Use Photo Manager to copy this graphic to a Photo Scrap on your Tutorial Project disk. 

Our first import will not change anything with the image proportions. We are just going to center the image. Go 

into P.L. and create a region (9"V to 4 2.5") and then press the SHOW button to ripple the text. Return to P.G., 

change to Zoom view and scroll to the region. Choose the Bitmap Placement Tool [gP Page 3-6] and click on 

the top left corner of the region. 

Once the graphic has been pasted into place choose the pointer Tool and click the picture. Now press "C= A" or 

click on the Attributes Icon [gP Page 3-5]. In the Attributes box [gP Page 4-45] make sure "Centered in Region" 

is selected. If you compare this to the P.L. box [gP Page 3-19] you'll see some big differences. Along with the 3 

main options and Smoothing we can make the graphic transparent or set it in a pattern. Click OK to close the 

Attributes box. 

You will notice that the image looks normal. Click on the image and use the Resize button to align the image 

with the region. In Zoom View you can see that there is room between the text and the region so you could drag 

the edges of the graphic outside of the region. No matter how big you expand the graphic boundary the image 

will remain a constant size. Also, when you choose Centered, if you resize smaller than the original size the 

image gets cropped, losing some of the graphic. 

Our next placement will use the Scaling option. Go to P.L., create a region (2"F to 3"Z) and ripple the text. 

Return to P.G., change to Zoom view and scroll to the region. Place the graphic, open Attributes and choose the 

second option (Scaled to fit). 

The graphic doesn't look any different than the first time we placed it but now we can do some neat things. 

Highlight the graphic, click on the Resize button and align the boundary with the P.L. region. The graphic will 

be scaled to fit into the new area. Scaling enlarges or reduces the image but will not distort it. 

Finally return to P.L., create a region (6"X to 8"F) and ripple the text. Back to Zoom View in P.G. and locate 

the new region. Paste the image and then choose the Stretched and Scaled to fit Attributes option. 

Now, when we click on the graphic and stretch it down to the bottom of our region it gets distorted and does not 

hold its original shape. 

And that is it for importing into P.G. where we have more control over the Graphics than in P.L. or Editor 

Mode. Next time we are going to look at yet another method (and my favorite) for importing Graphics. 

Transparency will come later.  Until then, enGEOy your Commodore!  
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Importing geoPub13 - Importing Graphics Part 2 
 

Start geoPublish and open the TutorialPart2 geoPublish document. Change to Page 22 if it doesn't open there.  

 

To import our geoPub13 article we will first need to create a new page to import it onto since Page 22 is already 

full. Choose Next Page under the Options menu and agree to create it. Our new page (#23) will be a Right Page 

Layout and it will need a Large Headline Region (1V-3Z) and 2 column regions for our text (3V-4X; 3X-4Z).  

 

BUT, since we have been saving our Page Layouts in a Library file we don't have to create the regions this time. 

Choose the Library option under the `file' menu. Use the down arrow button to move down the list until you see 

the Rt2ColLrg entry that we previously created and then press the Open button. 

 

When we created the Rt2ColLrg layout we had not changed the Gutter settings so we must correct that before 

importing our article. Click the Left Text Region (3V-4X) and then choose `set gutters' from the Options Menu. 

Set the Left and Right Gutter values to 10. Now do the same for the Right Text Region (3X-4Z). I'll leave it up 

to you if you want to re-save this Layout to the Library. 

 

 Now, choose the `text placement tool', select geoPub13 from the list and then click on the left (3V-4X) and 

then the right  (3X-4Z) text regions. After the import press the SHOW button to ripple the text. This article is 

formatted to fit around the graphics we will be importing so don't worry about the odd spacing at the moment. If 

you follow through and create the regions for the graphics as described it should all line up fine in the end. 

 

Since we are going to be importing a Graphic a number of times we'll make a change to help us with that. Go 

into Master Pages Mode and create a new Vertical Guideline at the 6 1/4" mark on the top ruler. This Guideline 

does not coincide with any of our Columns so it will be a Floater which can be set anywhere to enable Graphic 

placement. I will refer to this Floater as Guideline `F'. 

 

We're now ready to learn more about importing Graphics. 
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GeoPublish Tutorial Part 14 – Free Flow Graphic Placement 

I have two main `issues' with the graphic importing methods we have looked at so far. One is the uneven 

spacing, or discontinuity, in the text at the top and bottom edges of the regions created for Graphics (see Page 

#23). It is possible to reduce these but it takes extra time and effort and isn't always successful. The second 

issue is the amount of wasted space around an odd-shaped graphic if you reserve space for it with a region. This 

time out we will look at what I like to call Free Flow Graphic Placement - a process that takes care of both of 

my issues. 

If you have been around the 64 scene for any length of time you may remember when Berkeley Softworks ran 

fancy ads in all of the C= magazines. With the introduction of GeoPublish (gP) in 1988 this trend continued and 

brought us one ad in particular that I felt displayed a flaw in the way gP handles text and graphics (or at the 

least in the way in which people place text and graphics). 

The prescribed method for placing graphics is to go to Page Layout Mode (P.L.), create a region with the Open 

Region tool and then use either P.L. or Page Graphics Mode (P.G.) to place the graphic. This works fine if your 

image is of a blocky type, as the text re-formats around the region, but leaves lots of empty space if you are 

using an odd shaped picture. 

This brings us back to the Berkeley ad I mentioned above which featured a giraffe in the middle of two columns 

of type. Looking at the ad you can see columns placed far apart, a region used for the graphic, and gutters that 

weren't used effectively. We will redo this ad to use free-flow graphic placement and show just how much more 

text can fit on a page and how your image becomes part of the page instead of standing out on its own. 

Figure 1 (preview mode) & Figure 2 (zoom mode) show a reasonable facsimile of the original ad. The basic 

layout was created using the Master Page '2C Divider' Library file and the Page Layout '2C Title U' Library file. 

After some manipulation of the guidelines and regions I had the desired layout and was able to import my 

graphic (a Giraffe from The Newsroom publishing package by Springboard). I poured this article into the text 

regions, added the headline and separator graphic and had a completed page in no time flat. I used Screen2Paint 

for the screen captures and ScrapCan to create the Photo Scraps. Thumbnail, from RUN's GEOS Power Pak, 

was used to create Figure 3 and Figure 6 after printing the gP page to disk with the Paint Pages printer driver. 

Using the original gP Library files and a region for the graphic allows a newsletter page to be laid out with very 

little effort and in a very short time. This process can, however, waste a lot of space and may lead to our 

newsletter taking up more pages than it needs. 

As we redo this ad we will avoid the gP Libraries and we will not create a region for the graphic but will utilize 

the paragraph formatting of the gP Editor Mode to flow the text around our image. 

This process takes careful planning and counting but can greatly reduce the wasted space around your images. 

There is also a bit of mode swapping as you must go from Editor to P.G. Zoom View and back to get the fit you 

want. 

We will use this article and this Page (#24) to recreate the ad. Since we have already imported the text file our 

next step is to place our graphic on the page. 

Make sure your graphic (the giraffe in this case) is in a Photo Scrap and choose the P.G. Bitmap Placement 

Tool. Move into the middle of the page (about 3 1/2" and 2 3/4") and place the graphic. You can now select it 

(with the Arrow tool), open the Attributes box (select Stretched & Scaled) and resize it however you wish. To 
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create our faux ad I am going to stretch it down to the 9" mark and over to 5 3/4" on the horizontal scale (Figure 

4). It is a little easier to do this if you use Guidelines or if you get it close to the size you want in Preview and 

then change to Zoom for final placement. 

Get a piece of paper and get ready to count. Go into P.G. Zoom and locate the top of the image. Make note of 

the line of text directly above the graphic - you will want to make this the end of a paragraph. In our case the 

giraffe has been placed at a paragraph break. 

Make note also of the ruler position at the left edge of the graphic - you will set the Right Margin of the new 

paragraph 1 or 2 ruler notches short of this. This is another one of those skills that you will develop over time as 

the P.G. ruler increments in 1/8ths of an inch while the Editor ruler increments in 1/10ths of an inch. I use the 

rulers as a bit of a guide but rely more heavily on text in the previous line to help me line things up the way I 

want. You will develop your own process. 

Scroll down the page and count how many lines of text the graphic is tall - this is how many lines you need at 

that right margin setting. For the giraffe I counted 25 lines and added 3 more to allow for a caption. 

At present we are only looking at the left side of the graphic. Go into Editor mode and make the changes to our 

margins in the left column. This will change the positioning of the text in the right column (as things move 

down). Return to P.G. and scroll down the left side of the giraffe and make sure your text lines up as you want 

(if it doesn't, go back to the Editor and make adjustments). The left column must be left alone once you start 

working on the right column. 

When you are happy with the left side of the image start at the top and work down the right side. You will be 

counting the lines of text and deciding where to set the left margin of your text this time (Figure 5). You will 

see that I used a lot of single line paragraphs to mold the text to the shape of the giraffe. 

I know that this may sound like a lot of work but, once you've done it a few times, you will find it quite easy to 

do with very little mode swapping. You will also find that, if your graphics are odd shapes like our giraffe, you 

can fit a lot more text on the page (compare Figure 6 with Figure 3). In this case we added three full paragraphs 

to the page using the Free Flow Graphic method. Your graphics will also appear to be part of the page instead of 

looking like a separate island. 

ScreenShots 

There are 6 other Photo Scraps that accompany this article. We will now import them and make use of some 

other geoPublish tools for accurate placement. 

So far our Graphic Placement technique has relied on Regions, Guidelines and `close enough' placement. You 

know my feelings on Region Placement. Using Guidelines is great but there are a limited number of these and 

you can't change their location while in Page Graphics Mode. For the screenshots we have here we don't have a 

lot of extra space on the page and we want to ensure we have room for Captions under the images. In order to 

get the graphics placed exactly where we want them we'll use the line tool for help. 

Go to Page 25 and change to Page Graphics Mode. Select Zoom View and place the Zoom Box so you catch the 

top right corner of the text region (about 1/2" and 2"). This placement puts the Toolbox in such a position that 

we can leave it visible while we are working. If the Toolbox gets in the way of our work we can hide it with the 

Toolbox item under the Options Menu or by using the C= T shortcut. The same options make it visible again 

(they toggle the Toolbox) when you want to see it. 
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Select the Line tool and draw a line straight down from the 3 3/4" mark on the top ruler. Draw another line 

across from the 1 1/8" side Ruler. Make sure you draw the lines long enough so that they intersect. If they don't 

you can erase them and draw them again or select them and use the black resize box to change the length. 

From the GEOS menu open Photo Manager and Copy the Fig1 image to a Photo Scrap. Close Photo Manager 

and then choose the Bitmap Placement Tool. Move your Pointer onto the page and Click to place the image at 

the intersection of our two lines. 

Now select the Pointer tool and then click on each of our two lines in turn and then click on the Scissors to cut 

the lines from the page. Select the Update Tool [gP Page 3-5] to redraw the page. Trust me. This graphic comes 

out crisp and clear when printed on a PostScript printer. 

If you don't have an Accelerator on your system you will want to turn off the display of bitmaps in the 'disp' 

menu. This causes a grey box to be drawn in place of the bitmap, so you continue to have an idea of the actual 

size, and speeds up screen redraws. 

Change back to Preview (disp menu) and then select Zoom again. Place the zoom box so it overlaps the lower 

left corner of the graphic we just placed (about 3.5" and 2"). Here we want to select the Line tool and draw a 

vertical line at the 3 3/4" mark and a horizontal line at the 4 1/2" mark. Copy the Fig2 graphic into a Photo 

Scrap with Photo Manager and then place it at the intersection of these two lines. Once the graphic has been 

placed erase the two lines and go back to Preview. 

The two graphics that we have placed are screen shots of geoPublish while creating the simulated BSW ad. Our 

third image for this page is a thumbnail image of the ad once it was completed. The thumbnail is a lot smaller 

than the screenshots. Select Zoom View and place the box at about 7" down the page and as far to the right as it 

can go. Draw our two lines at 5 1/2" vertical and 7 3/4" horizontal. Copy Fig3 to a Photo Scrap with Photo 

Manager and place it on the page at the intersection of these two lines. Erase the two lines and change back to 

Preview. 

Change to Page 26. Select the Zoom View again and place the box at the top right corner of the text column 

(1/2" and 2"). Draw a vertical line at the 3 1/4" mark. Draw the horizontal line at the 1 1/8" mark. Copy Fig4 to 

a Photo Scrap with Photo Manager and then place it on the page at the intersection of our lines. Erase the lines 

and return to Preview. 

Use Zoom View to place Fig5 and Fig6 on the page. For Fig5 draw lines at 3 1/4" vertical and 4 1/2" horizontal. 

Place Fig6 with a 5" vertical line and a 7 3/4" horizontal line. 

I hope you see the potential in using both methods of graphic placement that we have looked at this time. Be 

aware that you can also use the line method in the Lower Right corner of a graphic to aid in re-sizing efforts. 

Next time we will start using Special Text to place Headlines, callouts, article continuation notes and end of 

article markers. 

Until then, enGEOy your Commodore!  

 

 

 



51 
 

Importing geoPub14 - Free Flow Graphic Placement 
 

This article deals with blending text and graphics using a method that is not outlined in the Publish manual. In 

addition to the main graphic we'll be working with, the article contains 6 other related Photo Scraps that need to 

be imported. Due to the size of the screen shots we will use a variation on our 3 column text layout. 

 

Start geoPublish and open the TutorialPart2 geoPublish document. Change to Page 23 if it doesn't open there. 

 

To import geoPub14 we first need to create a new page using the 'New Page' menu item under the Options 

menu. Page 24 is a Left Master Page that starts a new article so we need a Large Headline area. Change to Page 

Layout Mode if you aren't already in it and then load our Lf2ColLrg layout. Import geoPub14 to the left and 

right text regions. 

 

Create Page 25. This page is a Right Page that will use a 3 Column Layout with a Small Headline Region. We 

haven't got a Layout like that saved but there are a couple of options.  

 

First off we can create a new Layout. We need the headline region (1V-2Z) and three text regions (2V-4W; 2W-

4Y; 2Y-4Z). Save this to the Library as Rt3ColSml. 

 

Or, in Page Layout Mode import either the Rt3ColLrg or Lf3ColSml layout. Adjust the regions to match our 

desired layout as above and save this adjusted layout to the library as Rt3ColSml. 

 

Now that we have created our basic right page regions we need to adjust them to fit our current needs. Make 

sure you have the pointer tool selected and click on the Middle Region (2W-4Y). Now, with the region 

highlighted, click on the Scissors tool and Cut the region from the page. Do the same with the Right Region 

(2Y-4Z) so that we only have the Left Region (2V-4W) on the page. Click on the Left Region and then choose 

'set gutters' under the Options menu. Set the gutters for this region to 5, 0, 5, 5. Click OK and then import 

geoPub14 into this region. 

 

Create Page 26. Import Page Layout Lf3ColSml. Delete the Middle and Right Regions. Change the Gutters on 

the Left Region to 5, 0, 5, 5 and then Import geoPub14 into this region. 

 

Create Page 27. Load the Rt2ColSml layout and import the remainder of geoPub14 into the left and then right 

columns. 
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ScrapCan V1.3 by Nathan Fiedler (8/8/93) 
 

ScrapCan is an application that allows you to copy and paste any size photo scrap.  That's any size, even the full 

size of the document page. 

 

To use ScrapCan, launch it from the deskTop.  A dialog box will appear, listing the geoPaint/geoCanvas 

documents on the current disk.  Use the DISK and DRIVE icons to open other disks.  When you've found the 

document you wish to operate on, select it and click OPEN. 

 

When you've OPENed a document, you'll be asked to input a threshold value.  This is exactly the same as the 

threshold box in geoCanvas, and is here because ScrapCan is going to "preview" the document you've selected.  

If you haven't used geoCanvas, or you don't understand what threshold is, simply press RETURN, and the 

default 3 will be entered. 

 

Once you've pressed RETURN, ScrapCan will now display the document in a preview type box.  Once it's 

done, you can move the mouse within this box and click in it.  As you drag the mouse you should see a fence 

being formed.  Click again to set the fence, which will now outline the region.  Once you've defined a region 

using the fence, you can click on the 'edit' menu.  There are two options here:  'copy' and 'paste'.  Select the one 

you want. 

 

Now, if you've selected 'copy' as the operation, ScrapCan will ask which disk you wish to copy the photo scrap 

to.  The box on the screen will display the three drives and the name of the disk in each.  Highlight the drive you 

want by clicking in the rectangle in front of the disk name.  If no disk name is listed after the little rectangle, 

you won't be able to select that drive.  Click OK once you're ready. 

 

ScrapCan will then begin to copy out the region you've selected from the document, and place it on the 

destination disk.  This may take one or two minutes depending what type of drive you're reading and writing to.  

If you have an REU, it's suggested that you use it to emulate a real drive, so that ScrapCan will work much 

faster. 

 

Now, suppose you clicked on 'paste' in the 'edit' menu.  In that case, it will display a box asking what source 

disk you wish to paste the photo scrap from.  This box is very similar to the destination drive select box in the 

copy option of ScrapCan.  Once you've selected a drive, ScrapCan will ask you if you want to paste 

transparently.  This means that it will blend the data in the photo scrap with the data of the document.  Click 

YES to begin pasting transparently, or NO to begin pasting normally. 

 

Once ScrapCan is done, it will display a box asking if you want to paste in the color or not.  Click YES or NO.  

No-color pasting is useful if you want to transfer a large bitmap from one document to another, and leave the 

color in the destination document intact. 

 

This was done seperately from geoCanvas because it requires too much memory to work in GC. 

 

If you ever get a disk error, please write down:  Source drive # and drive type (RAM 1581, 1541, etc.), 

destination drive # and drive type, the error number, and the function (copy or paste).  Please send the 

information to Nathan Fiedler at the address where you ordered this disk.  Thank you. 

 

Enjoy! 
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From: Maurice Randall Sat Jun 24 17:12:21 2000 
 

Here's the DA I told you about that I use to make screenshots with. It will run in Wheels 64 or Wheels 128, 40 

or 80 column mode. It works in any app that can run a DA. There's no docs, but it's easy to use, just run it. 

 

When run, it automatically takes a snapshot of the current screen and saves it to the current directory as a 

GeoPaint file. A unique name is given to the filename depending on which mode you're in: 

 

"SCREENSHOT 64"  for 64 mode. 

"SCREENSHOT 40" for 128 40 column mode. 

"SCREENSHOT 80" for 128 80 column mode. 

 

If a filename exists of the same name, it will be deleted and replaced with the new file. So, if you want to take 

more than one screenshot, you must rename the current file to something else before making the next one. 

 

It captures all the color, even in 80 column mode. A 40 column screen will be placed at the upper left corner of 

the GeoPaint image and will be 320 x 200 pixels. An 80 column screen will be 640 pixels wide, but will be 

stretched to 400 pixels high (each vertical pixel will be duplicated) in order to maintain the correct aspect ratio 

for printing as well as for converting to other file formats for display on other computers. 

 

This file was archived with Wraptor V3. It may be passed around freely to anyone that would like to use it. I 

can also make the source code available to anyone that's interested. 

 

-Maurice 
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GeoPublish Tutorial Part 15 – Adding Special Text 

In this installment of the Tutorial we are going to use Special Text in Page Graphics (P.G.) Mode to add 

Headlines, Captions, Pull-Quotes and End of Article markings to give our Publication some flair. When creating 

Special Text [gP Page 4-35] we can use any GEOS font from 4 to 192 points and in any style. Since we are 

aiming for PostScript (PS) Printer output of this Tutorial we will stick to the 11 LW Fonts - in particular, the 5 

fonts identified in installment #3. If you aren't using a PS Printer you should use MEGA Fonts for your 

headlines and Special Text as the larger available point size reduces the jaggies that occur when enlarging 

regular GEOS fonts. 

While some people may use P.G. to add Special Text to each page as they go along I prefer to finish all of my 

text work and Graphic Placement first in case editing of files changes the layout. After all of the preceding work 

is completed I print off the file and use my red pen to indicate areas that need a Headline or Caption or to draw 

in a line or box. 

Since we have done our proofreading and spell checking a good option for this phase of publishing is to print 

out Thumbnails of the pages. Thumbnails can be printed from PostPrint or geoPubLaser or created manually 

with the Paint Drivers and the Thumbnail program from the RUN GEOS Power Pak disk. The beauty of 

Thumbnails is that all 16 pages of a geoPublish document get printed onto one 8.5" * 11" page (reduced to 22% 

size) and you can readily see where you need to add Special Text. 

While adding the Special Text I don't finish each page as I go but rather jump from page to page, back and forth 

through the document. The reason behind this is that the Attributes for the Special Text (Font, Size, Style) are 

retained by geoPublish. So, if I have 5 headlines to place it is quicker to set the attributes and then use the "Goto 

Page" Option to jump to each location and enter the headline than to change the attributes multiple times on 

each page. Another handy feature to speed things up if you don't have an accelerator is to turn off bitmaps in the 

options menu. 

Main Titles 

Let's start geoPublish, open our TutorialPart1 document and GoTo Page 1. In P.G. Select the Text Tool, open 

the Attributes, set LW_Cal, 30 point, bold, Centered and then press OK. 

Turn Snap On. Place your Pointer at the top left corner guidelines and click. The Special Text dialog box will 

open. Enter "Sophisticated Software" for our first article title. Click OK to set the text.  

Now we need to fix the alignment. Turn Snap Off. Select the Pointer and then click on our freshly placed text. 

Since we set Centering the text box extends to the right edge of the page. We want our headlines centered 

between our outermost vertical guidelines. Grab the resize button and drag it back to line up with the right 

guideline and at the same time drag it down about 1/4 of an inch. The reason we need to expand the box 

vertically is that the PS fonts print a bit different than they appear on screen. If we don't expand the text 

bounding box some of the letters may get cut off when printed. If you change Special Text Attributes after this 

placement you must expand the box again as it's size will return to the default. 

Next we have to change to Zoom View in the top left corner of the page. Make sure the Pointer Tool is selected 

and then click anywhere on "Sophisticated" to select the Special Text. Turn the Toolbox off in the Options 

Menu (or C= T - a handy toggle to keep the Toolbox from getting in the way). Drag the top corner down about 

1/4" to center the text in the Region. 
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Our first title is done so GoTo Page 3 and change to P.G. Preview.. Since our Attributes are going to stay the 

same we just have to turn on the Toolbox (C=T), select the Text Placement Tool and set the box at the top left 

corner guidelines. Enter "A Quick Tour" as the title and then fix the alignment by re-sizing the bounding box 

back to the right guideline, expanding it downwards 1/4 inch and then centering it vertically in the region. 

On Page 5 enter "Planning & Preparation" for the title. Fix the alignment, expand the box and center the text 

vertically before moving to Page 7. The steps are the same for the rest of our headlines so here they are. 

Page 7 - "Master Pages Mode" 

Page 10 - "Page Layout Mode" 

Page 13 - "Document Conversions" 

Page 14 - "Importing More Articles" 

That is all of the headlines for this document. Let's GoTo Page 2 and start with our headlines for subsequent 

pages. 

Subsequent Titles 

Choose the Text Placement Tool and then open the Attributes. For these subsequent headlines we want 

LW_Cal, 24 Point, Centered and Bold. Set those attributes and click OK. Set our Headline in the usual position 

and enter "Sophistication". Fix the alignment and expand the box downwards and we are ready to GoTo Page 4. 

Here, our headline will be "Touring". 

Add the following headlines: 

Page 6 - "More Planning" 

Page 8 - "Master Pages" 

Page 9 - "Master Pages" 

Page 11 - "Page Layout" 

Page 12 - "Page Layout" 

Page 15 - "Importing Articles" 

Page 16 - "Importing Articles" 

If you were paying attention you noticed that we have two more headlines to add. Let's GoTo Page 10. On this 

page we carried over the remainder of the previous article into two half-columns at the bottom of the page. 

Place your Text Pointer at 5 3/4"A and click. Enter "Master Pages" and then center and expand the box. 

Now GoTo Page 14 where we also have an article carried over in the lower half of the page. Place your Text 

Pointer at 6"A and enter "Converting Documents" as the headline and then align and expand the box. 

Pull-Quotes 

Since we were not importing graphics at this stage of the Tutorial we don't have any captions to add We do, 

however, have two Pull-Quotes to add. GoTo Page 2, change to Zoom view and position the Zoom box about 

2/3's of the way down the left column. You will see that there is space left between the last two paragraphs. We 

are going to use a Pull-Quote to fill this space. 

A Pull-Quote is used to attract the reader's eye to the page and provide some enticing information from the 

article to get the reader to read some more. Select the Text Placement Tool and then set the Attributes to be 

LW_Giannini, 18 points, left justified, plain. Now place your pointer at 5 3/4" and 1" and click. Enter the word 
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"It" and click OK to place the word on the page. Select the Pointer tool and click on our text. Use the re-size 

button to expand the text box down and across to 6 3/4" and 3.5".  

After placing the box open the attributes and change to Center justification. Press the Edit button and enter the 

rest of the text so it says "It is very important to allow the reader's eyes to rest." and then click OK. The text 

should be centered nicely in the blank area we had left for it. 

Let's GoTo Page 4 where we have a blank area near the bottom of the middle column. You can stay in Zoom 

View and GoTo Page 4 and the Zoom box will just need to be moved over to the right and down a bit by 

moving your mouse pointer against the side and bottom edges of the screen. 

Our text here is "...Page Graphics Mode is where you make it shine." but before entering the text change the 

Attributes back to left justified. Now just enter "...Page" to start with and then size the box to fit into our area. If 

you left the settings at Center you would Center the text between our placement point and the right edge of the 

page. Then, you would have to go to Preview in order to re-size the box back into our center column area. Once 

you have sized the box and entered the entire text string you can change the attributes back to Center to get the 

proper formatting. 

Marking the End 

Many publications use a symbol or picture to mark the end of each article. All of my articles here end with 

"Until then, enGEOy your Commodore!" but having a tag line like that to mark the end of an article isn't always 

going to be the case. One of our PS fonts is called LW_Shattuck and it contains many different symbols that are 

suitable for marking the end of an article. Open Zoom View in the bottom right corner of Page 2. We'll place a 

symbol to the right of the word "Commodore!" to indicate the end of this article. 

Select the text tool and open the Attributes. Set the font to LW_Shattuck, 12 points, left, Plain (styles don't have 

any effect on this font). We are going to use an Uppercase letter "X" which corresponds with the LW_Shattuck 

Splat symbol. Place the X and then expand the bounding box. Do the same on Pages 4, 6, 10, 12, 14 and 16. 

Again, you can see how changing pages in Zoom View and setting Special Text is easy to do when you don't 

have to change Attributes each time. 

Part 2 

So we have finished adding all of the Special Text we need to into our TutorialPart1 document. It is time to 

close it and open TutorialPart2. 

We have to start with Main Titles again so change to P.G. and GoTo Page 17. Choose the Text Place- ment 

Tool and set the Attributes to LW_Cal, 30 points, Bold and Centered. The Titles we need to enter in Part 2 are 

as follows. 

Page 17 - "Editor Mode" 

Page 18 - "Column Analysis" 

Page 20 - "Importing Graphics Part 1" 

Page 22 - "Proof Reading" 

Page 23 - "Importing Graphics Part 2" 

Page 24 - "Free Flow Graphic Placement" 

Page 28 - "Adding Special Text" 
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We have one more Main Title to add. On Page 21 we have an article which fills just the right column. Place 

your Text Pointer at 1/2"X and enter the title as "Document Renaming". Due to the narrow column the two 

words will be above and below each other. We still need to align the Bounding Box with the right guideline, 

expand it a bit and move the whole thing down about 1/4 of an inch. 

With the Text Tool selected change the Attributes to LW_Cal, 24 Point, Centered and Bold. Create the 

following Sub Headings: 

Page 19 - "Column Analysis" 

Pages 25, 26, 27 - "Free Flow Graphics" 

Pages 29, 30, 31 - "Special Text" 

GoTo Page 18 and position the Text Pointer at 5 4/72"A and enter "Editor Mode" for the sub heading. Next 

GoTo Page 21, change the Attributes to Left Justified and enter "Graphics Part 1" as the sub heading with your 

Text Pointer at the Top Left Guidelines. After Placing this Text change to Zoom View and expand the Text box 

to fit between the `V' and `X' Guidelines. Next, change the Attributes back to Centered and then expand the box 

down a bit. 

Captions 

In TutorialPart2 we began importing graphics. To help make sense of the images for our readers weare going to 

add some captions. Our captions are going to be set in LW_Giannini, 14 Point, Plain text and centered under the 

graphic. 

GoTo Page 20 and you will see in Preview that there is one graphic in the right column on this page. This is 

another reason not to use the first method for importing graphics. Change to Zoom View and place the box near 

the lower part of the left column. Here is a graphic that we imported in geoWrite / Editor Mode. It does not 

show up in Page Graphics Preview. We are going to place 2 captions beside this graphic. On the left side of the 

graphic we want our caption to say "Placed in geoWrite / Editor Mode". Make sure your Attributes are set to 

Left Justified, place your text pointer on the left side in line with the top of the garbage can and enter the word 

"Placed". Re-size the text box to be about as tall as the Can and enter the rest of the text. Change the Attributes 

to Centered and then expand the box down a bit. On the right side of the Can we want a caption that says "Not 

visible in Page Graphics Preview". Don't forget to change the Attributes back to Left before starting to enter the 

text. Once you have this caption completed move the Zoom Box (either scroll the screen or change to Preview 

and then place the Zoom Box from there) so that the other garbage can is visible. We want a caption on the right 

side of this Can that says "Centered in a Page Layout Region". GoTo Page 21 and enter a caption under this Can 

that says "Centered in a Region". 

All of the preceding captions re-inforce the reasons not to place graphics in Page Layout Mode. If there wasn't 

enough space to place our captions we could not move the graphics without changing all of our text layout as 

well. GoTo Page 23 where we have 3 graphics. Each of these was placed in Page Graphics Mode but aligned 

with a Page Layout Region. 

In Zoom View move to the lower part of the left column. We want to add "Centered" as a caption here. Under 

the graphic near the top of the right column we want a caption that says "Scaled". There isn't quite enough room 

to have this centered properly under the image but it is close enough for our purposes here. For the third image, 

that is lower on the right column, we will have to move the bottom of the image up about 1/4 of an inch (select 

the image with the Arrow Tool and use the resize button) to make room for our caption of "Stretched & Scaled". 

If you forget to change to Left Justified before setting a caption and it ends up Centered with the right edge of 



58 
 

the page just change it back to Left Justified, adjust the width and set Centered again. For a long Caption you 

would have to go to Preview to change the width or do some fancy scrolling in Zoom view. 

GoTo Page 24 where we have our very large Giraffe image. Change to Zoom view at the feet of the Giraffe. 

Our caption here will be "Stretched and Scaled without a region". Center this text in a box wide enough so that 

you have 3 words on each line. 

Pages 25 and 26 need 3 captions each. The first two will be centered under the images and the third one will be 

beside the image. Use the following captions: 

"Figure 1: Simulated BSW Ad – Place Graphic into its own Region on the Page." 

"Figure 2: Simulated BSW Ad - Graphic in Region; Text using separate Regions & Default Gutters." 

"Figure 3: Thumbnail of Page with Graphic in a Region." 

"Figure 4: Place your Graphic in Page Graphics Mode without a Region." 

"Figure 5: Use Free Flow Graphic Placement to wrap text around images." 

"Figure 6: Thumbnail of Page using Free Flow Graphic Placement." 

Almost Done 

We are now ready to add our Splat marks at the end of articles. Set the text to LW_Shattuck, 12 Point, Plain and 

place an Uppercase `X' at the end of Pages 18, 19, 21 (once in each column), 22, 23, 27 and 31. 

And finally, I can only imagine what you have been thinking so far as the first paragraph of each section has 

been missing the first letter and the formatting is odd. You have seen this technique used in many publications 

and it is not hard to do in geoPublish. We are going to place a Large Capital Letter (LW-Roma, 30 Point, Plain) 

straddling the first two lines of text at the start of these paragraphs. 

On Page 28 we need a letter `I' in the left column and a letter `L' in the right column. On Page 29 we need a 

letter `C' in the left column and a letter `S' in the right. On Page 30 we need both a letter `M' and a letter `S' in 

the left column and a letter `I' in the right column. Place these letters so that their tops are three pixels above the 

other characters in the first line. 

A slightly different approach will be taken with the letter `W' in the right column on Page 31. Line up the 

bottom of this letter with the bottom of the characters in the first line and then move three pixels up. 

That is all we are going to cover for Special Text now. I think there are enough examples and ideas here to keep 

you going for quite some time. Check your favorite publications for more ideas and see how easy they are to 

mimic in geoPublish. 

Next time we will look at some of the Drawing Tools available in Page Graphics Mode. 

Until then, enGEOy your Commodore!  
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Importing geoPub15 - Adding Special Text 
 

Start geoPublish and open the TutorialPart2 geoPublish document. Change to Page 27 if it doesn't open there. 

This installment is rather long and fills 4 pages. 

 

To import geoPub15 we first need to create a new page using the 'New Page' menu item under the Options 

menu. Page 28 is a Left Master Page that starts a new article so we need a Large Headline area. Change to Page 

Layout Mode if you aren't already in it and then load our Lf2ColLrg Library layout. Import geoPub15 to the left 

and right text regions. 

 

Create Page 29. This page is a Right Page that will use a 2 Column Layout with a Small Headline Region. Open 

the Library and load Rt2ColSml and then import geoPub15 into the left and right text regions. 

 

Create Page 30. Import Page Layout Lf2ColSml. Import geoPub15 into the left and right text regions. 

 

Create Page 31. Import Page Layout Rt2ColSml. Import geoPub15 into the left and right text regions. 

 

Follow along with the text to add Special Text to TutorialPart1 and TutorialPart2. 
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GeoPublish Tutorial Part 16 - Drawing Tools Part 1 

Now that we have our Article Titles, Captions and Pull-Quotes in place we can add some graphic elements to 

our pages. In this first look at the drawing tools available in Page Graphics (P.G.) Mode we are going to 

concentrate on Lines and Boxes. 

Another Blueprint 

Once again, our publishing efforts require some planning. If you have already printed off Thumbnail pages of 

our project up to this point, that is great. If you haven't, then now is the time to do so. Using PostPrint or 

geoPubLaser it is as simple as checking a box to print a page of Thumbnail images. If you don't have access to a 

PS Printer at the moment you could print each geoPublish (gP) Page to a geoPaint file using the Paint Pages 

Printer Driver and then use the Thumbnail program from the RUN GEOS Power Pak Disk to place up to 16 gP 

pages into a single geoPaint proofing file to print off. 

With our Thumbnail printout and Red Pen it is a simple process to mark the location of our graphics on each 

page to ensure that we don't miss anything. 

For this project we will draw a line down the left guideline. On pages where an article begins we are going to 

draw a line across the page below the title. On subsequent article pages we are going to place a shaded box 

around our titles. We will also add some highlights around our Pull-Quotes on Pages 2 and 4. 

Better than Grade 1 

We are going to start off drawing simple lines. Unlike using Crayola Crayons, however, gP provides some very 

handy features to make drawing lines easy and impressive. 

Start gP and OPEN the TutorialPart1 document. GOTO Page 1 and change to P.G. Preview. To make drawing 

our lines easier we want to turn on ratchet (C= R) under the options menu. Ratchet is similar to snap in that it 

controls the pointer placement but it does so in a different manner. Where snap attaches the pointer to the 

Master Page (M.P.) Guidelines, ratchet uses a grid system. Under the options menu you will see a choice to `set 

ratchet'. Choose this and you will see that we can use a `two pixel ratchet' or a `1/2 inch ratchet' as our grid. 

Choose the `1/2 inch ratchet' and press OK. 

We are going to draw our vertical line down the left side of the page first so select the line tool [gP Page 3-5] 

and then open the attributes for it. We want to choose `square' and `transparent', solid black and the narrowest 

line width. Press OK and then place the crosshairs at the top left corner of our page (1V) and click and drag the 

line down to the 10" mark. You will see how ratcheting makes this easy to do. 

Our next line will be under the title so place the crosshairs at the 3V location, click and drag across to 3Z. 

This will be our basic page configuration for graphics. With the M.P. line across the bottom of the text we have 

enclosed our text on 3 sides. The gap between where the left line ends at the 10" mark and the M.P. bottom line 

leaves the page a little less confined than if we had joined the two lines and ratcheting made it easy to do. 

Goto Pages 3, 5, 7, 10, 13 and 14 and add these two lines to each page in the same way we did on Page 1. We'll 

come back to Pages 10 and 14 to finish them up later. 
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And now a Box 

Goto Page 2 and draw the left edge line down the page to the 10" mark. Select the `Rectangle/Square' [gP Page 

3-6] tool and then open the attributes for it. We want our headlines to be visible but we also want to add a little 

flair to our pages. Select Square, the narrowest frame width, Transparent, and then click the up arrow beside the 

pattern box (which should be empty by default) 7 times to get a lightly shaded pattern. This pattern translates 

into a 12.5% grey shade when laser printed which gives a nice background for our titles. Click OK to close the 

attributes box. 

Click the crosshairs pointer at 1A and drag across and down and click a second time at 2E to make a shaded box 

for our headline. The attributes for the graphic objects are retained until you change them so it is a simple 

process to goto Pages 4, 6, 8, 9, 11, 12, 15 and 16 and add the line and box to each page. 

Once you have completed adding these elements to all of these pages goto Page 10. We continued an article 

onto Page 10 so we must draw a box around its' headline in the middle of the page. 

You should be able to see the headline text just below our lower regions. This makes it so that our 1/2 inch pixel 

ratchet won't line up our box exactly where we want it. We have 2 options. We could use the 2 pixel ratchet or 

we could stick with the 1/2 inch ratchet and just adjust the box in Zoom view after initial placement. 

I am going to stick with the 1/2 inch ratchet since the 2 pixel ratchet doesn't line up where I want it to and I'll 

have to adjust the box afterwards anyhow. The 2 pixel ratchet seems to move 4 pixels in the horizontal direction 

and 8 pixels vertically so it won't produce the box I want. 

With the 1/2 inch ratchet selected place your crosshairs at 5 1/2"A then click and drag to 6"E. Select the Pointer 

tool and select Zoom in the disp menu. Drag the Zoom box down the left edge of the page to the 5" mark and 

click to place it. 

After the screen redraws lightly bump your pointer against the right edge of the screen and quickly move the 

pointer back to the left. Wait for the screen to redraw and then do this again. These two bumps will move the 

screen over enough so that our left guideline (A) is almost at the edge of the screen where our ruler is. This will 

make it easier to judge where we want to place our box.Hide the Toolbox (C= T or use the options menu toggle) 

and then click on the shaded box. Click on the `move button' and drag the box down so that the top of it is 1 

pixel below the 5 5/8" mark (the first notch below the original position) and click to place the box. Unhide the 

Toolbox (C= T) and click on the Pointer tool to remove the bounding box from our shaded box. Next, click the 

Update Tool [gP Page 3-5] to redraw our page. The shaded box is positioned just right to have our headline 

centered. 

Now, goto Page 14 and then change to Preview under the disp menu. By changing pages first we don't have to 

wait for Page 10 to redraw in Preview before changing to Page 14 and having to wait for it to redraw. Select the 

Rectangle/Square tool and draw a box from 6"A to 6 1/2" E. Change to Zoom view and move the Zoom box 

down to the 4 1/2" mark. 

Select the Pointer Tool and then `bump' the right edge of the screen twice. Click on the shaded box and, using 

the move button, move the shaded box up to 1 pixel below the first ruler mark above the 6" mark. Click to place 

the box. Select the Pointer Tool and then select the Update Tool to redraw the page. 
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Highlighting 

Our two pull-quotes on Pages 2 and 4 need a little help to make them stick out from the page the way we want. 

Remain in Zoom view and goto Page 2. You should see our pull-quote in the lower portion of the screen. 

Select the line tool and draw a vertical line down the page from the 1" ruler mark. Draw a parallel line down the 

page from the 3 1/2" ruler mark. These lines will ensure that our next two lines are drawn correctly. 

Our next 2 lines will be drawn, one above and one below the Special Text, centered between our Special Text 

and our article text, across the page from the 1" vertical line to the 3 /12" vertical line. After drawing these 2 

lines, select the Pointer, click on the vertical line at the 1" mark and then click on the Delete Tool [gP Page 3-6]. 

Next, delete the vertical line at the 3 1/2" mark and then press the Update Tool to redraw the screen. 

Goto Page 4 and then we have to scroll the page to the right and down some to locate our Pull-Quote at the 7" 

vertical mark in the center column. We want to draw our vertical lines about 1/4" inside the column guidelines. 

Then, we want to draw our horizontal lines on top and bottom of the Special Text and between our vertical 

lines. Once you have done that Delete the vertical lines and Update the page. 

If you have been crossing off the graphics on our Thumbnail page you will see that we have completed adding 

our finishing touches to TutorialPart1. Close this file and open TutorialPart2. 

More of the same 

Use whatever method you have to and create a Thumbnail page for TutorialPart2. Go over this page with your 

red pen and mark the places where we need our lines and boxes. 

With TutorialPart2 open, goto Page 17 if it isn't open there, select the line tool and then the attributes. Attributes 

don't carry over from one document to the next so we have to ensure that the chosen options are Square, 

narrowest frame, transparent and solid black pattern. Turn on Ratchet under the options menu and make sure the 

setting is for 1/2 inch ratchet. In Preview add our Left Edge line and our line under the title. Add the same two 

lines to Page 18, 20, 22, 23, 24 and 28. 

Goto Page 19 and set the attributes for the Rectangle/Square Tool to Square, narrow frame, transparent and 

click the up arrow 7 times from the blank pattern to select the 12.5% shading pattern. Draw the Left Edge line 

and shaded title box on this page and Pages 25, 26, 27, 29, 30 and 31. 

Goto Page 18, select the Rectangle/Square Tool and draw a shaded box from 5"A to 5 1/2"E. Change to Zoom 

View, place the zoom box at the left edge of the page at the 4" mark and `bump' the screen to the right twice. 

Select the Pointer Tool, hide the Toolbox (C=T), click on the Shaded box and use the Move Button to move the 

box up by 4 pixels. Unhide the Toolbox, click the Pointer tool to remove the bounding box and the press the 

Update Tool to redraw the screen. 

We have a different Page Layout in this gP document so let's goto Page 21 and then change to Preview. This 

page has two articles on it. We need to draw a line down the left edge of the page as well as one down the 

middle guideline (X) - extend both to the 10" mark. The left column is a continuation article so it requires a 

shaded box at the top. Draw a shaded box from 1V to 2X. The right column is a new column so it needs a line 

under the title from 3V to 3X. 

We have to resize the shaded box so it isn't up against the center guideline. Change to Zoom view and move the 

box to the middle of the page. Make sure the Pointer Tool is selected and click on the shaded box. Use the 
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Resize Button to move the box to the left 1/4", click to place it, click the Pointer Tool to remove the bounding 

box and then press the Update Tool to redraw the screen. 

Verification 

In order to verify that we have placed all of the graphics that we wanted to it would be good to print out another 

Thumbnail page for each geoPublish file. Compare these pages with the previous Thumbnail pages and make 

any required adjustments. 

And that is all we have to do to add all of the graphics we need to up to this point in our Tutorial Project. From 

now on the directions on what to do for adding graphics will be included in the format file that accompanies the 

geoWrite files on the web site. 

In a future column we will look at an improved geoPublish program (Todd Elliott's V1.1) and see how an added 

feature makes it easier to add similar graphics to multiple pages as we have just done. 

Next time we will look at more of the drawing tools we have at our disposal in geoPublish. 

Until then, enGEOy your Commodore!  
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Importing geoPub16 - Drawing Tools Part 1 
 

After importing geoPub15 into TutorialPart2 we only had one empty page left in the geoPublish document. 

GeoWrite files cannot be split between geoPublish Documents so we have to create a new geoPublish document 

to continue with our Tutorial. 

 

 

Create new Document 

 

Start geoPublish and press the Create button. Enter a filename of TutorialPart3 and press Return to create the 

file. Change to Master Pages Mode and then choose `doc setup' under the file menu.  Starting Page number is 

32 (don't forget to press Return to set the page number), 2 Master Pages, First Page is a Left Master Page. Press 

OK. 

 

Under the file menu choose `library', select the LeftMaster library and press the Open button. Change to the 

Right Master Page and use the library option to import the RightMaster library layout onto the Right Master 

Page. 

 

 

Import the text 

 

Change to Page Layout Mode, use the Library option under the file menu to import the Lf2ColLrg layout. 

Select the Text Placement Tool and import geoPub16 into the left and then right text regions. Press the SHOW 

button to ripple the text and then choose `next page' under the options menu. Click OK to create the page. 

 

Use the Library function to import the Rt2ColSml layout. Import geoPub16 into the left and then right text 

regions and then press the SHOW button to ripple the text. Choose the `next page' option under the options 

menu and click OK to create the new page. 

 

Use the file menu Library option to import the Lf2ColSml layout. Import geoPub16 into the left and right text 

regions and then press the SHOW button to ripple the text. 

 

 

Special Text and Graphics 

 

Goto Page 32 and change to Page Graphics Mode. Select the Text Placement Tool and then open the attributes. 

Set LW_Cal, 30 points, bold, centered and press OK. Turn SNAP on. Place your Pointer at the top left corner 

guidelines and click.  Enter "Drawing Tools Part 1" in the dialog box that opens up and Click OK to set the text. 

 

Turn SNAP off. Select the Pointer tool, Click on the text and use the Resize button to align the text box with the 

right guideline and drag it down about 1/2 an inch at the same time. Click to set the text and then use the MOVE 

button to move the text box down and center it in the region. 

 

Since we are here let's add our lines. Select the Line tool and open the Attributes. Set Square, narrowest line 

width, transparent and Solid Black. Press OK. Turn Ratchet on (C= R) and then set the Ratchet under the option 

menu to 1/2 inch ratcheting. Draw the line down the left edge of the page to the 10" mark. Now draw our line 

under the headline from 3A to 3E. We're done with this page so choose Next Page under Options. 

 

We have the line tool selected so draw the line down the left edge of the page. This page also gets a box around 

the title but lets place the text first. 
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Select the Text Tool and then open the attributes. Change the 30 point size to 24 points and leave everything 

else the same. Click OK and place the text using the same title as the first page. Size and align the text box. You 

will find this easier to do if you turn Ratchet off. 

 

Select the Rectangle/Square tool and open the Attributes.  We want Square, narrowest frame, transparent and 

click the up arrow 7 times from the blank pattern to get the 12.5% shaded fill. Press OK and then turn Ratchet 

back on. Draw the box from 1V to 2Z and then change to Zoom View. Scroll across the page and ensure that the 

title is centered in the shaded box. If it is not go back to the top left corner in Zoom view, select the text with the 

Pointer tool and use the Move button to adjust the positioning of the title. 

 

We are done with Page 33 so select Next Page in the Options menu and then change to Preview. 

 

Place our title text first using the same title again. Then draw our left edge line and finally add the shaded box 

around the text. 

 

We have one more task to do to complete the import of geoPub16. Page 34 is the last page in this article. 

Change to Zoom View and move the Zoom Box to the lower Right corner of the page. Select the Text Tool and 

open the attributes.  Set the font to LW_Shattuck, 12 points, left, plain style. Press OK and place an uppercase 

`X' to the right of the tag line ("Until then, enGEOy...") and close to the right guideline. Select the Pointer Tool, 

Click on the freshly created Splat symbol and use the resize button to expand the bounding box. 

 

That is it we're done. 
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GeoPublish Tutorial Part 17 – Corrections & Continuations 

We have to be flexible while working with geoPublish (gP). When unexpected results pop up it is best to fix 

them before moving on. 

The first adjustment we have to make is in TutorialPart1 on Page 2. When we laid out this page we set custom 

gutter values to allow room for the title. The value we used was 36 which equals 1/2 an inch. 

When we drew the box around our title we used the ½ inch ratchet tool to ensure we got uniform box sizes on 

all pages. As soon as you place the box on Page 2 it is obvious that we have a problem. Our usual top gutter is 5 

points so we need to change the top gutter value for both text regions on Page 2 to 41 and then the box won't sit 

on top of the text. Read Page 12 again if you need a refresher on Gutters. 

After you move the text down by 5 points you should also adjust the Pull-Quote and the lines we placed above 

and below it. Use Zoom View on Page 2 to adjust these 3 items. 

In Living Color 

We haven't done anything with color yet. I was going to save that for the Front Cover. The graphics we have 

used so far need corrected so they will look better when printed. 

If you select the 'color' box when printing with PostPrint you will find that Maurice has programmed PostPrint 

to print colors for all but the first 9 patterns. Many of the graphics we have used so far look fine when printed 

on a Black & White Printer but appear as medium grey on light grey when printed in color. 

To correct this we have to load each photo scrap into geoPaint, turn on color, select Black foreground on White 

background, color the image, copy the scrap, add it to our Photo Album and use this picture in gP. Quite a few 

of our images have to be changed on Pages 20, 21, 23 and 24. 

I have uploaded a new Photo Album containing color corrected images. I have also uploaded new geoWrite 

files for installments #7 (Importing More Articles) and #10 (Importing Graphics Part 1) as they contained 

embedded graphics that were affected by the color problem. Download these files and make the substitutions. 

Now you see me 

Another issue with our graphics is making sure they don't overlay other elements on our page. Select each of 

our imported Graphics in Page Graphics Mode, open their attributes and make sure that the Transparent option 

is selected. This will allow items that are on the page before the graphic to appear through the graphic. 

All Thumbs 

I incorrectly stated in the last installment that you could place images of 16 geoPaint files onto one page using 

the Thumbnail program from RUN's Power Pak disk. Only PostPrint and geoPubLaser will place all 16 pages of 

a gP document onto a single page as thumbnails. "Thumbnail" will only place 12 files onto one page so you will 

need two pages to print all 16 gP pages as thumbnails. This is possible by printing the geoPublish pages to 

geoPaint files with the Paint Pages printer driver and then using "Thumbnail" to shrink them onto a page. 

Continuations 
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A real quick topic that I am going to squeeze onto this page is adding continuation notices to help the reader 

find the rest of an article. Since I am using a slogan and a symbol at the end of articles in this tutorial we don't 

need to add notices but we will do it now just to see how it is done. 

Continuation notices are created using Special Text just like we did for titles, captions and pull-quotes in 

"Adding Special Text" on Page 28. 

Goto Page 13, change to Page Graphics Mode, change to Zoom view and place the box in the lower right corner 

of the page. We have enough space below the text and above our Master Pages line to add a continuation notice. 

Select the Text Placement Tool, open attributes and set font to LW_Zapf, 10 point. Click between the text and 

the line under "WrongIsWrite" and enter "(continued on Page 14)" for our text. Click OK and then stretch the 

text box down and out a bit to allow our text room to print. 

Stay in Zoom View and goto Page 14. Move the zoom window up to the middle of the page and place "(from 

Page 13)" in the shaded box to the right of the "Converting Documents" title. Stretch the text box down and out 

a bit and we are done. 

We will now return to our regularly scheduled material. 

Until next time, enGEOy your Commodore!  
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Importing geoPub17 - Corrections & Continuation 
 

Open TutorialPart3 and Goto Page 34. Choose `next page' under the Options menu. Click OK to create the new 

page. 

 

Import the text 

 

Change to Page Layout Mode, use the Library option under the file menu to import the Rt2ColLrg layout. 

Select the Text Placement Tool and import geoPub17 into the left and then right text regions. Press the SHOW 

button to ripple the text. 

 

 

Special Text and Graphics 

 

Change to Page Graphics Mode. Select the Text Placement Tool and then open the attributes. Set LW-Cal, 30 

points, bold, centered and press OK. Turn SNAP on. Place your Pointer at the top left corner guidelines and 

click.  Enter "Corrections & Continuations" in the dialog box that opens up and Click OK to set the text. 

 

Turn SNAP off. Select the Pointer tool, Click on the text and use the Resize button to align the text box with the 

right guideline and drag it down about 1/2 an inch at the same time. Click to set the text and then use the MOVE 

button to move the text box down and center it in the region. 

 

Let's add our lines. Select the Line tool and open the Attributes. Set Square, narrowest line width, transparent 

and Solid Black. Press OK. Turn Ratchet on (C= R) and then set the Ratchet under the option menu to 1/2 inch 

ratcheting. Draw the line down the left edge of the page to the 10" mark. Now draw our line under the headline 

from 3V to 3Z.  

 

Change to Zoom View and move the Zoom Box to the lower Right corner of the page. Select the Text Tool and 

open the attributes.  Set the font to LW_Shattuck, 12 points, left, plain style. Press OK and place an uppercase 

`X' to the right of the tag line ("Until then, enGEOy...") and close to the right guideline. Select the Pointer Tool, 

Click on the freshly created Splat symbol and use the resize button to expand the bounding box. 

 

That is it we're done. 
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GeoPublish Tutorial Part 18 – Drawing Tools Part 2 

This time we are going to play around with the rest of the drawing tools that geoPublish (gP) comes equipped 

with. We have some special areas available in which to work as well. At the bottom of pages 2, 4 and 10 we 

have unused space that is just perfect to try out the Spline, Polygon and other tools. 

Open TutorialPart1 and Goto Page 2. Change to Page Graphics mode and then open the Zoom box with its' top 

left corner at about 8" and 1 1/2". You should be able to see the footer at the bottom of the page as well as part 

of the end of article tagline in the top right of the window. 

You may notice that there is a line that only runs half way across the page above the footer. This is the line that 

we placed in Master Pages Mode. The text region in the left column ends at the 8" mark so it doesn't cover up 

the line the way the full-length region does in the right column. Don't worry, the entire line will be visible on 

the printout. 

Overlays 

We will start with the rectangle shape that we are already familiar with. Select the rectangle tool [gP Page 3-6] 

and then open the Attributes. We want the Square Shape, narrowest frame width, Opaque Draw Mode and Solid 

Black Pattern. Click OK and draw a rectangle from about 9" and 2" to 10 1/8" and 4 1/4". 

Select the Attributes again and press the down arrow beside Pattern once to get a solid white fill. After you click 

OK position the crosshairs just to the left and just above the box we just drew. A good offset to use is the width 

of the crosshairs up and the same to the left. Click to place the rectangle and then drag down to the lower corner 

and use the same crosshair distance for the offset there. 

What we have just created is a box with a nice drop-shadow. This is a simple method to add a bit a flair to your 

pages and the offset can go whichever way you feel. Another, less precise, way to create the shadow is to draw 

the empty box and then just draw two thick lines along its' sides. 

Select the text tool and open the Attributes. Select LW_Giannini, 14 points, black, left and across. Place the text 

box near the upper left corner of our rectangle. Type the word `Shadow' and press OK. Choose the Pointer Tool, 

click on the word `Shadow', and expand the text box to fill most of our rectangle. Open the Attributes again, 

change to Center justification, press the Edit button and enter this text: 

"Shadow created by offsetting Opaque rectangle over solid-filled rectangle." 

Press OK to set the text and then re-size the text box to allow a bit of room for the text to grow when printed. 

You may want to center the text vertically in the rectangle as well. Press the Pointer Tool to de-select the text 

box. 

We could have done this entire thing in the reverse order and that, sometimes, is easier. If you write out your 

text first then you know how big to make the blank rectangle around it. Finish by drawing the solid rectangle 

over the top of the text and blank rectangle. The Background Tool [gP Page 3-5] is then used to move the solid 

rectangle behind the text and blank rectangle. Play around with the Foreground [gP Page 3-6] and Background 

Tools with our rectangles and Update [gP Page 3-5] the page. 

Splines 
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The next tools we are going to use are the Closed Spline [gP Page 3-5] and the Spline [gP Page 3-6]. Scroll the 

page all the way over to the left edge to get some free space to work in. 

The first thing we will do is select the Text Tool, open the Attributes and change to Left justification. The 

Toolbox is right where we want to work so hide it by clicking `toolbox' under the options menu or use the C= T 

shortcut. Place the text crosshairs near 8 1/2" and 7/8" and click to place the text. Enter the word `Closed', press 

the Return key 4 times and type `Spline'. Press OK. Press C= T to get the Toolbox back. 

Select the Closed Spline Tool, open the Attributes and press the Up Arrow once to increase the line thickness, 

and then hide the Toolbox again. These tools work a bit different than the other tools we have used so far. With 

lines and boxes you click once to set the start point and once to set the end point. The Splines allow you to draw 

curved connected lines containing multiple points (up to 64). 

We want to draw a figure 8 around our two words. I used 26 points to draw my figure 8 shape. When you want 

to stop drawing the spline you have to double- click your mouse and then the spline will be drawn on the screen 

and connected with the first point. 

Scroll to the right about an inch and select the Text Tool. Place the word `Open' at 8 1/4" and 2 1/4" and the 

word `Spline' at 8 1/2" and 3 1/4". Make sure you expand each text box after you place it. Select the Spline 

Tool, open the Attributes, select Round Shape and then press the down arrow 6 times from Solid Black. When 

printed in color this Spline will be Turquoise. Click OK and draw a snake shaped Spline from the top left corner 

above the word `Open' down, under it and then up and over the word `Spline' and end by wrapping the tail 

down and under the word `Spline'. I used 12 points in my snake. Double-Click when you are done. 

Connected Lines & Polygons 

The last two tools are similar to the Splines except the lines are drawn straight rather than curved. Scroll all the 

way to the right edge of the page now. Select the Text Tool and write `Connected Line' at the 10" and 5" 

position. Then select the Connected Line Tool [gP Page 3-6] and open Attributes. Set Square shape, second line 

width and solid black pattern. I used 10 points to make a Mountain Range over my words. 

Select the Text Tool and write the word `Polygon' at the 8 3/4" and 5 1/4" position. Set the word in Italics. 

Select the Polygon Tool [gP Page 3-5] and change the Line Width to the narrowest setting. Draw a shape to 

surround the word `Polygon'. 

That is all I am going to do on this page. If you want to play around with these tools some more in the open 

spaces go ahead. 

Some More Color 

Stay in Zoom View and Goto Page 4. You will see the open space in the lower right corner of the page. Select 

the Text Tool, take off the Italics, set Center, and enter "This rectangle will be filled with Green when printed." 

Size the text box so you have 4 lines of text and then select the Rectangle Tool. Set the attributes to Square, 

second width, Transparent and click up 11 times from Black. Draw a box around the text. What you will notice 

this time is that the box is still outlined in Black but the pattern will fill the box with Green when printed to a 

Color PS Printer with PostPrint. 
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Circles / Ellipses 

Remain in Zoom Mode and GoTo Page 10. Below our tagline we have about 1 inch of space. We are going to 

use the Circle/Ellipse Tool [gP Page 3-6] to fill this space and, once again, demonstrate the effects of the 

Opaque/Transparent Attributes. 

Select the Text Tool, set Left and Bold, and click at 9 7/8" and 5 1/4". Type `Filled' press Return twice, type 

`Ellipse' and press OK. Select the Circle Tool, set Round, Narrow Width, click up 6 times from Black. Draw an 

Ellipse from 9 1/4" and 4 1/2" to 10 1/8" and 6 3/4". Select the Text Tool and write the word `Transparent' at 9 

5/8" and 6 1/4". 

Select the Circle Tool, set Blank Pattern and draw a circle around the word `Transparent'. Scroll to the left so 

the right edge is about the 7 1/2" mark on the ruler. Change the Circle Attributes to be Opaque and draw a circle 

from 9 1/4" and 4 1/4" to 10 1/8" and 5 1/4". Place the word `Opaque' inside this circle and our lesson this time 

is done. 

These circles provide good examples of how to overlay various objects. Use your imagination and have fun 

creating your geoPublish documents. 

Next time we will see how easy and quick it is to make a poster in geoPublish. 

Until then, enGEOy your Commodore!  
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Importing geoPub18 - Drawing Tools Part 2 
 

Open TutorialPart3 and Goto Page 35. Choose `next page' under the Options menu. Click OK to create the new 

page. 

 

Import the text 

 

Change to Page Layout Mode, use the Library option under the file menu to import the Lf2ColLrg layout. 

Select the Text Placement Tool and import geoPub18 into the left and then right text regions. Press the SHOW 

button to ripple the text. 

 

Choose `next page' under the Options menu. Click OK to create the new page. Use the Library option under the 

file menu to import the Rt2ColSml layout. Select the Text Placement Tool and import geoPub18 into the left 

and then right text regions. Press the SHOW button to ripple the text. 

 

Special Text and Graphics 

 

On Page 37 change to Page Graphics Mode. Select the Text Placement Tool and then open the attributes. Set 

LW_Cal, 24 points, bold, centered and press OK. Turn SNAP on. Place your Pointer at the top left corner 

guidelines and click.  Enter "Drawing Tools Part 2" in the dialog box that opens up and Click OK to set the text. 

 

Turn SNAP off. Select the Pointer tool, Click on the text and use the Resize button to align the text box with the 

right guideline and drag it down about 1/2 an inch at the same time. Click to set the text and then use the MOVE 

button to move the text box down and center it in the region. 

 

Select the Line tool and open the Attributes. Set Square, narrowest line width, transparent and Solid Black. 

Press OK. Turn Ratchet on (C= R) and then set the Ratchet under the option menu to 1/2 inch ratcheting. Draw 

the line down the left edge of the page to the 10" mark. Now draw our shaded box around the headline from 1V 

to 2Z.  

 

Change to Zoom View and move the Zoom Box to the lower Right corner of the page. Select the Text Tool and 

open the attributes.  Set the font to LW_Shattuck, 12 points, left, plain style. Press OK and place an uppercase 

`X' to the right of the tag line ("Until then, enGEOy...") and close to the right guideline. Select the Pointer Tool, 

Click on the freshly created Splat symbol and use the resize button to expand the bounding box. 

 

Goto Page 36 and change to Page Graphics Mode. Select the Text Placement Tool and then open the attributes. 

Set LW_Cal, 30 points, bold, centered and press OK. Turn SNAP on. Place your Pointer at the top left corner 

guidelines and click.  Enter "Drawing Tools Part 2" in the dialog box that opens up and Click OK to set the text. 

 

Turn SNAP off. Select the Pointer tool, Click on the text and use the Resize button to align the text box with the 

right guideline and drag it down about 1/2 an inch at the same time. Click to set the text and then use the MOVE 

button to move the text box down and center it in the region. 

 

Turn Ratchet on (C= R). Draw the line down the left edge of the page to the 10" mark. Now draw our line under 

the headline from 3A to 3E.  

 

That is it we're done. 
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GeoPublish Tutorial Part 19 – A Quick Poster 

In this installment of the geoPublish Tutorial we are going to see what can be done using just the Page Graphics 

Mode of geoPublish. 

Once again, our process starts with a planning session. For this Tutorial we are going to stick with materials that 

everyone has on hand. The graphics we will use come from the geoPublish Manual Addendum and Photo 

Albums that were provided with the 2-disk geoPublish version. Looking over these graphics I have picked out 3 

images to use in our Poster. 

From the `Just for Fun' album we will use the `Cityscape' and `Hour Glass' pictures. The third graphic will be 

the `Balloon' from the `Work & Play' Album. We'll use these images to create a flyer for our Hot Air Balloon 

company which will be offering special discounts for rides over the city during the annual 2-week summer 

festival. 

We are going to have a large headline that says "Hot Air Balloon Rides". We'll overlay a box and some text to 

set our company apart from the rest of the Balloon Companies. Below our headline we'll place the picture of the 

balloon floating over the city. Some text will go alongside these images outlining the special deals. Below all of 

this we will use the Hour Glass to remind people that these are limited time discounts. Finally, we'll include our 

business address, phone number and regular prices.  

Before continuing on we need to get our graphics ready. The easiest thing to do is to use Rick Coleman's Photo 

Mover to copy the graphics from the two Albums into our Project Album. With our graphics in the proper 

Album it is time to fire up geoPaint and color the graphics black with a white background. This will make them 

print off better as we have previously discussed. Since we don't need a geoWrite file we are now ready to make 

our poster. 

In geoPublish open the `Poster' document you were told to create in the format19 geoWrite file. Select the Text 

Tool. Set the Attributes (LW_Roma font, 95 pointsize, Black, Center, Across and Bold). Click your pointer at 

the 1/2" mark on the Left Guideline and enter `Hot Air Balloon Rides' for the text. Press OK, line the text box 

up with the right guideline and then expand the text box down to allow for print expansion. 

Select the Zoom option under the disp menu and set the Zoom box in the middle of the page over the words Hot 

Air. Select the Rectangle Tool (Square, no Frame Width, Opaque and Blank Pattern). Click OK and then draw 

the box across the middle of the letters "ot Ai". We want it to be about 3/8ths of an inch high. Select the Line 

Tool (Square, Narrowest Width, Opaque and Black). Draw a line along the top and bottom edges of the box we 

just drew. Select the Text Tool (LW_Cal, 18 pointsize, Black, Left, Across). Place your pointer near the top left 

corner of our box area and enter `Environmentally Friendly' for the text. After placing the text select the Pointer, 

click on the text, change the Attributes to Center and then re-size the text box to match up with the lines we 

drew. Select the Text Tool (LW_Roma, 9 pointsize, Black, Left, Across and Bold). Place a number `1' to the top 

right of the word `Friendly' to indicate a footnote we'll enter later. Select Preview under the disp menu. 

Select the Line Tool, increase the width by one and draw a line across the page at the 3" mark. 

Now we need to add our first two graphics. Use Photo Manager to copy the Balloon to a Photo Scrap and place 

it with the Graphic Placement Tool at the 3 1/4" and 1 1/4" location. Select the Balloon, open the Attributes, set 

Stretched & Scaled to fit and drag the bottom corner down to the 5 3/4" and 4 1/4" mark. 
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Open Photo Manager again and copy the Cityscape graphic to a Photo Scrap. Place this at 5 5/8" and 3/4", set to 

Stretched & Scaled and drag the bottom corner to 7" and 4 3/4". 

Draw vertical lines down the page at 4 3/4", 5" and 5 1/8" marks. These will be temporary guidelines. 

Select the Text Tool (LW_Roma, 24 Pointsize, Black, Left and Across) and place your pointer at 3 1/4" on the 

line at 5 1/8". Enter the following text: 

Hot Air Balloon Rides over the City! (Return) 

See the Parade like never before. (Return) 

Excellent view of the Fairgrounds. 

Click OK to place this text. Start another text box at 5 1/4" on the line at 5 1/8". Enter these two lines next: 

 

You can see your house from here. (Return) 

Multiple Flight Times per day. 

Place the Zoom box at the 3" and 4" position so you can see our first line of text. Select the Line Tool (Narrow 

width) and draw a dash mark before each sentence using the vertical lines (4 3/4" and 5") to keep the dashes 

lined up and the same length.  

Use the line tool to underline the word `can' in the second last sentence. Select the Pointer and then highlight 

each of our three vertical lines in turn and press the `Delete' icon [gP Page 3-6]. 

Still in Zoom mode select the Text Tool (LW_Roma, 9 pointsize, Black, Left, Across and Bold). Place a 

number `2' to the top right of the word `here' in the second last line and a number `3' to the top right of the word 

`day' in the last line to indicate footnotes we'll enter later. 

Change back to Preview and use Photo Manager to copy the Hour Glass to a Photo Scrap. Place this graphic at 

the 6 3/4" and 6" location, Stretch and Scale it to 8 1/4" and 7 1/2".  

Select the Text Tool (LW_Cal, 10 pointsize, Black, Left and Across). Click to place the text box just below and 

a bit to the left of the Hour Glass and enter the following text: 

Don't let time run out (Return) 

on these special prices!  

After placing the text select the pointer and size the text box to be a little wider than the Hour Glass and then 

change to Center justification. 

Scroll to the left and draw an ellipse from 7" and 2 3/4" to 8 1/4" and 5 1/2". Open the attributes and set Round 

shape, Narrowest Frame width, Transparent and press the Pattern up arrow 7 times from blank to set a lightly 

shaded background. 

Select the Text Tool (LW_Giannini, 14 pointsize, Black, Left Across, Bold) and place the box at 7 1/4" and 3 

1/8". Enter the following text: 

Flights only $65 (Return) 

per person during (Return) 
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Summer Festival Days (Return) 

July 9 - 23, 2005 

Select the Text Box with the Pointer Tool and stretch it across to the 5 1/4" mark. Open the Attributes and set 

`Center' justification. Press OK and then drag the bottom corner down to the 8 1/4" and 5 1/4" mark. Scroll to 

the left edge of the page. 

Place the Text Tool at 7 1/4" and 1" and enter: 

 

Limited (Return) 

Time (Return) 

Offer 

 

Click `Attr', set left justified and press OK. 

Select the text again and change to `Center' justification. Drag the box to 8" and 2". Use the Connected Line [gP 

Page 3-6] to draw a starburst around this text. I used 17 clicks for my starburst. 

Scroll to the bottom of the page and place a text box at 8 3/4" and 5/8". Enter the following text: 

To make a reservation (Return) 

Contact Barb at: (Return) (Return) 

We're Full of Hot Air (Return) 

102 Main St. (Return) 

Springfield 

Press the `Attr' button, change to Left and add Bold. Press OK. Place another text box just below the word 

`Springfield' and enter the phone number: 

1-800-555-1212 

Stretch both text boxes to allow for print expansion.  

Select the Rectangle Tool (Square, Narrow, Opaque and blank pattern). Draw a box around our text. Select the 

box with the Pointer tool and press the Background Tool [gP Page 3-5]. This makes our text visible again. 

Select the Rectangle tool (Black Pattern). Draw another box over our existing one but offset it to the right and 

down by the width of the crosshairs. After drawing this box select it with the Pointer tool and, once again, press 

the Background Tool to move this behind our other box and text. This solid box gives us a nice shadow behind 

our text. 

Scroll to the right of these boxes and open a Text Box at 8 3/4" and 3 1/8". Enter: 

Regular Prices: (Return) (Return) 

Adult - $110 (Return) 

Senior - $75 (Return) 

Youth (13-17) - $65 (Return) 

Child - $50 
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Draw a box (Narrowest width, blank pattern, transparent) around this text and then scroll to the right edge of the 

page. Draw a thin vertical line down the screen at the 5 3/8" mark.We have a couple of text boxes to create to 

hold our footnotes and this will ensure they are lined up properly. 

Select the Text Tool (LW_Cal, 10 pointsize, Black, Left and Across). Place the Text Box at 8 3/4" and 5 3/8" 

and enter the following text: 

1 - Environmentally Friendly balloons (Return) 

are heated by Electric Heaters (Return) 

powered by Fuel Cells. (Return) (Return) 

2 - if you live in Springfield 

Create a second Text box an appropriate distance below the first one and enter: 

3 - All flights last at least 1 hour. Flights are 

scheduled to depart at 7:30 AM, 10:30 AM, 

1:30 PM and 5 PM daily. (Return) 

(weather permitting) 

Stretch both text boxes a little to allow for Print Expansion and then delete the vertical line. Draw a box 

(Square, Narrow, Blank, Transparent) around our text. This time we will use a different technique to create our 

shadow effect. 

Select the Line Tool (Square, two clicks up from Narrowest width and Black). Draw a line down the right edge 

of the box and a line across the bottom of the box to create the same shadow effect we previously made with the 

solid box. This can take a bit of practice to get the lines just the right distance from the edge of the box (about 2 

pixels with this line width) and to get the two ends to line up properly. 

Change to Preview and select the Rectangle Tool (Round, 2 clicks up from Narrow, transparent, blank). Draw a 

border around the entire page and our Poster is finished. Print it off, post it around town and tell Barb to get 

ready for a lot of phone calls. 

A couple of tips 

You may have noticed that for some of the text I forced new lines (Return). The Text Tool will wrap text if it is 

too long for the text box but, until you get the box sized, this can work against you by stretching the text all the 

way across the page. By entering the text on separate lines you save some effort in re-sizing text boxes. 

Once you have the entire page created you need to do some print tests. You may find when you print the page 

off the first time that you haven't re-sized some of your text boxes properly, that some lines aren't the right 

thickness or positioned quite right or that some of the Opaque items cover up things you don't want them to. 

Always allow time to make corrections after Laser Printing a new project the first time as PostScript Laser 

output isn't exactly `What You See Is What You Get' (WYSIWYG). 

Next time we are going to start working on our Title Page section and then we'll be ready for printing. Which is 

really what all the rest of this is geared towards. 

Until then, enGEOy your Commodore! 
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Importing geoPub19 - A Quick Poster 

 
Open TutorialPart3 and Goto Page 37. Choose `next page' under the Options menu. Click OK to create the new 

page. 

 

Import the text 

 

Change to Page Layout Mode, use the Library option under the file menu to import the Lf2ColLrg layout. 

Select the Text Placement Tool and import geoPub19 into the left and then right text regions. Press the SHOW 

button to ripple the text. 

 

Choose `next page' under the Options menu. Click OK to create the new page. Use the Library option under the 

file menu to import the Rt2ColSml layout. Select the Text Placement Tool and import geoPub19 into the left 

and then right text regions. Press the SHOW button to ripple the text. 

 

Choose `next page' under the Options menu. Click OK to create the new page. Use the Library option under the 

file menu to import the Lf2ColSml layout. Select the Text Placement Tool and import geoPub19 into the left 

and then right text regions. Press the SHOW button to ripple the text. 

 

Special Text and Graphics 

 

On Page 40 change to Page Graphics Mode. Select the Text Placement Tool and then open the attributes. Set 

LW_Cal, 24 points, bold, centered and press OK.  

 

Turn SNAP on. Place your Pointer at the top left corner guidelines and click.  Enter "Quick Poster" in the dialog 

box that opens & Click OK to set the text. 

 

Turn SNAP off. Select the Pointer tool, Click on the text and use the Resize button to align the text box with the 

right guideline and drag it down about 1/2 an inch at the same time. Click to set the text and then use the MOVE 

button to move the text box down and center it in the region. 

 

Select the Line tool and open the Attributes. Set Square, narrowest line width, transparent and Solid Black. 

Press OK. Turn Ratchet on (C= R) and then set the Ratchet under the option menu to 1/2 inch ratcheting. Draw 

the line down the left edge of the page to the 10" mark. Now draw our shaded box around the headline from 1A 

to 2E.  

 

Change to Zoom View and move the Zoom Box to the lower Right corner of the page. Select the Text Tool and 

open the attributes.  Set the font to LW_Shattuck, 12 points, left, plain style. Press OK and place an uppercase 

`X' to the right of the tag line ("Until then, enGEOy...") and close to the right guideline. Select the Pointer Tool, 

Click on the freshly created Splat symbol and use the resize button to expand the bounding box. 

 

Goto Page 39, select the Text Placement Tool and then open the attributes. Set LW_Cal, 24 points, bold, 

centered and press OK. Turn SNAP on. Place your Pointer at the top left corner guidelines and click.  Enter 

"Quick Poster" in the dialog box that opens up and Click OK to set the text. 

 

Turn SNAP off. Select the Pointer tool, Click on the text and use the Resize button to align the text box with the 

right guideline and drag it down about 1/2 an inch at the same time. Click to set the text and then use the MOVE 

button to move the text box down and center it in the region. 
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Select the Line tool. Turn Ratchet on (C= R). Draw the line down the left edge of the page to the 10" mark. 

Now draw our shaded box around the headline from 1V to 2Z.  

On Page 38 select the Text Placement Tool and then open the attributes. Set LW_Cal, 30 points, bold, centered 

and press OK. Turn SNAP on. Place your Pointer at the top left corner guidelines and click.  Enter "A Quick 

Poster" in the dialog box that opens up and Click OK to set the text. 

 

Turn SNAP off. Select the Pointer tool, Click on the text and use the Resize button to align the text box with the 

right guideline and drag it down about 1/2 an inch at the same time. Click to set the text and then use the MOVE 

button to move the text box down and center it in the region. 

 

Turn Ratchet on (C= R). Draw the line down the left edge of the page to the 10" mark. Now draw our line under 

the headline from 3A to 3E.  

 

That takes care of importing the article. Print off Pages 38 - 40 of TutorialPart3 using your regular GEOS 

printer driver. You will need these pages close at hand to complete the rest of this installment. 

 

Close TutorialPart3 in geoPublish. Press the `Create' button and enter the name `poster' for the new file. The 

new file opens in Page Graphics Mode so you can just follow along through Pages 38 - 40 that you just printed 

off to create the poster. 

 

The big reason why we created a separate geoPublish file for making our poster is that we want to work on a 

clean page. If we just created the poster on Page 41 of TutorialPart3 we would have the bottom line, footer and 

page number on the page from Master Pages Mode. 

 

That is it we're done. 
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GeoPublish Tutorial Part 20 – First Impressions 

As you likely learned long ago, first impressions are very important. In this installment we are going to create 

the front section of the Tutorial, including our Title Page, which has to look good, convey the topic and offer 

the reader a reason to look inside. 

This means we must be getting close to the end of this project, right? Not so fast. By my figuring we have about 

4 more sessions to go. This is installment number 20 so you must have a good idea where we are going to begin. 

The Planning Stage 

That's right. Before we start creating our Title Page with geoPublish (gP) we need to plan what we are going to 

do. 

The Title Page steals a layout design I saw in a book. We'll have the gP Icon atop a shaded box on the right 

edge of the page. The Title, a short caption and author name will overlap this box. 

The rest of the front section will contain a Short Title page, an Index Page, a few blank pages and our 

Introduction article. We are not going to use pages 2, 3, 4, 6, 8 or 10 in this gP file. If we printed on Page 2 the 

text would be visible through our Title page. We will leave a blank sheet behind the Title Page and the Short 

Title will go on Page 5. 

Since one of our objectives is to use all the features of gP while creating this Tutorial we need to place some 

Special Text either Up or Down the page. I'm choosing to go with writing "GeoPublish Tutorial" Up the left 

side of the Index Page.  

We are also going to add the gP and gP Document Icons here and the Article Index will be printed on the right 

side. Between the large text and the Index we will repeat the short caption describing the Tutorial. 

The Intro article will go on Page 9 (we'll label this page `vii' - the Cover and inside page don't get numbered). 

We'll leave Page 10 blank so as not to distract from the start of our first article. You may wonder why we will 

leave the pages blank. If you are printing to a double-sided printer it is easier to send the document as a whole 

rather than having to break it up or disable the double-sided printing. There are also advantages when using 

PostPrint as you will see soon. But I'm getting ahead of things here with all of this printing talk. 

A Picture is worth... 

I said we were going to add a couple of Icons so now is the time to get them. There are a number of GEOS 

programs to grab Icons or portions of the screen (even a good BASIC one). For our project we'll use a simple 

program called IconGetdbl by Robert J.G. Norton (8/22/88 1:10 AM). 

This program, which copies Icons to Photo Scraps, has a few nifty things going for it. It runs fine under GEOS 

and under Wheels. It uses the Icon of the program you copied as the icon for the Photo Scrap and it doubles the 

size of the Icon compared to the captures made by IconGet. One minor drawback is that you have to type in the 

name of the program whose Icon you wish to capture. 

Anyhow, with IconGetdbl we will capture the Icon for TutorialPart1 as well as the Icon for gP. After you 

capture one Icon run Photo Manager and add the Icon to the Album you are using or it will get over-written by 

the next capture. 
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After you have grabbed the Icons load them into geoPaint and change the colors to Black Paint on a White 

Canvas. Copy the Icon back to a Scrap and add it back to the album. Then surround the Icon again and press the 

Rotate button 3 times. This will turn the Icon the way our Index Page text will go (up the page, top to the left). 

Save the new versions back to the Album so we can easily get them into geoPublish.  

The easy part 

Open gP and Create a document – TutorialCover. When the document opens, change to Master Pages mode and 

choose `doc setup' under the file menu. 

We have already seen how adjusting the page number lets us continue on through multiple gP documents and 

maintain a consistent numbering pattern. You can enter a starting page number as high as 240 which allows for 

15 documents chained together and a maximum of 255 pages. 

We'll leave the starting page number at `1' even though we already have a Page #1 in the Tutorial. We can do 

this because the Page Number only matters if you actually use the PAGE special text in Master Pages or Page 

Graphics modes - and we aren't going to do that in this document. We also want 2 Master Pages and the Right 

Page will be the first one. Press OK. 

Our page layout for this section is going to be simple so we'll just create it fresh instead of trying to modify a 

saved layout. Select the Pointer and draw vertical guidelines at the 1", 4 1/2", 6 1/2" and 8" marks. Draw 

horizontal guidelines at the 1/2", 2 1/4", 9 3/4" and 10 1/4" marks.  

Since we aren't using the Left Pages that is all we need to do in Master Pages mode. In the interest of 

completeness we will look at the changes that would be necessary to have complementary Left Pages. 

Our left page would just shift left 1/2 an inch.The easiest way to create this is to press the Copy button in the 

middle of the page. Pick up each of the vertical guidelines and move them to the 1/2", 4", 6" and 7 1/2" marks. 

Save these two pages to a Master Pages Library if you want. 

The Cover 

Change to Page Graphics Mode. Turn on Snap. In Preview select the Text Tool and open the Attributes. Set 

LW_Cal, 24, Black, Right, Across and Bold and create a text box at 4 3/4" and 1". Enter "A Guide to 

getting(space)(Return)the most out of(space)(Return)this complex software(space)". Click OK, click the text 

with the Pointer, line the right edge up with the 8" guideline and expand the box down a bit. 

Leave the Text Attributes alone, create another text box at 7 1/2" and 1". Type "by R. Bruce Thomas(space)". 

Click OK, click the text with the Pointer tool, line the right edge up with the 8" guideline and expand the box 

down a bit.  

Select the Text Tool (LW_Roma, 60, Black, Right, Across, Bold), place the crosshairs at 3" and 1" and enter 

"GeoPublish(space)(Return)Tutorial(space)". Click OK, click the text with the Pointer tool, line the right edge 

up with the 8" guideline and expand the box down a bit. 

In the text we just entered we left `spaces' at the end of the lines. This ensures that the text does not bump 

against the side of the shaded box we are going to add next. 
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Select the Rectangle Tool (Square, No Frame, Transparent, 5 clicks up from blank) and draw a rectangle from 2 

1/4" and 6 1/2" to 10 1/4" and 8". Copy the gP Icon (not the rotated one) to a Photo Scrap, change to Zoom and 

place the Icon at 1/2" and 6 1/2". Stretch & Scale it down to 2" and 8". 

Select the Line Tool (Square, Narrow, Transparent, Black) and draw a line across the page at the 4 1/2 " mark 

from 1" to 8". 

The rest 

Create 4 new pages so we are working on Page 5. In Preview set the Text Pointer (LW_Roma, 60, Black, 

Center, Across, Bold) at 3" and 1" and enter "GeoPublish(Return)Tutorial". Click OK, click the text with the 

Pointer, line the right edge up with the 8" guideline and expand the box down a bit. 

Select the Text Tool (LW_Cal, 18, Black, Center, Across) and create a text box at 9" and 1". Enter "Files 

available at http://members.shaw.ca/cue64". Click OK, click the text with the Pointer, line the right edge up 

with the 8" guideline and expand the box down a bit. 

Turn Snap off. Create another text box at 9 1/2" and 1" and enter "geoPublish discussions on the COPS mailing 

list(Return)http://cbm.videocam.net.au/mailman/listinfo/cops". Click OK, click the text with the Pointer tool, 

line the right edge up with the 8" guideline and expand the box down a bit. 

Create 2 new pages so we are working on Page 7. Change to Page Layout mode, turn Snap on, select the Open 

Region Tool and draw a text region using the 4 1/2" and 8" vertical guidelines and the top and bottom 

guidelines. Select the Pointer Tool and click on the text region you just made. Select the Text Placement Tool, 

choose the Index article and ripple the text after the import. If you open the Index in Editor Mode you will see 

that it uses Decimal Tabs for two of the tab stops. 

Change to Page Graphics Mode. Select the Text Tool (LW_Roma, 120, Black, Center, Up and Bold), place the 

Crosshairs at the 9 3/4" and 1" mark and click to place the text. Type "GeoPublish(Return)Tutorial" as the text 

and press OK. 

Select the Pointer and then click on the text we just entered. You'll see that the text goes right to the top of the 

page. We want it centered between our top and bottom guidelines so click on the Move button and Snap will 

force the top corner to jump to the 1/2" and 1" mark. Click to place the text. Now click on the Size button and 

move the bottom corner down to the 10 1/4" and 4" mark and click to place it. This will cause the text to center 

the way we want and also allow expansion room for printing. 

We could have done this without the 9 3/4" guideline but I wanted to show a different method for text 

placement. If we had to move the text down more than the 1/4" we did this time it is possible that we would 

have to use the Size button first and make the text box smaller before we could re-position it. It just makes sense 

to make it smaller first, get it positioned, and then line up the bottom corner. 

Select the Text Tool (LW_Roma, 24, Black, Center, Up), place the crosshairs at 9 3/4" and 4 1/8" and enter "A 

Guide to getting the most out of this complex software." Press OK and then select the Pointer. Click the text and 

use the Move button to line it up with the 1/2" top guideline. Use the Size button to place the corner at the 10 

1/4" & 4 3/4" mark. 

Select the Rectangle Tool (Square, Narrowest width, Transparent, Click the up arrow 7 times from the blank 

pattern). Draw a box from 1/2" and 4" down to the 10 1/4" and 4 1/2" mark. 
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Copy the rotated gP Document Icon (NEWS) to a Photo Scrap and Paste it onto the page at about 5/8" and 2 

1/2" while in Zoom view. Set Attributes for Stretch and Scale. Click on the Icon and expand it to be 1" across 

the page and 1 1/4" down the page. Use some temporary lines to help position it if you want. Move to the 

bottom of the page so you can see the `T' in Tutorial. Copy the rotated gP Icon to a Photo Scrap and paste it on 

the page at 2 1/4" and 8 5/8". Stretch it down and over to about 3 3/4" and 9 7/8". Select the Text Tool (LW_ 

Shattuck, 12, Black, Left, Across), place this at 10" and 7 1/2" and enter "X" for our end of article Splat. 

Create 2 new pages so we are working on Page 9. We are still in Zoom view in the bottom right corner of the 

page. Select the Text Tool (LW_ Shattuck, 12, Black, Left, Across), place this at 9 3/4" and 7 1/2" and enter 

"X" for our end of article Splat. 

Place another text box (LW_Zapf, 14, Black, Left, Across) at 10 1/4" and 7 3/4" and enter `vii'. Expand both of 

these text boxes. Change to Page Layout mode. Draw a text region from 1V to 4 Z. Select the Text Tool and 

pour the gPIntro article into this space. Create a new page and our document is complete. 

New Web Page 

The ISP where the Tutorial has lived has gone under so we need to make some changes. Open TutorialPart1 and 

change to Master Pages mode. Goto Page 1, Zoom to bottom of page and change the footer to "files available at 

http://members.shaw.ca/cue64". Adjust the size down a bit to allow for print expansion. 

From the file menu choose `library', click on our `RightMaster' entry and press the Save button. Close 

TutorialPart1 and open each of the other Tutorial files (except for TutorialCover), goto an odd numbered page, 

change to Master Pages mode, open the library function, select the RightMaster library and press the Open 

button. Click OK on the warning box that pops up. This updates the footers in the other Tutorial files. 

I have updated the GPIntro file and geoPub4 to reflect the web site change so download the new versions of 

these files to keep your Tutorial up to date. 

Next time we are going to create our Appendices. 

Until then, enGEOy your Commodore!  
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Importing geoPub20 - First Impressions 
 

 

Start geoPublish and Create a new file. Call it TutorialPart4. Change to Master Pages Mode and then choose the 

`doc setup' item on the `file' menu. We want the starting page to be Number 42, 2 Master Pages and the first one 

will be a Left Page. Press OK. 

 

Under the `file' menu choose `library', select the LeftMaster library and press the Open button. Change to the 

Right Page and use the `library' option to Open the RightMaster layout. 

 

Import the text 

 

Change to Page Layout Mode, use the Library option under the file menu to import the Lf2ColLrg layout. 

Select the Text Placement Tool and import geoPub20 into the left and then right text regions. Press the SHOW 

button to ripple the text. 

 

Choose `next page' under the Options menu. Click OK to create the new page. Use the Library option under the 

file menu to import the Rt2ColSml layout. Select the Text Placement Tool and import geoPub20 into the left 

and then right text regions. Press the SHOW button to ripple the text. 

 

Choose `next page' under the Options menu. Click OK to create the new page. Use the Library option under the 

file menu to import the Lf2ColSml layout. Select the Text Placement Tool and import geoPub20 into the left 

and then right text regions. Press the SHOW button to ripple the text. 

 

Special Text and Graphics 

 

On Page 44 change to Page Graphics Mode. Select the Text Placement Tool and then open the attributes. Set 

LW_Cal, 24 points, bold, centered and press OK.  

 

Turn SNAP on. Place your Pointer at the top left corner guidelines and click.  Enter "First Impressions" in the 

dialog box that opens & then Click OK to set the text. 

 

Turn SNAP off. Select the Pointer tool, Click on the text and use the Resize button to align the text box with the 

right guideline and drag it down about 1/2 an inch at the same time. Click to set the text and then use the MOVE 

button to move the text box down and center it in the region. 

 

Select the Line tool and open the Attributes. Set Square, narrowest line width, transparent and Solid Black. 

Press OK. Turn Ratchet on (C= R) and then verify that Ratchet under the option menu is set to 1/2 inch 

ratcheting. Draw the line down the left edge of the page to the 10" mark. Now draw our shaded box (Square, 

Narrowest width, 7 clicks up from blank) around the headline from 1A to 2E.  

 

ge to Zoom View and move the Zoom Box to the lower Right corner of the page. Select the Text Tool and open 

the attributes.  Set the font to LW_Shattuck, 12 points, left, plain style. Press OK and place an uppercase `X' to 

the right of the tag line ("Until then, enGEOy...") and close to the right guideline. Select the Pointer Tool, Click 

on the freshly created Splat symbol and use the resize button to expand the bounding box. 

 

Goto Page 43, select the Text Placement Tool and then open the attributes. Set LW_Cal, 24 points, bold, 

centered and press OK. Turn  
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SNAP on. Place your Pointer at the top left corner guidelines and click.  Enter "First Impressions" in the dialog 

box that opens up and Click OK to set the text. 

 

Turn SNAP off. Select the Pointer tool, Click on the text and use the Resize button to align the text box with the 

right guideline and drag it down about 1/2 an inch at the same time. Click to set the text and then use the MOVE 

button to move the text box down and center it in the region. 

 

Select the Line tool. Turn Ratchet on (C= R). Draw the line down the left edge of the page to the 10" mark. 

Now draw our shaded box around the headline from 1V to 2Z.  

 

On Page 42 select the Text Placement Tool and then open the attributes. Set LW_Cal, 30 points, bold, centered 

and press OK.  

 

Turn SNAP on. Place your Pointer at the top left corner guidelines and click.  Enter "First Impressions" in the 

dialog box that opens up and Click OK to set the text. 

 

Turn SNAP off. Select the Pointer tool, Click on the text and use the Resize button to align the text box with the 

right guideline and drag it down about 1/2 an inch at the same time. Click to set the text and then use the MOVE 

button to move the text box down and center it in the region. 

 

Turn Ratchet on (C= R). Draw the line down the left edge of the page to the 10" mark. Now draw our line under 

the headline from 3A to 3E.  

 

That is it we're done. 

 

Make sure that you have downloaded the updated Photo Album so that you can follow along with installment 

20 and create the front section of the Tutorial. 
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GeoPublish Tutorial Part 21 – Creating Appendices 

In this installment we are going to start working on the end of the Tutorial. Appendix A and Appendix B will 

hold our article formatting instructions and thumbnail pages respectively. We will add to these as the remaining 

articles get written. Appendix C will hold our Style Sheet. 

More designing 

Each Appendix will have a section title page featuring reversed text and its own index listing the contents it 

holds. We will also create custom Master Page layouts for Appendix A to spice up our layout articles while 

reducing the work we have to do on each page. Since the thumbnail pages get created with geoPubLaser or 

PostPrint we will simply insert the printed pages directly into the product before binding. 

It is not customary to put page numbers on appendix title pages but the appendix pages themselves get 

numbered. In order to do this the title pages will get added to our Poster file rather than creating another 

geoPublish document. 

Start geoPublish and Open the Poster file. Change to Master Pages Mode and Open the RightMaster Library 

file. Change to Zoom View and place the Zoom box at the bottom right corner of the page. With the Pointer 

Tool click on the word PAGE and then click on the scissors. Cut the Bottom line and the Footer Text as well. 

Change to Page Graphics Mode and turn Ratchet on. Create 2 new pages. Select the Rectangle Tool (Square, 

Narrowest Frame, Opaque, Black) and draw a rectangle from 2 1/2" and 2" to 4" and 7". Turn Ratchet off and 

select the Text Tool (LW_Roma, 60, Blank, Center, Across, Bold). Place the crosshairs at 2 7/8" and 2" and 

enter "Appendix A" for the text. Select the text with the Pointer and re-size the text box to the width of the black 

box and expand it down a bit. Redraw the page. Turn Ratchet on and draw a box (Square, No Frame, 

Transparent, 7 clicks up from blank) from 5" and 7" to 10" and 8". 

Change to Page Layout mode. Create a text region from 5"X to 10"Z and import AppIndexA. Create 2 new 

pages and we'll create the Appendix B title page on page 5. Create a text region from 5"X to 10"Z and import 

AppIndexB. 

Change to Page Graphics Mode, select the Rectangle Tool and draw a box (Square, No Frame, Transparent, 7 

clicks up from blank) from 5" and 7" to 10" and 8". Draw another rectangle (Square, Narrow Frame, Opaque, 

Black) from 2 1/2" and 2" to 4" and 7". Turn Ratchet off, select the Text Tool (LW_Roma, 60, White, Center, 

Across, Bold), place the crosshairs at 2 7/8" and 2" and enter "Appendix B" for the text. Select the text with the 

Pointer and re-size the text box to the width of the black box and expand it down a bit. 

Create 2 more new pages so you are on Page 7. Repeat the preceding steps except import the AppIndexC file 

and enter "Appendix C" as the text. Create 2 new pages and change to Page Layout Mode. 

On page 9 create a text region from Guideline 1 and 1 1/4" to 4Z. Import the PubStyle article that accom- 

panied article 7 as a download. Change to Page Graphics Mode and place the number 91 (LW_Zapf, 14 point) 

at the 10 1/4" and 7 3/4" mark. Create another new page and close the Poster file. 

New Master Page 

Create a new file and call it AppendixA. Change to Master Pages Mode and open the doc setup. We want 

Starting Page # 57, 2 Master Pages with the first one being a Right Page. Click OK and then open the Library. 

Open the RightMaster layout. Add a horizontal guideline at 2". 



87 
 

Use the Line Tool (Square, Narrow, Black) to draw two lines forming a crosshair at 3/4" and 2". Select the Text 

Tool (LW_Cal, 60, 5 clicks up from blank, Left, Across, Bold) and place the word "appendix" with your mouse 

crosshair on the two lines we drew. Stretch the box down and to the right a bit. Create another text box offset 3 

pixels down and 3 pixels to the right of our crosshairs. This time enter "appendix" but change the pattern by 

clicking twice on the down arrow. Stretch the box down and to the right a bit. Create a third text box this time 

offset by 6 pixels down and 6 pixels to the right of our crosshairs, enter "appendix" as the text and change the 

pattern to solid black. Stretch the box down and to the right a bit. These three overlaid words give an interesting 

3-D look to the title. Delete our two crosshair lines. 

Create a new Text Box (LW_Roma, 140, 1 click up from Black, Left, Across, Bold) at 1/2" and 3" and enter 

"A". Stretch the box down and to the right a bit, press the Background Tool and then Redraw the page. 

Open the Library and save this Master Page layout as AppendixRt. Use the Photo Manager to copy our regular 

upright geoPublish Icon to a Photo Scrap. Use the Bitmap Placement Tool to Stretch and Scale the Icon from 

1/2" and 6" to 2" and 8". We have to do this after saving since Master Page Layouts can't be saved if they 

contain a bitmap.  

Press the Left button and Open the LeftMaster layout from the Library file. Add the new horizontal guideline at 

the 2" mark. 

Use the Line Tool (Square, Narrow, Black) to draw two lines forming a crosshair at 3/4" and 3". Select the Text 

Tool (LW_Cal, 60, 5 clicks up from blank, Left, Across, Bold) and place the word "appendix" with your mouse 

crosshair on the two lines we drew. Stretch the box down and to the right a bit. Create another text box offset 3 

pixels down and 3 pixels to the right of our crosshairs. This time enter "appendix" but change the pattern by 

clicking twice on the down arrow. Stretch the box down and to the right a bit. Create a third text box this time 

offset by 6 pixels down and 6 pixels to the right of our crosshairs, enter "appendix" as the text and change the 

pattern to solid black. Stretch the box down and to the right a bit. Delete our two crosshair lines. 

Select the Text Tool (LW_Roma, 140, Black, Left, Across, Bold) at 1/2" and 4" and enter "A". Stretch the box 

down and to the right a bit, press the Background Tool and then Redraw the page. 

Open the Library and Save this Master Page layout as AppendixLf. Use the Photo Manager to copy our regular 

upright geoPublish Document Icon to a Photo Scrap. Use the Bitmap Placement Tool to Stretch and Scale the 

Icon from 1/2" and 1/2" to 2" and 2 1/2". 

Change to Page Layout Mode. Choose Set Gutters under the Options menu and set the Left and Right values to 

10 while leaving the Top and Bottom values at 5. Turn Snap on and create 2 text regions (2"V to 4X; 2"X to 

4Z). Save this layout in the Library as AppendixRt. Select the Text Placement Tool, choose format8 and then 

click in the left and then right text regions. Ripple (SHOW) the text. 

Create a new page and then create two text regions (2"A to 4C; 2"C to 4E). Save this layout to the library as 

AppendixLf. Import format9 to the left column. 

Create a new page and then open the AppendixRt Library layout. Import format10 into the left and then right 

text regions. On the next new page open the AppendixLf Library layout and then import format11 into the left 

region and format12 into the right region. 

And that is the method we will use to import the rest of our format articles into the AppendixA gP document. 

Create a new page, open the appropriate layout library and then import the formatting files. After importing the 

articles change to Page Graphics Mode, select the Text Tool (LW_Shattuck, 12 points, left, plain) and place an 
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uppercase `X' to the lower right of the end of each article. We couldn't include the Splat in our Master Pages 

layout as there are already 8 graphics objects and that is the most it can hold. 

Format13 and format14 get their own pages. Format15 uses the left column on Page 63 and format16 uses the 

right column along with both columns on the next page. The rest of the articles (format17, format18, format19, 

format20 and format21) all use both columns on their respective pages. 

From now on the instructions to add the format file to AppendixA will be included in the format file itself for 

each installment. We will use all 16 pages of the gP document for Appendix A. 

Next time we are going to start a 2-part article on printing. There is a lot involved when printing gP files and we 

will see in a later installment that new gP developments require special handling of printing. 

Until next time, enGEOy your Commodore!  
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Importing geoPub21 Creating Appendices 
 

Open TutorialPart4 and `goto page' 44 if you aren't already on it. Change to Page Layout Mode, choose `next 

page' under the Options menu, click OK to create the new page.  

 

Use the Library option under the file menu to Open the Rt2ColLrg layout. Select the Text Placement Tool and 

import geoPub21 into the left and then right text regions. Press the SHOW button to ripple the text. 

 

Choose `next page' under the Options menu. Click 

 

OK to create the new page. Use the Library option under the file menu to Open the Lf2ColSml layout. Select 

the Text Placement Tool and import geoPub21 into the left and then right text regions. Press the SHOW button 

to ripple the text. 

 

Special Text and Graphics 

 

On Page 46 change to Page Graphics Mode. Select the Text Placement Tool (LW_Cal, 24 points, bold, 

centered).  

 

Turn SNAP on. Place your Pointer at the top left corner guidelines and click.  Enter "Creating Appendices" in 

the dialog box that opens & then Click OK to set the text. 

 

Turn SNAP off. Select the Pointer tool, Click on the text and use the Resize button to align the text box with the 

right guideline and drag it down about 1/2 an inch at the same time. Click to set the text and then use the MOVE 

button to move the text box down and center it in the region. 

 

Select the Line tool and open the Attributes. Set Square, narrowest line width, transparent and Solid Black. 

Press OK. Turn Ratchet on (C= R) and then draw the line down the left edge of the page to the 10" mark. Now 

draw our shaded box (Square, Narrowest width, 7 clicks up from blank) around the headline from 1A to 2E.  

 

Change to Zoom View and move the Zoom Box to lower Right corner of the page. Select the Text Tool 

(LW_Shattuck, 12 points, left, plain style) and place an uppercase `X' to the right of the tag line ("Until then, 

enGEOy...") and close to the right guideline. Select the Pointer Tool, Click on the freshly created Splat symbol 

and use the resize button to expand the bounding box. 

 

On Page 45 select the Text Placement Tool (LW_ Cal, 30 points, bold, centered). Turn SNAP on. Place your 

Pointer at the top left corner guidelines and click.  Enter "Creating Appendices" in the dialog box that opens up 

and Click OK to set the text. 

 

Turn SNAP off. Select the Pointer tool, Click on the text and use the Resize button to align the text box with the 

right guideline and drag it down about 1/2 an inch at the same time. Click to set the text and then use the MOVE 

button to move the text box down and center it in the region. 

 

Select the Line tool. Turn Ratchet on (C= R). Draw the line down the left edge of the page to the 10" mark. 

Now draw our line under the headline from 3V to 3Z.  Close TutorialPart4. 

 

Update Appendix file 

 

Open our Appendix file `Goto Page' 68 and create a `new page'.  Open the AppendixRt Library layout and then 

import format21 into the left and then the right regions. Press the SHOW button to ripple the text. 
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Change to Page Graphics Mode and select the Text Tool (LW_Shattuck, 12 points, left, plain) and place an 

uppercase `X' to the lower right of the end of the article. 

 

That is it, we're done for this  article. 
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GeoPublish Tutorial Part 22 – Printing Part 1 

Finally! After 21 installments we are ready to talk about printing. And for once we don't have to do any 

planning. 

The planning part was covered way back at the start. When we decided we were aiming for PostScript (PS) 

Printer output and chose the LaserWriter (LW) fonts we would use we were planning our printing phase of this 

publication. If we weren't planning for PS printing we would have chosen MEGA Fonts and other fonts that 

look better on dot matrix or inkjet printers. And that brings us to our first printing option. 

Since geoPublish (gP) is a GEOS program you can simply select the Print item on the File menu and your gP 

file will print using your regular GEOS printer driver. If you do choose to use this option you are advised to 

make sure you have a multi-strike or interpolating printer driver for your printer. Regular GEOS printer output 

without enhanced printer drivers is well deserving of the bashing it gets from critics of the system. 

When using this standard method to print gP files you will notice a couple of options that aren't present when 

printing a geoWrite file, for instance. The options for High, Draft and NLQ are not present in a gP print Dialog 

Box (DB). What you do have are options for Content, Layout or Master. Generally, you will always want to 

choose the Content option as it prints your entire document or as many pages as you specify in the From 

Page/To Page boxes. The Layout option prints the outlines of the Text Regions you created in Page Layout 

mode and the Master option prints the contents of your Master Pages (if you have two Master Pages as we do 

they will both get printed as long as there is more than one page in the gP file). You can select any or all of the 

three print options. 

The Best Output 

Luckily for us, Berkeley Softworks (BSW) had the foresight to create geoPubLaser (gPL) to send our files to 

PS equipped print devices. With gPL and the proper serial connection from the User Port to a PS equipped 

printer your documents will never look lousy again. And PS Printers print a lot faster than any Dot Matrix 

printer ever could. 

While BSW stated that an RS-232 interface card and modem cable were required to connect to a PS Printer I 

found that a simple null-modem connection worked fine with the modem cable to give me a connection. What 

was also required for this setup was access to the printer configuration settings to make sure it would work. I set 

the NEC Printer I initially used to 9600 baud, PS batch files, RS-232 interface, 8 data bits, 1 stop bit, Parity at 

Mark and Xon/Xoff for flow control. These settings allowed me to choose the 9600 Baud rate in gPL rather 

than the slower 1200 Baud rate setting. 

For a while this direct connect method was our only option for PS printing. It seemed odd that BSW figured 

people running GEOS on a C-64 would have no problem laying out several thousands of dollars to have a PS 

printer sitting beside them. That NEC SilentWriter LC890 I used in 1988 and 1989 had a $6000 price on it! The 

store manager was a User Group member and let me use it whenever I wanted. 

In addition to having the correct interface and settings you also must make sure you have the right software 

versions. You should really only use the two-disk version of gP, dated 10/4/88, and with that you need gPL 

dated 10/25/86. If you still use the buggier 10/8/87 gP then you need gPL dated 3/10/88. If you use the wrong 

versions together the results turn out very messed up. 
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The next progression in our printing journey allowed us to 'print' our gP documents to PS files on disk. These 

could then be transferred to other computer systems that were hooked to PS Printers (like a PC or a Mac at a 

copy shop). In order to do this you need the program called PS.Patch(2.0) by Jim Collette which patches a copy 

of your gPL so it will print the file to either Drive A or B. A few years later Jim created another version 

(PS.Patch(GC) ) that would patch gPL to use a geoCable parallel connection to a PS Printer. 

With the file on a Commodore disk the challenge then became transferring it to a PC disk. Many methods exist 

for this including modem transfers, Big Blue Reader and geoDOS. The process to accomplish this is outside the 

scope of this tutorial. If you aren't sure join the discussions on the COPS mailing list. Make sure you name the 

file in ALL CAPS in GEOS or it won't be readable from Commodore BASIC or non-GEOS programs. 

Smooth Operator 

Just as the gP printer DB is different than the DB for geoWrite you will find that gPL offers a number of new 

options as well. 

One that is fairly self-explanatory is the Copies box. Here you can enter the number of copies of each page of 

your gP file that you want printed. We have discussed the Thumbnail option a few times already. This will print 

all 16 pages of a gP file onto one page with each gP page reduced to 22% of original size. This is great for 

proofing the graphic placement on your copy before final printing. 

An option we have not used so far is Smoothing. This option is available when placing Special Text or Photo 

Scraps. If you choose Smoothing when you place a graphic or special text gP tries to add extra pixels to smooth 

out the jaggies. For the most part I found that a lot of experimentation was required to get just the right size and 

the right setting for smoothing to get good results. As a result I just avoid using this option as the LW fonts 

provide unparalleled output quality when a PS printer is used and graphics can often turn out worse than they 

originally looked. 

Nevertheless, the Smoothing option appears in the gPL print DB. There are 4 options if you click in this box. 

The default is 300 Dots Per Inch (DPI). This means that gPL will tell the PS Printer to draw this item at 300 DPI 

to help smooth out the jaggies. This can take quite a while to process. Your other options are 150 DPI, 75 DPI 

and NONE. My preference is to just not set smoothing on objects in gP and then you don't have to worry about 

this. 

The final new option in the gPL arsenal is the 'Reduce to' box. This is actually mislabelled as it should be called 

'Scaling'. You can enter a value in this box from 1 to 999. A value of 100 will print the document full size. 

Values less than 100 will reduce the document to that percentage of its original size and values greater than 100 

will enlarge the document. 

For example, if you entered a value of 22 in the 'Reduce to' box your gP pages would print out the same size as 

if you chose the Thumbnail option. The one big difference is that each page would print on its own piece of 

paper. If you entered a value of 300 it would cause your document to be printed over 9 pages of paper (3 rows 

of 3 sheets of paper). Crop marks are printed in the corners so you know where to cut the pages to fit them into 

one seamless, and large, entity. 

If you are using a copy of gPL that you have patched with PS.Patch(2.0) you will find a file on your output 

device that contains all the PS Code to generate your gP pages. If you want to learn about PS Programming 

there are many very useful books available. 
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There is also a great resource created specifically for Commodore GEOS users and that is K. Dale 

Sidebottom's Laser Lover's Disk. This disk contains a wealth of information on how to modify the PS code 

created by gPL to add some very neat effects to your gP printer output. Also on the disk are all of the GEOS 

LW fonts including some updated versions with extra point sizes. Anyone who wishes to get the best possible 

printer output from their Commodore GEOS system should buy this disk from Dale. He is on the COPS list if 

you wish to contact him. 

Next time we'll look at more print options with PS.Processor and PostPrint and see why, after learning all about 

it, we no longer need gPL. 

Until then, enGEOy your Commodore!  

  



95 
 

Importing geoPub22 Printing Part 1 
 

Open TutorialPart4 and `goto page' 46 if you aren't already on it. Change to Page Layout Mode, choose `next 

page' under the Options menu, click OK to create the new page. Use the Library option under the file menu to 

Open the Rt2ColLrg layout. Select the Text Placement Tool and import geoPub22 into the left and then right 

text regions. Press the SHOW button to ripple the text. 

 

Choose `next page' under the Options menu. Click OK to create the new page. Use the Library option under the 

file menu to Open the Lf2ColSml layout. Select the Text Placement Tool and import geoPub22 into the left and 

then right text regions. Press the SHOW button to ripple the text. 

 

Special Text and Graphics 

 

On Page 48 change to Page Graphics Mode. Select the Text Placement Tool (LW_Cal, 24 points, bold, 

centered). Turn SNAP on. Place your Pointer at the top left corner guidelines and click.  Enter "Printing Part 1" 

in the dialog box that opens & then Click OK to set the text. 

 

Turn SNAP off. Select the Pointer tool, click on the text and use the Resize button to align the text box with the 

right guideline and drag it down about 1/2 an inch at the same time. Click to set the text and then use the MOVE 

button to move the text box down and center it in the region. 

 

Select the Line tool and open the Attributes. Set Square, narrowest line width, transparent and Solid Black. 

Press OK. Turn Ratchet on (C= R) and then draw the line down the left edge of the page to the 10" mark. Now 

draw our shaded box (Square, Narrowest width, 7 clicks up from blank) around the headline from 1A to 2E.  

 

ge to Zoom View and move the Zoom Box to the lower Right corner of the page. Select the Text Tool 

(LW_Shattuck, 12 points, left, plain style) and place an uppercase `X' to the right of the tag line ("Until then, 

enGEOy...") and close to the right guideline. Select the Pointer Tool, Click on the freshly created Splat symbol 

and use the resize button to expand the bounding box. 

 

On Page 47 select the Text Placement Tool (LW_Cal, 30 points, bold, centered). Turn SNAP on. Place your 

Pointer at the top left corner guidelines and click.  Enter "Printing Part 1" in the dialog box that opens up and 

Click OK to set the text. 

 

Turn SNAP off. Select the Pointer tool, Click on the text and use the Resize button to align the text box with the 

right guideline and drag it down about 1/2 an inch at the same time. Click to set the text and then use the MOVE 

button to move the text box down and center it in the region.  

 

Select the Line tool. Turn Ratchet on (C= R). Draw the line down the left edge of the page to the 10" mark. 

Now draw our line under the headline from 3V to 3Z.  Close TutorialPart4. 

 

Update Appendix file 

 

Open our Appendix file `Goto Page' 69 and create a `new page'.  Open the AppendixLf Library layout and then 

import format22 into the left and then the right regions. Press the SHOW button to ripple the text. 

 

Change to Page Graphics Mode and select the Text Tool (LW_Shattuck, 12 points, left, plain) and place an 

uppercase `X' to the lower right of the end of the article. 

 

That is it, we're done for this  article. 
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GeoPublish Tutorial Part 23 – Printing Part 2 

It is quite amazing to sit here in the year 2005 and look back at 17 years of PostScript (PS) Printer output of my 

GEOS files. The ability to get near-typeset quality output from my Commodore has to be one of the big reasons 

that I still use the venerable computer. It wasn't always easy, though. Many people contributed to the 

development of the process we take for granted these days. 

Randy Winchester was likely the first person to tackle the shortcomings of the original geoPubLaser (gPL) 

that we discussed in the previous installment. His AntiGrav Toolkit series of articles in geoWorld magazine 

detailed methods to get around the limitations of a program that expected a Laser Printer to be directly 

connected to the computer. All of his articles are available on the GEOS page of his web site 

(http://web.mit.edu/randy/www/antigrav) and are still worth reading if you never have for no other reason than 

to appreciate how easy things are today. 

Jeanine Cutler bought an HP Laser and wrote a couple of articles for geoWorld about her adventures with 

GEOS Laser Printing. Jeanine provided lots of advice and assistance to many people in the early years and 

helped a young programmer test a great piece of software we are going to look at this time. 

David B. Ferguson, a gifted programmer who wrote NewTools and other GEOS gems, contributed to PS 

Printing by outlining the steps he took and the things he learned using a PS Laser Printer without owning one in 

The GeoPublish Compendium. 

K. Dale Sidebottom spent vast sums of money to buy PS Laser Printers and also joined the Adobe Developers 

Association to learn more about the intricacies of PS. Dale has also created the Laser Lovers' Disk which 

contains a wealth of information gleaned from his many years of PS printing. Dale was also the driving force 

behind the creation of the second program we are going to look at by yet another extremely brilliant and 

talented GEOS programmer. 

The people I have mentioned above all played important roles in the evolution of PS Printing from our 

Commodores. However, what makes the process so easy today is a direct result of the talents of our two intrepid 

programmers. 

The geoWizard! 

Jim Collette was in his early teens when he created the PS.Patch program we discussed in the previous article. 

Over the next few years he wrote some truly amazing software including geoWizard which lets you halt one 

program, load another one and then return to the same spot in the first program as if nothing had ever happened. 

This was an amazing accomplishment and was extremely useful for many. 

Jim's PS.Patch program provided GEOS users with a very easy way to print their files to disk in preparation for 

transferring to a PC or Mac for PS Printing. Jim next came up with a wonderful program called PS.Processor 

(PS.P). 

Just as its name implies, PS.P takes the PS file you have written to your disk and processes it according to a 

script file you write in geoWrite. The script file makes use of any of the 8 available commands to tell the 

program how to process your PS file. You can write a new file to disk, send the file out over a serial or parallel 

connection to a PS Printer, layout your pages in Portrait or Landscape mode and even print multiple geoPublish 

(gP) pages onto one page coming out of your printer. 

http://web.mit.edu/randy/www/antigrav
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Some of these things may not sound all that exciting but when you see what the program can do it really adds to 

the functionality we have with our Commodores and GEOS. Jeanine Cutler tested the program for Jim since he 

did not have his own PS Printer. She also created a bunch of sample files that come on the disk with PS.P and 

they do a good job of showcasing many of the features. 

PS.P is available on the Collette Utilities Disk which was recently released to the Public Domain. A .D64 image 

is available from the Downloads page of the CUE web site (http://members.shaw.ca/cue64/download.html). 

My review of PS.P in Issue #22 of Commodore World magazine outlined how to design a single business card 

in gP and use PS.P to print 10 copies onto one page. I am not going to repeat that here but will say that if you 

are serious about PS Printing from your Commodore (and if you are still following this gP Tutorial you must 

be) you absolutely have to have PS.P as part of your software library. 

Renaissance Man 

Maurice Randall would have to be considered a true rarity in the world of Commodore computing. He earns 

his living running an auto repair shop and he also raced cars professionally (including NASCAR). Maurice has 

written some of the most amazing GEOS software (after all, there is only 1 FAX program for Commodore's) 

and he took over the line of CMD hardware products a number of years ago. 

I could go on and on about the various programs Maurice has written for GEOS (not to mention the terrific 

Wheels upgrade for the entire system!) but I am going to focus on a program he wrote, at the request of Dale 

Sidebottom, called PostPrint (PP). 

In 1994 Dale was looking for a way to download a PS font to his Laser and asked Maurice to make an addition 

to geoSHELL to accommodate this. The laser COM file was the result. Dale's next request was for a GEOS 

program that would send a geoWrite file containing PS commands to a Laser. Maurice created PostPrint and it 

has continued to evolve since then to become a central command station that you could almost use as a 

replacement DeskTop. 

PostPrint also supercedes PS.Patch and gPL since PP can print files to disk or output directly to PS Printers 

connected with serial or parallel interfaces. PP makes it easy to layout your gP documents onto different sizes of 

paper and PP is required to be able to print JPEGs along with your gP files. 

PostPrint Project 

PostPrint is what we are going to use to print the geoPublish Tutorial with. We are going to create a PP Project 

and tie all of our gP documents together. Let's get started. 

There are 2 versions of PP. The biggest difference between PP2 and PP3 is that PP2 does not require any 

expansion RAM. PP3 will soon require the user to have a SuperCPU and SuperRAM card with some available 

RAM. SuperText is an application that PP3 has for editing large files such as PS ASCII. For really impressive 

results PP lets us add EPS files or JPEG images to our Projects. 

Start PP (either version) and click on the LAYOUT Icon. Press the Create button, type TOTALTUT and press 

RETURN. The default paper style (Letter 8.5 * 11 portrait) is what we want so press the OK button. Choose 

which drive you want this file to be created on and press OK. It is best to create the PP Project on the disk 

where your gP files are located. 

http://members.shaw.ca/cue64/download.html
http://store.cmdrkey.com/agora.cgi?cart_id=2844668.7238*Nd4YD7&p_id=00872&xm=on&ppinc=search3
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The PP Project file opens and you see a page of paper on the screen. From the 'paste' menu choose 'geopublish 

file', click on 'TutorialCover' and then press the Open button. The file will be added to the PP Project and the 

Status Box in the lower left corner will soon show that we are on page 1 of 10. 

Use the 'options' menu to 'goto page' 10. Now, use the 'options' menu to go to the 'next page'. Press the OK 

button to create a new page just the same as in gP. Now add our TutorialPart1 'geopublish file' with the 'paste' 

menu. After you have done that you will see you are on page 11 of 26. 'Goto Page' 26 and then create the 'next 

page'. 

Once you are on Page 27 add our TutorialPart2 file with the 'paste' menu. 'Goto Page' 41, create a 'next page' 

and 'paste' in the TutorialPart3 file. 

'Goto Page' 50 and create the 'next page'. From the 'paste' menu choose the 'geopublish page' option. Select the 

Poster file and press the Open button. We now get presented with a dialog box that lets us paste in any page 

from this gP file. Accept the default of '1' by pressing the RETURN key and our poster will get added to our PP 

Project. We won't paste in TutorialPart4 or AppendixA since they aren't complete yet. 

The file menu gives us three options. The first will take us back to the Project Create/Open dialog box. The 

second will take us directly to the Print dialog box. Click 'exit' to return to the main PP screen. 

PP Print Icon 

This is where the rubber hits the road. The whole point of our little exercise, or any publishing venture for that 

matter, is to get the material onto paper and into the hands of our readers. Maurice has provided an amazing 

array of print options for us. Click your mouse button on the PRINT Icon. 

Here we have 4 options. Starting from the bottom up 'Cancel' is fairly obvious. The 'Config' paper size button 

lets us set regular 8.5" * 11" paper or A4 paper which is commonly used in Britain and Europe. The 'Config' 

output ports button lets us set the address and speed of a SwiftLink or Turbo232 and the speed of RS232 

communications along with PAL/NTSC timing. Click the 'Select' print job button. 

Here we see how PP has evolved from simply printing geoWrite files containing PS commands. We can still do 

that plus send ASCII PS files, geoPaint, geoWrite, gP files and PP Projects. Select PP Project (the default) and 

press OK. Choose our TOTALTUT file in the DB that pops up and press the Open button. 

The next DB provides us with quite a few options, some of which are dependent on others. If you have a color 

PS Printer to use for output click your mouse in the Color box. If you want to print your file to disk and create 

an EPS file click in the EPS box. The PS Level box toggles between 1 and 2. The EOL box toggles between CR 

- LF - CR/LF and sets the end-of-line character which differs depending on which computer you will read the 

file with. 

From the earliest version of gPL there was a problem where the Printer did not get properly reset after each 

print job was sent. This caused subsequent printouts to get a little smaller. Sending a CTRL-D character to the 

printer properly resets it. 

The next boxes show you which pages you will print. The box at the bottom of the screen tells you the name of 

the file, chosen paper format and number of pages in the file. If you don't want to print the entire file enter the 

starting and ending page numbers in the From/To boxes. Use the INST/DEL key to clear the box and press the 
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RETURN key after entering the desired page number. Use the same method to set how many copies of each 

page you wish to print. 

The 'Output source' box is what makes PS.Patch and gPL obsolete. From here we can choose any of 7 output 

methods for our Project. If you have connected your Commodore to a PS Printer choose the appropriate option. 

If you want to print your project from another computer choose the disk file option. 

My PS Printer (connected with a geoCable II) has a duplexer built in so it automatically flips the pages and I get 

double-sided printouts. This comes in very handy for some jobs but especially when printing a PP Project file. If 

you don't have a duplex printer you will find the 'all/odd/even' and 'fwd/rev' boxes very handy. These control 

the way PP sends the file to the printer and make it easy to get double-sided printing. 

One gPL option that is absent from PP is the smoothing function. Maurice felt the same as I did - it never really 

worked all that well so he saved the code space and dropped smoothing from PP. 

Anyhow, the options you choose in PP to print your Project will differ from the options I choose. You should 

now be able to create and print a Project file (or even just the gP files) with little or no trouble. 

If you are printing a gP file there will be an EDIT button in the Print DB. Clicking on this will launch gP so you 

can edit your file. Quitting gP then brings you right back to the Print DB with your chosen options. 

On Pages 35 and 37 the issue of color came up a couple of times. Maurice gave us the ability to add color with 

the B3.6 of PP in 2001. We have 32 patterns that can be used for Special Text or Graphics. The first 9 produce 

varying shades of gray. The remaining 23 produce different colors (see the B3.6 release News in Appendix D 

for a chart). Since it is tough to edit items once a pattern has been applied the best time to add color is now, 

when you are all done and ready to print. Customize your copy of the Tutorial by adding color to some items. 

Next time we will learn some new tricks that gP now has up its sleeves. 

Until then, enGEOy your Commodore!  
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Importing geoPub23Printing Part 2 
 

Open TutorialPart4 and `goto page' 48 if you aren't already on it. Change to Page Layout Mode, choose `next 

page' under the Options menu, click OK to create the new page. Use the Library option under the file menu to 

Open the Rt2ColLrg layout. Select the Text Placement Tool and import geoPub23 into the left and then right 

text regions. Press the SHOW button to ripple the text. 

 

Choose `next page' under the Options menu. Click OK to create the new page. Use the Library option under the 

file menu to Open the Lf2ColSml layout. Select the Text Placement Tool and import geoPub23 into the left and 

then right text regions. Press the SHOW button to ripple the text. 

 

Choose `next page' under the Options menu. Click OK to create the new page. Use the Library option under the 

file menu to Open the Rt2ColSml layout. Select the Text Placement Tool and import geoPub23 into the left and 

then right text regions. Press the SHOW button to ripple the text. 

 

Special Text and Graphics 

 

On Page 51 change to Page Graphics Mode. Change to Zoom View and move the Zoom Box to the lower Right 

corner of the page. Select the Text Tool (LW_Shattuck, 12 points, left, plain style) and place an uppercase `X' 

to the right of the tag line ("Until then, enGEOy...") and close to the right guideline. Select the Pointer Tool, 

click on the freshly created Splat symbol and use the resize button to expand the bounding box. 

 

In Preview turn Ratchet on (C= R), select the Line tool, open Attributes (Square, narrowest line width, 

transparent, Solid Black), press OK  and draw the line down the left edge of the page to the 10" mark. Draw a 

shaded box (Square, Narrowest width, 7 clicks up from blank) from 1V to 2Z. 

  

Select the Text Placement Tool (LW_Cal, 24 points, bold, centered). Turn SNAP on. Place your Pointer at the 

top left corner guidelines and click.  Enter "Printing Part 2" in the dialog box that opens & then Click OK to set 

the text. 

 

Turn SNAP off. Select the Pointer tool, click on the text and use the Resize button to align the text box with the 

right guideline and drag it down about 1/2 an inch at the same time. Click to set the text and then use the MOVE 

button to move the text box down and center it in the region. 

 

Go to the previous page (50), select the Line tool and open the Attributes (Square, narrowest line width, 

transparent and Solid Black). Turn Ratchet on (C= R) and then draw a line down the left edge of the page to the 

10" mark.  

 

Select the Text Placement Tool (LW_Cal, 24 points, bold, centered). Turn SNAP on. Place your Pointer at the 

top left corner guidelines and click.  Enter "Printing Part 2" in the dialog box that opens & then Click OK to set 

the text. 

 

Turn SNAP off. Select the Pointer tool, click on the text and use the Resize button to align the text box with the 

right guideline and drag it down about 1/2 an inch at the same time. Click to set the text and then use the MOVE 

button to move the text box down and center it in the region. Draw a shaded box (Square, Narrowest width, 7 

clicks up from blank) around the headline from 1A to 2E. 

  

On Page 49 select the Text Placement Tool (LW_Cal, 30 points, bold, centered). Turn SNAP on. Place your 

Pointer at the top left corner guidelines and click.  Enter "Printing Part 2" in the dialog box that opens up and 

Click OK to set the text. 
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Turn SNAP off. Select the Pointer tool, Click on the text and use the Resize button to align the text box with the 

right guideline and drag it down about 1/2 an inch at the same time. Click to set the text and then use the MOVE 

button to move the text box down and center it in the region. 

 

Select the Line tool. Turn Ratchet on (C= R). Draw the line down the left edge of the page to the 10" mark. 

Draw our line under the headline from 3V to 3Z.  Close TutorialPart4. 

 

Update Appendix file 

 

Open our Appendix file, `Goto Page' 70 and create a `new page'.  Open the AppendixRt Page Layout Library 

and then import format23 into the left and then the right regions. Press the SHOW button to ripple the text. 

Change to Page Graphics Mode, select the Text Tool (LW_Shattuck, 12 points, left, plain) and place an 

uppercase `X' to the lower right of the end of the article. 

 

That is it, we're done for this article. 
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B3.6 PostPrint News GeoPublish 
 

The biggest change with PostPrint 2 and PostPrint 3 in this B3.6 release is apparent if you're reading this. We 

now have color capability in GeoPublish. How is this possible? Anything that can have a pattern applied to it 

can have a color. For instance, when you want to draw a filled rectangle such as the sidebar background to the 

left, you merely select a pattern and that rectangle will be filled with the color associated with that particular 

pattern. 

In the past (this worked the same with geoPubLaser), the first 9 patterns were used to specify a shade of gray. 

The remaining 23 patterns all produced the same 50 percent shade. Now those 23 patterns are used for 

producing color while the first 9 patterns are still used for grayscales. 

You can also specify a pattern when you enter text in the "graphic mode" of GeoPublish. This allows you to 

make small amounts of text in color just like you see on this page. 

Proofreading a GeoPublish document on the screen might prove to be difficult once you've applied a pattern to 

some text. Some of the bolder patterns won't be hard to read, but the lighter ones will be nearly impossible. So, 

you might want to wait until the document is nearly finished before applying your colors. 

On the next page, you'll find a cheatsheet that will help you pick the colors you want to use in your GeoPublish 

documents. 

 

From within GeoPublish, you can apply the colors and grayscales found on this page to any object that can have 

a pattern applied to it. This includes objects such as lines, filled rectangles, text entered in graphic mode, etc. 

GeoPaint files can also be printed in color now. A GeoPaint file is a BIG bitmap image being sent to the printer, 

so it will take some time to print in color. The newer color lasers are quite fast, though. Some of the faster ones 

can print a full GeoPaint page in about 30 seconds. Even a black and white printer can print a color GeoPaint 

using halftones. But some of them are quite slow due to all the added calculating of the halftones. My Panasonic 

KX-P5400 takes about 30 minutes to print a GeoPaint page. If you turn color off within GeoPaint, then the file 

will still print in black and white and will go much, much faster. The "colorimage" operator is used for printing 

these color images. If your Level 1 printer doesn't support colorimage, the procedure used is smart enough to 

recognize this and will revert to black and white printing. 

For GeoPublish files, color is printed using "setrgbcolor" for Level 1 printers and "setcmykcolor" for Level 2 

printers. 

In this current version, the black and white colors, plus the 14 colors that simulate the 40-column screen colors 

are also used when printing a color GeoPaint file. 
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GeoPublish Tutorial Part 24 – Old Dog, New Tricks 

March 2005 marked the 17th Anniversary of the first monthly club newsletter I produced with geoPublish (gP). 

After many complaints about my gP Dot Matrix printouts, I hooked a C-64 to a PostScript (PS) Laser Printer on 

October 26, 1988 and was amazed at what my Commodore and GEOS could produce. The complaints about the 

newsletter promptly stopped. 

Since that day I have produced countless newsletters, flyers, posters and a book. I have written articles about gP 

and PS Printing for numerous publications and I wrote this Tutorial to help others get the best output from gP. 

So I must know everything there is to know about gP, right? 

Not exactly. 

Feedback 

When I published the Nov. 2003 UCUGA Commodore Digest as a favor to Dale Sidebottom he told me he was 

pleased with my work but there was one thing he wished I would do differently. If you look back at installments 

8 and 9 (pages 17 - 19) in this Tutorial you may see what Dale was upset about. I haven't made the same error 

since. 

Dale didn't like my use of the apostrophe (SHIFTed 7) for the front and back single quote mark. Now, if you 

print your document on a Dot Matrix printer there isn't any difference. But, if we 'really' (wrong) look at a PS 

Printout we'll see that the 'single quotes' (right) are different if created properly. Use the Commodore Key and 

@ to make the front quote. 

I am a big fan of keyboard shortcuts in GEOS as they really help speed up use of the system - even when you 

have a 20 MHz SuperCPU. The shortcut for the front single quote somehow escaped me all these years until 

Dale mentioned it. Have a look at the Keyboard Shortcuts in the manual [gP Pages 6-6 and 6-7] and get used to 

using them; all of them. They will speed up your work and can make your published efforts look better. RUN 

Magazine also published a list of shortcuts in the July/August 1991 issue. 

I Adore my 64 

I Love my PS Printing 

Dale is a Laser Lover as well. So much so that he titled his commercial disk the Laser Lovers' Disk (LLD) and 

offered wisdom, insight, assistance and humor to anyone willing to spend $25. See my review of the LLD (with 

an early version of PostPrint (PP)) in Commodore World Issue #24. 

The LLD is the official source of the PP program written by Maurice Randall. PP is a real workhorse and 

makes it so easy to print your gP files and PP Projects. However, if you want to invest some time with the LLD 

and a couple of good PS books you can learn to create what Dale calls 'Hybrid' Projects. Hybrids are created by 

printing your file to disk and then editing the PS code to add special effects. 

Do you want to print your text in circles? How about adding drop shadows? Do you want to add a pattern to 

your text and have it clipped inside the outline of the letters? Do you want to be able to rotate your graphics in 1 

degree increments? All of these effects plus many more can be used to spice up your gP masterpieces if you 

want to spend a little time learning how. 

http://store.cmdrkey.com/agora.cgi?cart_id=2844668.7238*mW8GQ5&p_id=00874&xm=on&ppinc=search3
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Like Jim Collette's PS.Processor before it I will state here that Dale Sidebottom's Laser Lovers' Disk should be 

part of your GEOS software library if you are serious about your printing projects. 

Continued Evolution 

Todd Elliott has done some amazing programming work under GEOS. He helped create geoZip, wrote a patch 

to create geoWrite128V2.2, patched geoCanvas and geoList to work properly under Wheels, patched Missile 

DefenCe to run with a SuperCPU under Wheels and, finally, he has now added some great new features to gP. 

The first thing you need to know about Todd's geoPublish V1.1 is it requires memory. The reason for this is 

that it loads itself totally into RAM and runs from there. If you have used gP you know it can be sluggish at 

times when it has to load modules from disk. The waiting is all over now. Todd added a nice splash screen that 

is displayed while gP V1.1 loads into RAM. 

The next big improvement is that gP V1.1 now supports 4 drives. This means that you can have gP V1.1 on 

Drive D and load it by double-clicking a file on Drive B. All of your geoWrite files must still be on the same 

disk as your geoPublish document but you aren't limited to using only Drives A and B now. 

If you look at the gP V1.1 'file' menu you will notice that there is no longer a 'print' option. What is currently 

there are Todd's italicized initials - tse. This was done to re-inforce the fact that you must use PP to print any 

document created with gP V1.1. 

A New Library 

Installments 4 and 5 of the geoPublish Tutorial dealt with Master Pages Mode and Page Graphics Mode and 

how to save time by saving your layouts into the Libraries that geoPublish has. 

Installment 16 introduced the Page Graphics Mode Drawing Tools and we laid out our basic graphic elements. 

We had to add our lines and shaded boxes to each and every page in the Tutorial in order to get the consistent 

look that we wanted. But, since we were adding these elements to each page separately, it was hard to make 

sure our Special Text was placed the same way on each page. 

A major time-saving feature that gP V1.1 has is a Library function for Page Graphics Mode. Think how easy 

our Tutorial would be to put together now that this exists. We would place our lines and Title on one Right Page 

and one Left Page and save each of these to a Library. We would place our line, shaded box, splat and Title on 

one Right Page and one Left Page and save each of these to a Library. That is only 4 pages that we have to 

layout manually. You could likely do it with just two saved pages but there comes a point where the amount 

you have to remove would take longer than just saving another page. Add as much as you feel like to your 

saved layouts and then just delete what you don't need. For each of the other 50 or so pages we would just Open 

the appropriate saved Library and edit the Title to fit the current page. You still can't save Photo Scraps in the 

Library but Image Proxies (we'll look at those soon) can be saved; you just have to remember that the Layout 

has an Image Proxy and make sure the EPS/JPEG is on the disk when you Print the page. The rest of the new 

Library is the same as in the other two modes. 

Graphic Enhancements 

The next thing we'll look at are some additions to the graphic handling capabilities of geoPublish V1.1. These 

features are available in Page Graphics and Master Pages modes. 
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If you want to include Photo Scraps you can do that just as easily as in the original gP. Click the Graphic 

Placement tool and, instead of just placing our graphic on the page, a Dialog Box (DB) comes up. If we want to 

paste a Photo Scrap we just press the Open button and it will be placed on the page. 

However, we now have other options in case our graphic is not a Photo Scrap. Just above the CANCEL button 

there is a little Icon. By pressing the Icon the DB changes into a file selection box and we can choose EPS 

(Encapsulated PostScript) files to paste in. Pressing the Open button will paste the selected EPS file into gP. 

There are many programs for many different computers that can create an EPS file. You can even create your 

own right from PP. The beauty of an EPS file is that it can be resized however you want and it doesn't lose any 

clarity because it contains PS commands to draw the object. 

We can also paste JPEG images into our gP files now. Press the little Icon again when it shows EPS and you 

will get a selection box listing the JPEG files on the disk. The Open button is used to paste the image onto the 

page. 

Once you have an EPS or JPEG on the screen, what does it look like? The image takes on the attributes of the 

rectangle or circle that you last used. If you have no frame or pattern set in the Attributes you won't see anything 

and just have to know where you placed the image. Select an image and then open the attributes box. This looks 

like a normal gP Attributes Box. However, instead of Opaque and Transparent options we now have Constrain 

and Scale. These make it easy to manipulate the image in ways we previously couldn't. 

The Attributes box also has an Edit button. If you click the Edit button a DB opens and you will see the name of 

the image. On the left side of the DB it says 'orientation' with a little icon beside it. If you click the icon it 

changes direction. This rotates the image in 90 degree increments just like we did with our gP Icons in geoPaint. 

Another way to get an image onto the page is by using what Todd calls 'Image Proxies'. Draw a rectangle on the 

page, open the rectangle Attributes and choose Edit. This is an ordinary rectangle so it doesn't show an image 

name. If we press the Open button we'll get our Image DB and can choose an image to put into this rectangle. 

We can also do the same for a circle object. Further enhancements to PP are planned to crop the image in the 

shape of the circle. 

Yes, PostPrint does the processing of the images and it handles the options differently. If you choose Constrain 

the Image may get centered in the Graphic Region by PostPrint to maintain the aspect ratio of the image. 

Scaling will cause the image to fill the entire Graphic Region. If you draw a Frame around a Constrained Image 

the Frame will be drawn around the Graphic Region and not directly around the Image. 

As you have seen there are two methods to use to include JPEG and EPS files in your gP documents. We could 

still add the images with PP but you can't really see how they fit onto the page. PostPrint also has a lower limit 

than gP V1.1. In PP we can place 16 objects onto a single page and the geoWrite or gP page counts as one 

object. In gP V1.1 we can place 104 JPEG and/or EPS files onto a Page Graphics Mode page and 8 such objects 

onto a Master Pages Mode page. Todd says these limits may change as development continues but I think you 

will agree they are likely higher than most projects would need. 

There are a couple of other points about these images we have been pasting on the screen. In the Attributes we 

can still use the Frame Width and Pattern settings. Frame Width does what you would expect. The Pattern 

setting can be used to set a pattern for the Frame. If you have a color PS printer you can accentuate your images 

with color frames. 
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Practice Session 

In keeping with the format of the rest of this Tutorial we are going to run through an example using one of the 

new features of gP V1.1. If you have been creating PostPrint Projects to add JPEG images to the printouts of 

your gP documents you will find the process is much simpler, and more accurate, when you place JPEGs with 

gP V1.1 for the simple reason that you can see the other elements on the page when you position the JPEG. If 

you don't have gP V1.1 yet, now is the time to order it from Todd. In the meantime you can place the JPEG 

with PostPrint if you have to. 

Open the Poster file with gP V1.1, change to page 10 and create a new page. Create a text region from 5"X to 

10"Z and import AppIndexD. Change to Page Graphics Mode, select the Rectangle Tool and draw a box 

(Square, No Frame, Transparent, 7 clicks up from blank) from 5" and 7" to 10" and 8". Draw another rectangle 

(Square, Narrow Frame, Opaque, Black) from 2 1/2" and 2" to 4" and 7". Turn Ratchet off, select the Text Tool 

(LW_Roma, 60, White, Center, Across, Bold), place the crosshairs at 2 7/8" and 2" and enter "Appendix D" for 

the text. Select the text with the Pointer and re-size the text box to the width of the black box and expand it 

down a bit. 

Create 3 new pages so that you are on Page 14. Open the Lf2ColLrg Page Layout from the saved Library (with 

a saved Layout library you don't need the Master Page guidelines). Import the AboutAuthor file into the left and 

then right text regions. Change to Page Graphics mode, select the Text Tool (LW_Cal, 30 points, Center, Bold) 

and place "About the Author" in the usual Title location. Draw a line under the title. Place our end of article 

splat ('X', LW_Shattuck, 12 points, Left, Across) to the right of the last line of text. All of what we have just 

done is standard gP practice. 

Select the, now inappropriately named, Bitmap Placement Tool, position your Pointer at 5 1/2" down and 4 1/4" 

across and click to place the graphic. When the selection box opens click the Graphic Selection Icon which is 

just above the CANCEL Button. The first click of this Icon changes the box from pasting Photo Scraps (P.S.) to 

a selection box where you can select EPS files on the disk. Press the Icon a second time and you will be able to 

select from the JPEG images you have on the disk. You should see "BRUCE.JPG" in the selection box so click 

on it and then click the Open button. This places the JPEG on the page and now we have to resize it. Your 

selection is saved so the next time you want to paste a graphic the JPEG selection box opens first. 

Select the Pointer Tool and click on the area where we placed the JPEG (it may or may not be visible depending 

on whether you last drew a rectangle with a pattern or not). The usual bounding box should now be visible so 

click on the lower right Resize box and move the lower right corner of the image to 9 1/2" down and 7 1/4" 

across. Click to place the image and then set the Attributes (Square, No Frame, Constrain (more life-like 

picture), No Pattern). 

Loose Ends 

You will find that the new Index article is too long for the region we had created for it. Open the TutorialCover 

file, change to page 7, stretch the region down to 10 1/2" and set the top gutter to zero. In Page Graphics mode 

move the center bar and slogan down an appropriate amount as well. 

Next, I created a new PostPrint Project file called Extras and pasted in the Poster gP file. Then I went to page 

14, created a new page and pasted in the postnewsb36 file. I used this Project file to print the Thumbnail page I 

need for AppendixB. 

The Tutorial is now finished. Return to the format24 article, finish creating the PostPrint Project and print it.  
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Thanks to everyone for their feedback during this project. I hope you enjoyed following along as much as I 

enGEOyed writing this and that you find it to be a reference you want to keep handy as you use geoPublish.  
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Importing geoPub24 Old Dog, New Tricks 
 

This article could almost have been installment 25 titled `Come Together' because it brings all the Tutorial 

pieces together in our Project file. But, I had already laid out the page numbers and appendices so it is just 

easier to leave things as they are than to try to change everything around. 

 

I am not going to provide a step by step process for importing the geoPub24 article into the TutorialPart4 

geoPublish (gP) document. By now you should know how to do that all on your own. If you want a process to 

follow read the format20 article as it deals with importing a 3 page article that begins on a left page. Just 

remember that the referenced page numbers will be different. On Page 52 use the title "Old Dog, New Tricks". 

On Page 53 just use "Old Dog" and on Page 54 just use "New Tricks". The rest is just the same. 

 

For this format24 article we have two choices on how to add this to our Project. Each gP document is limited to 

only 16 geoWrite (gW) files. Our AppendixA file already has 16 gW files in it. We can either create a second 

gP file or we can reduce the number of gW files. I am going to choose the latter as it is a bit simpler in the long 

run. 

 

Luckily, we have a program by Nick Vrtis called Combiner (3/4/89 4:03 PM) which will do just what we want. 

Check under the Help menu for full documentation. The 2 files we are going to combine are format11 and 

format12 which share page 60.  Start by making a copy of format11 called format112. To append format12 to 

format112 run Combiner,  press the Begin menu, select format112 and click Open, select format12 and click 

Open, Click OK. 

 

Start gP and open the AppendixA file. `Goto page' 60 and clear the regions in both columns (grey shaded tool 

above Show button). Press Show to ripple the page. Import format112 into the Left and then Right regions. 

Now `goto page' 71 and create a new page. On Page 72 import the format24 article into the left and right 

regions. Don't forget to place the end of article Splat mark. This will finish off the TutorialPart4 and AppendixA 

files. Print Thumbnail pages for each of these gP documents. Now we have to complete our PP Project file. 

 

Completing the Project On Page 50 in article 23 we began to create our PostPrint Project file. We ended off by 

pasting our Poster page onto Page 51 of the Project. It is almost time to finish the Project. First, make sure you 

have completed the `Practice Session' portion of geoPub24. Once you have done that continue on with the next 

paragraph. 

 

Start PostPrint, Open the TOTALTUT Project File and goto page 51 if it doesn't open there. Create the next 

page and then paste in the TutorialPart4 gP file. Goto Page 64 and create the next page. Paste in Poster Page 3 

on Page 65 and then create 2 new pages. On Page 67 paste in the AppendixA gP file.  

 

Goto Page 82 and create a new page. Paste in Poster Page 5 on Page 83 and then create 2 new pages. On Page 

85 paste in Poster Page 7 and then create 2 new pages. On Page 87 paste in Poster Page 9 and then create 2 new 

pages. On Page 89 paste in Poster Page 11 and then create 2 new pages. 

 

On Page 91 paste in Page 1 of the postnewsb36 gP file. Create 2 new pages and paste Page 2 of the 

postnewsb36 gP file onto Page 93 of the Project file. Create 3 new pages and paste Page 14 of the Poster file 

onto Page 96.  

 

This completes the PostPrint Project file. It is setup in such a way that you can print the entire Project at once if 

you have a duplexing printer and it will print off the way we want. Once you print off the Project you have to 

insert the Thumbnail pages into Appendix B before putting your printouts into a binder or getting them Cerlox 
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bound. Remember to check the Color box when you print your Thumbnails as the colors you have used will be 

present on the Thumbnails as well. 
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About The Author 

 
Bruce Thomas bought his first Commodore 64 in November 1983 with a 1541 Disk Drive and a 1702 Monitor. 

After typing in countless magazine programs he joined the Commodore Users of Edmonton (CUE) in 

September 1984 and got access to a vast disk library of programs. The group offered many other opportun- ities 

and Bruce contributed in many ways including submitting the winning Newsletter Cover Design in the Spring 

of 1987 (the newsletter was produced by a member using The Newsroom at the time) and acting as an Assistant 

SysOp on the Club BBS.  

 

After doing a demo of geoPublish at a club meeting in March 1988 Bruce was asked to produce the 8-Bit 

section of The Kernal Chronicles - the club's newly renamed hybrid newsletter. The Laser printed Amiga 

section of the newsletter caused lots of criticism to be directed at the dot-matrix produced 8-Bit section. These 

criticisms were silenced in November 1988 when the first Laser printed 8-Bit section of the newsletter arrived 

(printed with the same PostScript Laser that the Amiga section used). Bruce continued to produce the 8-Bit 

section until that side of the club disbanded in late 1992. During that time he also produced two complete issues 

when the Amiga editor was unavailable. 

 

Since that time Bruce has continued to publish an annual Family Newsletter (begun in 1988) plus contribute to 

and publish various Club newsletters for Meeting 64/128 Users Through The Mail (Commodore MaiLink), 

Louisville Users of Commodore of Kentucky (The LUCKY Report) and The United Commodore User Groups 

Association (UCUGA Commodore Digest). For 6 years Bruce used geoPublish to create the monthly newsletter 

for the School Parent Association at the Elementary School his 3 children attended and to create order forms for 

the Hot Lunch Program. He also published a book of his father's short stories. All of these items were printed 

using a variety of PostScript equipped printers (Laser, Ink-Jet, Black & White and Color) to get the best 

possible print quality. 

 

Bruce has satisfied his writer's itch by submitting columns and articles to such other publications as Willis 

Patten's GEOS Publication, the LoadStar Letter plus Commodore World and Go64! magazines. 

 

While using his Commodore computers has been a constant in Bruce's life for more than 20 years his career 

path has been quite varied including stints as a Labourer, restaurant Cook, Crane Operator, Truck Driver, 

Professional Athlete and Air Traffic Controller.  Currently, Bruce is an IT Specialist responsible for the 

Network, Phone System and Windows and Linux Servers at a High Tech firm in Edmonton, Canada. 

 

In spite of his day job, and sometimes because of it, Bruce always enjoys coming home and using his 

Commodore computers. 

 

 

 

 

 

 

 



112 
 

  

 


